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Reporting Overview

Reporting is a collection of data as a result of monitoring the network traffic, which can be used for
further analysis. In NetWitness Platform you can run a report against NetWitness Platform Database
core services to identify the network activities. For example, if you want to identify the Top Source
Countries and Destination Countries, or top Threat and Risk trends that help monitor any changes to the
normal categories or monitor the users and services that may potentially have malicious activities etc.

The reporting typically consist of: Reports and Charts. You can report on the log, packet and endpoint
data collected, and customize the reports and charts to enhance the visual appearance. You can create
real-time reports for historical data. You can create charts and dashlets, that can be added in the real-
time chart dashlets as well.

Reporting Engine

Reporting relies on the Reporting Engine to provide data for the reports, alerts and charts. Hence, you
must configure the Reporting Engine as a service to NetWitness Platform before you can generate the
reports. You must also specify the data source in the Reporting Engine from which the data is extracted.

The data that you can report or alert depends on the configuration of Reporting Engine and the data
sources that you specify as part of the rule definition.

Note: Make sure you have access to the components in the Reporting.

Note: Make sure you have access to the required data sources. Only privileged users with access to
sensitive information have the permission to certain data sources. However, for the existing reports,
alerts and charts, if the user role or permissions are modified for the data sources, then it is not
applicable unless you manually update the permissions.

Note: Reporting is accessible based on the role based access, defined for the user.

Report

A report is a combination of rules and other formatting objects such as headers and HTML-formatted
notes that describe and identify data pertaining to a particular area of interest. Reports are defined and
managed in the Build Report page and can be scheduled to run on an adhoc or timely basis. Once a
report is run, results are stored centrally and can be automatically sent over email, SFTP, URL, and
NFS to users, viewed via the NetWitness Platform web interface, downloaded as PDF and CSV files.

A report consists of the following:

T N

Report Name Used to identify the report ~ Reportl
to schedule them at a later
Note: For Name ficld, the icon to extend the column size | time.

is not displayed at the end of the column field. You have
to hover the mouse a little to the left side to see the icon
for extending the column.

Tt Pre-defined text fields Headerl,
used within a report to Comment
make the report more
meaningful to the user.
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T R

Rules

The rules (queries) used to  select

create a report.

user.dst

where
ip.src =
10.10.10.1

Note: In the Reporting user interface, the displayed date or time is always according to the user-
selected time zone profile.

Rule

A rule is the basic and essential building block in the Reporting. You must create a rule which can be
used in a Report, Chart or Alert.

A rule represents a unique query that detects and summarizes the requested information within a
collection of network data.

The rule syntax is very similar to that of Standard Query Language (SQL) where you can use the select
clause, where clause, sort and group options and limits for the result set. A rule consists of the following:

T

Name

Select

Where

Then
(Rule
Actions)

The name of the rule.

List of meta types that are returned in the result set. The list of
meta types is provided in the Meta Library. Meta Library in the
Rule Builder is continually synchronized with the index
configuration of the NetWitness Platform host to which
NetWitness Platform is connected. The number of meta types
that this property can represent depends on how the rule is to be
sorted. If the Sort by property is 'None' or Custom, a rule can
have more than one select field, for example, for each match,
include the ip.src, ip.dst, size, time in the rule result. If a rule is
set to be sorted, either by session count, session size, or packet
size, then there can only be one field on which to select.

A clause that is the base query for the rule.

A series of functions that manipulate the original result set of a
rule in order to make the output in a report more meaningful or
add additional functionality other than querying and displaying
data.

Windows System
Account Activity

alert='cleartext ftp
password'

lookup and add
(‘'username','ip.src',10);
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e

Sort By Determines how the data in the result set is sorted. The various  Total
possibilities are:

e Total
o Value

e Column Name

Limit Designates how large a result set can be for the given rule. 20
Users must note that if a result set is sorted by count or size, the
limit represents the top (or bottom) N values to be returned. If
the result set is not sorted, the first N values are returned.

Note: In the User Interface (UI), the date or time displayed depends on the time zone selected by the
user.

Rule Types

There are different rule types in the Reporting. Rule types designate the source of data for the report
rule. Following are the rule types:

NetWitness Database ~ The NetWitness database extracts the meta from a Reporting Engine
(NetWitness DB) configured to use a Concentrator, Broker and Archiver as the data sources
and provides the meta for rules.

Warehouse Database The Warehouse database, also referred to as the RSA NetWitness

(Warehouse DB) Warehouse, warehouses large volumes of data. The Warehouse is designed
so that you can retrieve large volumes of data easily and efficiently. The
Warehouse also extracts the meta from the Reporting Engine.

Respond Database The Respond database contain alerts and incidents generated from different
(Respond DB) services and you can create a report on those alerts and incidents.

Note: In the User Interface (UI), the date or time displayed depends on the time zone selected by the
user.

List

A list is a variable that refers to a series of comma-separated values (CSV). You can insert a list into a
rule or use it as an argument to a rule action. Lists can act as placeholders for other values, which you
can populate and update as needed.

You can create, manage and view lists that can be used to define rules for Reporting and Alerting.

Lists cannot be empty or have duplicate or blank values.

9 Reporting Overview
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Note: If you are defining a report with a rule which has lookup and add in the Then clause and direct
the report output to a list, the list is not populated with the result.

For example, if you create a rule with ip.src in the Select clause and lookup and add ('ip.dst','ip.src’,
10) in the Then clause, the report displays the result, but if you have redirected the output to a list, the
list will be empty

Chart

Chart is a tabular or grid representation of data. It consists of the following:

T e

Chart Name Identifies the chart. Chartl
Rule Basis Identifies the rule path chosen from the folder hierarchy.

Any NetWitness Platform DB rule in the Reporting Engine system which is not sorted by none can be
used to instantly create a chart. In NetWitness Platform, the chart interval can be adjusted from the chart
definition panel itself. Each time a chart runs, it stores its result data locally in the Reporting Engine, so
that it can be reviewed in either the Dashboard View or Chart View without any performance
considerations.

Note: In the Reporting user interface, the output for the field where Date and Time are displayed is
always according to the user-selected time zone profile.

Note: The Reporting Engine (RE) will automatically check for the available disk space before you
execute a Test Rule, Report, Chart and Alert. If the RE disk space (in percentage) is less than the
minimum disk space threshold (default value is 5), the RE will stop the current execution and an error
message 'Available disk space of Reporting engine home is <5%, please clean up the space to proceed
further' is displayed. Additionally, you may also configure the minimum disk space threshold by using
the following path: RE>Config>General>System Configuration>Mini disk space threshold in %.

Reporting Guidelines

This section lists the RSA recommended guidelines to enhance the execution time of your reporting
entities such as rules, reports, alerts, charts, and lists. The guidelines are provided for the following:

« NWDB Rules

o Timeout Configuration for NWDB Rules
o Lookup and Add rule action

o List value Reports

NWDB Rules

If the reporting entities such as report, alert, or chart contain NWDB rules (in most cases where the
query contains Group By) takes a long time to execute, you may do the following:

Reporting Overview 10
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Refine the Where clause:

You may limit the number of sessions scanned by using or refining the Where clause (especially

when you use the Group By option). For example, consider the following rule.

Build Rule

Rule Type

MName

Group By

Seszion

MetWitness Platform DB
Source |p Activigy

Event Count v
ipsrc

Source |? Address

ipsrc exists

ipsrc

Enter a then clauszs...

Column Name

Tatal

=]
L4

Save Reset

Test Rule

Sort By

' Descending

If you use a Where clause as mentioned above, the number of sessions aggregated is huge. To avoid
this, you can filter only required sessions by specifying the list of [P addresses or creating a List (list

of IP Address) that contains relevant IP addresses.

Note: The NWDB rule where clause is appropriately quoted if the syntax has an invalid quote. For
example, in case of an invalid meta, or missing separator, the status and the error message is
updated appropriately.

11
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Build Rule
Rule Type MetWitness Platform DB
Mame Source IP Activity
summarize Svent Coune -
Salect ip.src
Alias Source IP Address
Where ip.sro=3[/User Report/List of IP Address]
Group By ip.sre
Then Enter a then clause...
Ordear By Column Name
Total
Zeszion o -+
Threshold
Limiz 20 +
E Save Reset Test Rule

2. Using indexed Meta keys in the Where clause:

To understand if the Meta is indexed or not, mouse hover the Meta List present on the right panel. If
the Value Type is INDEX VALUE, then the Meta is indexed. The Value Type is INDEX KEY or

INDEX NONE if the Meta is not indexed.

Below is a snapshot of a Meta key that is indexed.

Reporting Overview
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Meta

10.31.204.31 - conc

05
access.point

action

Value Type: INDEX_VALUE

ad.comput@¥EER LR
Description: Action Event

ad.compu
ad.domain.dst
ad.domain.src
ad.username.dst
ad.username.src

alert

3. Configure the Timeout option:

If the query is taking a long time and fails due to timeout issues, you can configure the timeout for the
NWDB rule executions. For more information, see below section "Timeout Configuration for NWDB
Rules".

Schedule the queries to run at different times:

If multiple query aggregates are concurrently executed and timeout occurs, you may schedule the
queries to run at different times without much overlap.

Timeout Configuration for NWDB Rules

Note: It is a good practice to check the statistics of the Reporting Engine and the NWDB data sources
before you make any changes to the configuration. For more information, see the "Monitor Service
Details" topic for Reporting Engine and "Monitor System Statistics" topic in the System Maintenance
Guide.

If NWDB rule execution fails due to timeout, you may get the following errors on the View a Report
page:

Reporting Engine timeout error

“Data source ‘10.31.x.x Concentrator' did not respond within the configured time 30 minutes
for the ‘/sdk/values' request.”

NWDB timeout error

"Error occurred while fetching data from source '10.31.x.x Concentrator'. {Timeout message
from NWDB}”

In such cases, you may do the following:

13
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o Reporting Engine timeout

In case of Reporting Engine timeout, you may set the timeout to a longer duration so the long running
queries can be executed. For more information on setting the NWDB Queries Time Out and NWDB
Info Queries Time Out option for the Reporting Engine, see "Step 2. Configure Reporting Engine
Settings" topic in the Reporting Engine Configuration Guide. RSA recommends you set the NWDB
Query Time Out to zero minutes (implies no timeout) and NWDB Info Queries Time Out to 60
minutes.

o NWDB timeout

In case of NWDB timeout, you may need to configure the query.level.timeout and
max.concurrent.queries parameters for the NWDB data source based on the recommendations
in the Core Database Tuning Guide to fine tune the queries.

The following figure is an example of Explorer view where you can set the parameters for NWDB
data source.

R S/\ Respond Inve: e Monitor Configure Admin ?) admin v

SERVICES EVENT S 5 ENDPOINT SO HEALTH &

%, Change Service | EMSA-Broker | Security
Roles Settings
-1 User Information
Username
Name Username
admin Administrator admin
Password Confirm Password
Email Description
Administrator account for this service
User Settings
Auth Type Core Query Timeout
NetWitness Platform v 60 <
Query Prefix Session Threshold
0
Role Membership
Groups
M Administrators
[] Aggregation
Analysts
Data_Privacy_Officers
Malware_Analysts
Operators
SOC_Managers
Apply Reset
RS /\ NETWITNESS' PLATFORM 11.4.00

o Schedule Reports at different times

If the NWDB core devices are heavily utilized, you may schedule the reports to run at different times
without overlap.

o Split the Report

Reporting Overview 14
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If you have many rules in a Report, split the report into multiple reports with each report containing
logical set of rules. If you have multiple rules, all rules will begin to execute at the same time based
on available threads, therefore you may group the rules logically into separate reports.

LookupAndAdd Rule Action

If a rule that consists of single or multiple lookup and add rule actions, takes a long time to execute
the report, it is because each of the rule action triggers multiple lookup queries on the NWDB data
source resulting in longer execution time.

To improve the report execution time, you may do the following:

Refine the Where clause in the following:
o Rule that contains the 1ookup and_add rule action

e lookup and add rule action
Set Limits

You must set appropriate limits for the rule and rule actions. If the limit is high it will result in many
queries being triggered and hence the report will take a long time to execute.

Set the boolean aggregate parameter

If you do not want the aggregate value such as sum (meta), count (meta) etc. for the lookup
values, set the boolean aggregate parameter to false in the lookup and add rule action. For more
information, see the "NWDB Rule Syntax" section in Rule Syntax.

lookup and add(string select, string field, int limit, boolean inherit,
string extraWhere, boolean aggregate)

Consider the rule with lookup and add rule action:

15
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Build Rule

Rule Type
Mame

Group By

MetWitness Platform DB

Source IP Activity

Custom i

ip-src, count {alias.host)

Source IP Address

ip_src

lookup_and_add (ip.dst, ip.src.25...false)

Enter a then clause...

Column Mame

Encer the column name....

20 -
Lave Reset Test Rule

Sort By

Azcending

The output is displayed:

Reporting Overview
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2018 52 09:00:00
Source IP Address

1. ip.src

[

. ip.src
1. ip.dst
3. ip.Erc

4. ip.src

Source IP Activity 2018 92 10:59:59
count(alias.host)
6624
5438
2481

o Each lookup and add rule action triggers by default two concurrent lookup queries on the data
source. RSA recommends that you retain the default setting, however if you want to increase the
value you may want to ensure the value of Max # of Concurrent LookupAndAdd

Queries parameter in Reporting Engine is less than the Max Concurrent Queries value in the

NWDB data source configuration.

If the NWDB data source is shared across other services, then you may retain a low value for the
Max # of Concurrent LookupAndAdd Queries parameter in Reporting Engine as increasing it
will impact the queries from other services. For more information, see "Reporting Engine General
Tab" topic in Reporting Engine Configuration Guide.

If you are interested only in unique values and not accurate aggregates, then set the Session
Threshold to a non-zero value for the NWDB rule. For more information, see "Create a Rule Using
NetWitness Data Source" section in Configure a Rule. The higher the value, the longer is the rule
execution. If the value is set to zero it will take a longer time but will provide accurate aggregates.

Consider a rule with lookup and add rule action and Session Threshold set to 10.

17
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Build Rule

Rule Type

Mame

MetWitness Platform DB

Cuscom v

Select ip.src, count{alias.host)
Alias o Addrass
Where
Group By ip.sre
r
Then lookup_and_add{ip.dst. ip.sre.25,,.false):
Enzer a then clause...
Crder By Column Mame

Enzer the column name....

10 -
Limit 20 -+

Reset

Test Rule

Sort By

Azcending

The output is displayed:

Reporting Overview

18



Reporting User Guide

Test Rule

Data Source 2018 92 08:55:00 Source IP Activity 2018 9 08:54:59

Broker - Broker v
IP Address count(alias.host) -
Format
1.ip.src 128.164.141.11 1553
Tabular v

Time Range

Past v

2 0 Weeks v

4, Ip.dst 8.7
[ Use relative time calculation
5. ip.dst 10.2.95.40

6. ip.dst 12.10.101.123
7. ip.dst 12.16.163.50
8. ip.dst 12.41.88.9

9. ip.dst 12.41.118.216

10. ip.dst 12.47.224.234

11, ip.dst 12.1

12, ip.dst 12.1

13, ip.dst 12.1

List Value Reports
Use a Refined List:

In case of List value reports (for any data source type), individual reports will be generated for each
value in the list. Therefore, more the number of values in the list the longer the reports will take to
execute. Hence, you must use a refined list to generate such reports.

Access Control for Reporting

Reporting Module provides you the option to set up access control for all the components in the module.
In NetWitness Platform, you can define different roles and specify the access control for each of the role
from the System Security module. You can define the access control to be provided for the Reporting
module for each role. For more information, see "Step 1: Review the Pre-Configured NetWitness
Platform Roles" and "Step 2: (Optional) Add a Role and Assign Permission" topics in the System
Security and User Management Guide.

In the Reports module, you can modify the role permissions or access to the following Reporting objects:

The Following is an example of the hierarchy of the object groups, objects and dependents. This is an
illustration of the Report Groups and Reports hierarchy.

19 Reporting Overview



Reporting User Guide

. Administrator
Object Group A Reports
i . H Router Config
Changes
Router
Dependent A Configuration rule
i N | | Network Activity
Reports
S Network Traffic
Report
Inbound Network
—  Dependent BA ] Traffic rule
Qutbound Network
—  Dependent BB ] Traffic rule
Inbound Network
—  Dependent BC ~ | Traffic Schedule
Sub Group AA User Activity Reports

Report Groups and Reports Hierarchy

Permission for Object Groups

e You must have the Read & Write permission to set the permissions for the Object Group, Objects, or
Dependents. The dependents with “No Access” permission are grayed out and dependents with
“Read-Only” permission are indicated with an icon.

o When you set the permission for the Object Group, the Objects and Dependents in the Object Group
do not inherit the permission automatically. You must select the "Apply these permissions to sub-
groups and <Objects> in this group” option to achieve this. For example, if you do not want Operators
roles to access reports in Report Group A, then you must set the permission on Group A to No access
for the Operator role and select the "Apply these permissions to sub-groups and Reports in this
group" option.

o When you set the permissions for the Object Group and select the "Apply these permissions to sub-
groups and <Objects> in this group" option, the dependents such as rules or schedules in the objects
do not inherit the permissions automatically. You must use the "Apply Read-only permission to Rules
in the <Object>" option to apply the permission to the rules.

Reporting Overview 20
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o When you set the permissions for the Objects, you must ensure that the Objects in hierarchy should
always have a permission that is less than or equal to the one above in the hierarchy for the
permission to be applied. For example, if the reports in a Report Group have Read & Write
permission and you apply a Read-Only or No Access permission at the Report Group level and select
the "Apply these permissions to sub-groups and Reports in this group" option, then the permission on
the rules will remain unchanged.

o The permissions are cascaded from top to down in the hierarchy and not vice-versa. For example, if
you apply a permission to a rule, it does not change the permission of the Report that contains the rule.

Permission for Objects or Dependents

o You must have the Read & Write permission to set the permissions for the Objects or Dependents.

¢ You can specify the permission for multiple objects at once instead of setting the permission for each
object.

o When you set the permission for the Object, the dependents in the Object do not inherit the permission
automatically. You must select the "Apply Read-only permission to Rules in the <Object>" option to
achieve this.

When you apply the permission to dependents the permission is applied based on the existing permission
for the role. For example, consider an Analyst and a Operator with the following permissions for the
different dependents (Report A object has Rule AA, Rule AB, and Rule AC as dependents).

Object or Dependent | Analyst

Report A Read & Write  No Access
Rule AA Read & Write  No Access
Rule AB Read and Write Read and Write
Rule AC Read-only No Access

When the Analyst applies a Read & Write permission for the Operator role and selects the option "Apply
Read-only permission to Rules in the <Object>", then the permissions will be set for the different
dependents as follows:

Modify the Permissions

o Group Level: Set the permissions at the Object Group level and for all the object and entities in the
Group. For example, if you have 80 reports in the Administrators Reports group and you do not want
anyone except the Administrator to add or modify these reports, you can set the permission for all the
other roles at the group level to Read-Only and select the option to apply it to all the reports and sub-
groups in the report group.

o Multiple Objects:Select multiple objects and specify the access for all the selected objects. For
example, if you have 10 reports in the Network Traffic sub group with sensitive information that you
do not want anyone to access, select the 10 reports and then set the permission for all the roles as "No
Access".
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o Single Object: Select only the object and specify the permission. For example, select the Network
Traffic Report and specify the Read-Write permission for the Security Analyst role or select the
Login Failure Alert and specify the Read-Write permission for a Security Analyst role.

Object or Operator (Before Permission is | Operator (After Permission is
Dependent
Report A No Access Read & Write

Rule AA No Access Read-only

Rule AB Read and Write Read & Write

Rule AC No Access Read-only

Roles and Permissions for Reporting Module

Although NetWitness Platform has five pre-configured roles, you can add custom roles. For example, in
addition to the pre-configured Analysts role, you can add custom roles
for AnalystsEurope and AnalystsAsia.

Administrators Full system access

Operators Access to configurations but not to data

Analysts Access to data but not to configurations

SOC Managers Same access as Analysts and an additional permission to handle incidents

Malware Analysts Access to malware events only

Depending on the user role, you can set the following access permissions to access the Reporting module
components (Rules, Reports, Charts, Alerts, Lists):

o Create
o Delete
« Export
Manage

o View

Note: You must enable all these permissions for a user role to be able to define, delete, manage and
view each of the Reporting modules. Y ou must also have appropriate permissions for the data source
to be listed, while defining the reports, charts, or alerts. For more information, see "Configure Data
sources Permissions" topic in the Reporting Engine Configuration Guide.

For a detailed list of permissions and how to add a role and assign permissions, see "Role Permissions"
and "Step 2. (Optional) Add a Role and Assign Permissions" topics in the System Security and User
Management Guide.
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Navigate to the Roles Tab

Each of the following procedures starts on the Rolestab. Perform the following steps to navigate to
the Rolestab:

1. Go to Admin> Security.

The System Security panel is displayed with the Users tab highlighted.
2. Click the Role tab.

The Roles panel is displayed:

(& admin

SECURITY

External Group Mapping  Settings

Name Description Permissions
Administrators The System Administrators per

Administrator ansge

%, Modify Services, rvices, Apply System Updates

n_Admini..

_Administrator

The persona of Data Privacy Of.

The persana for

The System Operators
The persana of M.

The SOC Analy sonais ce...

| Page 1 | of1 | I C Displaying 1-9 of 9

RS /\ NETWITNESS' PLATFORM 11.200

1. In the Roles tab, click + in the toolbar.
The Add Role screen is displayed:

23 Reporting Overview



Reporting User Guide

Add Role

F

Role Info

Mame

Description

Attributes

Core Query Timeout 5

Core Session Threshold 100000

Core Query Prefix

Permissions

Assigned Description ~

= Administration -
Access Administration Module

Access Health & Wellness

Apply System Updates

Can Optln to Live Intelligence Sharing

Manage Advanced Settings

OO ooogg

Manage ATD Settings

-

Cancel

2. In the Role Info section, provide the role information for the following:

o Name
o (Optional) Description
3. Inthe Permissions section:
o Click # and = to scroll through the modules.
o Select the Reports module the role accesses.
o Select each permission the role has.
4. Repeat the previous step until you select all permissions to assign to the role.

5. Click Saveto add the new role, which is effective immediately. You can now assign the new role to
users.
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This figure is an overview of the entire process of configuring and generating a report.

Create and Schedule a

Configure a Rule

Report
Create a Report or
Report Group
Schedule a Report

Create a Parameterized

Report Using Variables

Create or Deploy a Rule

Configure Reporting
Engine
-

Create a List or List
Group

— View a Report
Investigate a Report

L

Manage Lists, Rules or

Reports

To configure and generate a report, perform the following tasks:

1. Configure Reporting Engine - Y ou must configure the Reporting Engine before you can configure
and generate a report. You must also specify the data source in the Reporting Engine from which the
data is extracted. For more information on how to configure Reporting Engine, see "Configure
Reporting Engine" topic in the Reporting Configuration Guide.

Configure a Rule

Create and Schedule a Report

View a Report

Investigate a Report

AN A

Manage Lists, Rules or Reports
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You can create a new rule or deploy an existing rule from the Live Services which can be used in a
report. You can use different conditions to refine the data or information in the data sources such as:

o Select clause

o Where clause

e Group By

e Order By and so on

For example, you can write a rule to view the top 20 web addresses that the users visit daily.

You can create different type of rules using different data sources. Based on your requirements you can
select any of the following options to create a rule:

o Create a Rule Using NetWitness Data Source
o Create a Rule Using Warechouse Data Source

o Create a Rule Using Respond Data Source

You can also use a list in a rule to refine a search result from the data source. Once a rule is created
you can test a rule to see the results returned by the rule.

Create a Rule Group

To create a rule group or rule sub-group, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Do one of the following.

o To define a rule group:

a. Inthe Rules Groups Panel, click + .
The new rule group is added to the Rule Groups panel.

b. Enter the name for the rule group and press ENTER.
o To add a rule sub-group:

a. Inthe Rules Groups panel, select the rule group to which you want to add a sub-group.

b. Click T
The new rule sub-group is added to the rule group.

c. Enter the name for the rule sub-group and press ENTER.
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Create a Rule Using NetWitness Data Source

You can create a rule to fetch data or events from a NetWitness data source. The same procedure is
used to define a rule to fetch data or events from an Archiver data source.

The Archiver data source can be added in the Services Config View of the Reporting Engine. For more
information, see "(Optional) Add Archiver as a Data Source to Reporting Engine" topic in the Archiver
Configuration Guide.

Prerequisites

Make sure that you understand how custom meta keys are created using custom feeds. For more
information, see "Create Custom Meta Keys using Custom Feed" topic in the Decoder and Log Decoder
Configuration Guide.

To create a rule to fetch data or events from a NetWitness Data Source, perform the following:
1. Go to Monitor> Reports.
The Manage tab is displayed.

2. In the Rules toolbar, click T > NetWitness Platform DB.
The Build Rule view tab is displayed.
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Build Rule

Rule Type Metwitness Platform DB

MName Source and Destination details

Summarize Ewent Count -

Select p.dst

Alias |IF Address

Where pgst=1

e ip.dist

Then Enter a then clause...
4 3

Order By Column Mame Sort By
Total Azcending

Jezzion 0 -

Threshold . -

Limiz =0 S

Save Re<et Test Rule

3. Inthe Rule Type ficld, NetWitness Platform DB is selected by default.

4. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

The Summarize field determines the type of summarization or aggregation for the rule. Based on the
type of rule to be defined, you must select one of the following:

o To define a Non-Aggregate rule without any grouping, select: None

o To define an Aggregate rule with special aggregation like the collection (sessions/events/packets)
related aggregates, select one of the following:

o Event Count
o Packet Count

o Session Size
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10.

11.

o To define an Aggregate rule with meta values and custom aggregates like sum(), count(), and so
on, select: Custom

Choosing 'Custom' in the Summarize field enables you to define aggregate function of your
choice in the Select clause. For example, select ip.src, countdistinct(ip.dst), distinct(ip.dst). The
supported aggregate functions are:

o sum (<meta>)

o count(<meta>)

« countdistinct(<meta>)
o min(<meta>)

o max(<meta>)

o avg(<meta>)

o first(<meta>)

o last(<meta>)

o len(<meta>)

o distinct(<meta>)

For more detailed information about Aggregate and Non-aggregate rule, see "NWDB Rule Syntax
section" in Rule Syntax.

In the Select ficld, enter a meta or select a meta from the list of available meta types provided in the
Meta Library. For more information, see "Meta Panel" in Build Rule View. The meta name to fetch

raw log is raw. raw can only be used in the Select field. It cannot be used in the Where and
Then fields. Multiple aggregate functions are supported for Custom aggregate rule in the Select
field. For example, Select: ip.src, username, service, distinct(country.src), sum(payload).

In the Alias field, enter the alias name for columns used in the Select clause.

In the Where ficld, enter a meta or select a meta from the list of available meta types and use the
operators to construct the Where clause for the base query criteria.
The Group By field is a read-only field which gets populated with meta that are defined in the Select

clause. For a Non-Aggregate function, this field is not visible. A maximum of six meta are supported
in the Group By field.

Note: In earlier versions of NetWitness Platform, only one meta was supported for Custom
aggregate rule in the Group By clause. From now, a maximum of six meta are supported in
the Group By clause.

In the Then field, enter the rule actions that manipulate the original result set of a rule in order to
make the output in a report more concrete or add additional functionality other than querying data and
displaying it, for example, creating a feed from the results. For a complete list of available rule
actions, see "NWDB Rule Syntax" in Rule Syntax.

Note: When a rule is executed for an Archiver data source, it is recommended not to use query
intensive rule actions such as lookup and add() and show whats new().

In the Order By field, perform the following:
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12.

13.

14.

a. Inthe Column Name column, enter the name of the columns by which you want to sort the
results. By default, the value is empty. The value gets populated based on the value selected in
the Summarize field.

o For Summarize 'None', if no Order By is selected, then by default it is ordered by session or
collection time.

o For other Summarize values, the default sorting is based on the first 'group by' meta selected
when no 'order by' is defined. For Event Count, Packet Count, and Session size, the
accepted values are Total and Value.

b. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order

In the Session Threshold field, enter the optimization setting to stop scanning the matching sessions
for each possible unique value for the selected meta. The threshold is an integer between 0 (default)
and 2147483647.

Note: This is applicable to only NWDB Aggregate rules. If the default value is specified, all the
matching sessions will be scanned and the accurate value will be returned. A higher session
threshold allows accurate counts for a value. However, this causes longer rule execution time. For
example, consider you set the Session Threshold as 1000 for ip.src. If there are 5000 matching
sessions then for a particular ip.src value which is present in more than 1000 sessions, NWDB
stops the scan after 1000 sessions and returns the extrapolated aggregate value. This optimizes the
query execution time. If the value is present in less than 1000 sessions, then the actual value is
returned.

In the Limit field, enter the limit to be put on the query while fetching data from the database. If a
result set is sorted by event count, packet count, or session size, the limit represents the top (or
bottom) N values to be returned. If the result set is not sorted, the first N values are returned.

Click Save.

Note: Unlike parsed meta, raw logs are fetched from decoders. When both raw log and

parsed meta are queried in a single rule, due to different retention periods, parsed meta might be
available and raw logs missing in the same session. So the result will have parsed meta values and
empty raw value for those sessions. For example, for the rule Select ip.src, ip.dst, service,
username, raw, the parsed meta might be populated and the raw meta remains empty for a few
sessions.

Create a Rule Using Warehouse Data Source

You can create a rule to fetch data or events from a Warehouse event source. You can define the rules
in two modes:

o Default Mode

o Expert Mode
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Default Mode

In Default Mode, you can create rules containing simple SQL like HIVE queries that

contain clauses like Select, Where, Group By, and Having. By default, you can create rules to query
sessions or raw logs. For more information on "Simple query syntax and examples", see Warehouse DB
Simple Rules Syntax.

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type without the Expert Mode selected.

Build Rule Meta
Rule Type Warehouze DE MFE_LOT11 L4
Expert Mode *
Mame EFS by Device o5 -
Select hour{from_unixtime{time]). count{timel{60=E0) I:
From sessions ~
Alias Hour.AverageERE
Where device_type = ‘snort’
-
Group By hour{from_unixtime{time]) »
Having
Order By Column Name Sort By w
Enter the column name... Azcending
*Z Inzert © [ 38 - =
B[] Compliance -
a0

Limit =

B[] Logs

Sawve Reset Test Rule B[] Metwork Activity
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Querying Raw Logs

The raw log format is used in the select or where clause to query for raw logs.

Note: The time range that you can specify in your query is a day (24 hours). If you have specified a
time range less than a day in your query, the result set contains data of at least a day (24 hours).

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type and create a rule for querying raw logs.
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: Meta
Build Rule
MFS_LDT111 ~
Rule Type ‘Warehouse DB
*
Expert Mode
ormat
Mame ‘Windows Failed Logon Events
packetd
Select raw_log raw_log
From logs W raw_proto
unigue_id
Alias lMezzage
Where raw_log LIKE "“#Security_525%%' OR raw_log LIKE "#5ecurity_530%' OR raw_|locg
LIKE "%5ecurity_531%" OR raw_log LIKE “5ecurity_532%' OR raw_|log LIKE
“Security_533%" OR
4 3
Group By hour{frem_unixtime{time]}
Having L 515
*
Cirder By Column Name Soirt By
Enter the column name_ Azrending *= Insert - o
B[] Compliance -
a3
Limit 20 o]
B[] Log:
B[] Network Activity
\:l Save Reset Test Rule
B[] Per User Report
arg
] -
4 3
Expert Mode

Advanced rules are defined using complex HIVE queries created using the clauses DROP, CREATE,
and so on. Unlike simple rules, we always insert the results into a table. For more information on
"Advanced HIVE query language", see HIVE language manual.

The following figure is an example of the Build Rule view that displays when you select Warehouse
DB for Rule Type with Expert Mode selected.
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: Meta
Build Rule
MFS_LOT11 a
Rule Type ‘Warehouse OB
- ®
Expert Mode ™
05 -
Name Rule in Expert Mode ) |:|
Query DROP Table IF EXISTS sessions21022014: .
CREATE External TABLE = —
ROW FORMAT & .serde avrg AvroserDe’
STORED AS |MP
‘arg.apach
g
z
LOCATION YREA/ rsasacly
TELPROPERT
o -
3
“fields":
[
{"name”:"time", “type”:["leng”. "null”] "default™:"null"}. — %
{"name”:"threat_categery”. "type”:["string”. "null"] "default™"null"}. -
{"name™"jp src”. "type™["string”. "null"] "defsult™:"null"} o #2 |nzert - on
{"name”:"device_clasz". "type™:["string”. "null"] "default™ " null"}
1 @] Compliance -
et mapred.inputdinrecursivestrus: h oD
Alias
B[] Legs
B[] Network Activity
Use Save Reset Test Rule
B[] Per User Report
o
mr] -
4 | [ »

If you want to generate a report for a specific time range, you need to manually define the time range in
the query using the following two variables:

o ${report starttime} - The starting time of the range in seconds.

o ${report _endtime} - The ending time of the range in seconds.

For example, SELECT coll, col2 FROM custom_table WHERE timecol >= ${report_starttime}
AND timecol <= ${report_endtime};

Note: By default, Reporting Engine treats $ { keyword} as a variable. If you want to specify HIVE
variables, you must mention the complete syntax of a variable. For example,
S{hiveconf:hive.exec.scratchdir}.

Prerequisites
Make sure that you understand how custom meta keys are created using custom feeds. For more
information, see "Create Custom Meta Keys using Custom Feed" topic in the Host and Services
Configuration Guide.
To create a rule to fetch data or events from a Warehouse data source, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.

2. In the Rules toolbar, click
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+ > Warehouse DB.
The Build Rule view is displayed.

3. Inthe Rule Type field, Warehouse DB is selected by default.

If you are defining the rule in Default mode, perform the following:

a. Inthe Name field, enter a name that is used to Identify or label the rule in alerts and reports.

b. In the Select ficld, enter a meta or select the meta from the drop-down or select a meta from the
list of available meta types provided in the Meta Panel. For more information, see " Meta Panel"
in Build Rule View.

c. Inthe From drop-down menu, select one of the following:

o Session
o Logs

d. Inthe Alias field, enter the alias name for columns used in the Select clause.

e. Inthe Where field, enter a meta or select a meta from the list of available meta types provided
in the Meta Panel. The Where clause provides the base query criteria for the rule.

f. In the Group By field, enter the meta selected in the Select clause, so that the result set is
grouped based on the meta.

g. In the Having field, enter the criteria to filter the result set for aggregated queries.

h. In the Order By field, perform the following:

1. In the Column Name column, enter the name of the columns by which you want to group the
results.

2. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order

i. In the Limit field, enter the limit to be put on the query while fetching data from the database. If
a result set is sorted by session count, packet count, or session size, the limit represents the top
(or bottom) N values to be returned. If the result set is not sorted, the first N values are returned.

j. Click Save.

4. If you are defining the rule in Expert mode, select the Expert Mode checkbox and perform the
following:

a. In the Name field, enter a name that is used to Identify or label the rule in alerts and reports.

b. Inthe Query field, enter the Hive query statement to query the data source.

c. Inthe Alias field, enter the alias name for columns used in the Select clause.

d. Click Save.
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Create a Rule Using Respond Data Source

You can create a rule to fetch incidents or alerts from a Respond data source.

Prerequisites

Make sure that you:

Ensure Reporting Engine service is up and running.

Ensure the Incident Management service is up and running. For more information, see "Configure a
Database for the Respond Server Service" topic in the NetWitness Respond Configuration Guide.

(Optional) Ensure the Event Stream Analysis service is up and running. For more information, see
"Step 2. Configure Advanced Settings for an ESA Service" topic in the £SA Configuration Guide.

(Optional) Ensure the Malware Analysis service is up and running. For more information, see "
(Optional) Configure Auditing on Malware Analysis Host" topic in the Malware Configuration Guide.

Note: You need to configure any one of the services (Event Stream Analysis, Reporting Engine,
Malware Analysis, or Endpoint) based on your requirement and the type of alerts or incidents you want
to generate.

To create a rule to fetch data or events from a Respond Data Source, perform the following:

1.

Go to Monitor > Reports.
The Manage tab is displayed.

In the Rules toolbar, click + > Respond DB.

The Build Rule view tab is displayed.

In the Rule Type field, Respond is selected by default.

In the Name field, enter a name that is used to Identify or label the rule in alerts and incident reports.

The Summarize field determines the type of summarization or aggregation for the rule. Based on the
type of rule to be defined, you must select one of the following:

o To define a Non-Aggregate rule without any grouping, select None
o To define an Aggregate rule with meta values and custom aggregates select Custom

Choosing 'Custom' in the Summarize field enables you to define aggregate function of your
choice in the Select clause based on the report type you have selected.

For more detailed information about Aggregate and Non-aggregate rule, see Rule Syntax.

In the From field, based on the type of report output to be displayed, you must select one of the
following:

o Alert
¢ Incident

In the Selectficld, enter a meta or select a meta from the list of available meta types provided in the
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Meta Library. For more information, see "Meta Panel" in Build Rule View. It cannot be used in the

Where field. Only one aggregate function is supported at a time in a query.

For example, the supported metas for alert are:

o alert host summary

o alert.name

o alert.numEvents

« alert.severity

o alert.source

o alert.timestamp

o incidentCreated

o incidentld

o receivedTime

For example, the supported metas for incident are:

o categories

o created

e priority

o riskScore

o sealed

o status

For more detailed information, see "Aggregate and Non-aggregate rule" topic in the Rule Syntax.
8. In the Alias field, enter the alias name for columns used in the Select clause.

9. Inthe Where field, enter a meta or select a meta from the list of available meta types and use the
operators to construct the Where clause for the base query criteria.

10. The Group By field is a read-only field which gets populated with meta that are defined in the Select
clause. For a Non-Aggregate function, this field is not visible. A maximum of six meta are supported
in the Group By field.

11. Inthe Order By field, perform the following:

a. Inthe Column Name column, enter the name of the columns by which you want to sort the
results.

Note: by default the first meta in the select clause will be dispalyed.

b. In the Sort by column, select one of the following ways to sort the results:
o Ascending Order
o Descending Order
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12. In the Limit field, enter the limit to be put on the query while fetching data from the database. If a
result set is sorted by the limit represents the top (or bottom) N values to be returned. If the result set
is not sorted, the first N values are returned.

13. Click Save.

Deploy a Rule

In RSA NetWitness Platform you can deploy the selected rules on the service (for example, Reporting
Engine), using the Deployment Wizard.

Prerequisites
Make sure that:
o The services on which you deploy a rule is up and running.

o The Live Services is configured.

To deploy a rule, perform the following:
1. Goto CONFIGURE > LIVE CONTENT.

2. Inthe Search Criteria panel, search Live resources (for example, search for the Application Rule
resource Type).

3. Inthe Matching Resources panel, select Show Results > Grid.

Select the checkbox to the left or the rules that you want to deploy.

In the Matching Resources toolbar, click ., Deploy
Click Next.
Select the service on which you to deploy a rule (For example, Reporting Engine) and click Next.

Click Deploy.
The rule is deployed successfully.

> =N w

Use Meta Aliases for Reporting

When you refer to meta data in Reports and Charts, you can only view aliases for the meta names.
These aliases makes them more understandable to a broader audience.

You cannot provide alias values for any meta in the WHERE clause because NetWitness Platform uses
the WHERE clause to fetch data from the data source (for example, in the Concentrator) and data
sources do not support aliases. In other words, you cannot provide the alias value HTTP for the HTTP
port # 80.

Note: * You cannot create aliases for meta other than the ones that have existing aliases by Reporting
Engine. Also, the format of the aliases cannot be changed.
* Aliases are not supported for Alerts and CSV reports.
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To use alias in a rule, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules panel, do one of the following:
o Select a rule and click lj in the Rules toolbar.
. Click ¥ > gait,

3. Specify the meta with aliases in the Select field.

The following example specifies the eth.type, ip.proto, medium, service, tcp.dstport, and tcp.srcport
meta in the Select field.

Build Rule

MetWitness Platformn DB

Mame Metwork Actvity
Summarize Custom -
Select eth.oype, ip.proto, medium, service, top.dstport, Top.sroport
Alizs IF
Where
EIFC}L.IJIE_.r eth.gype.ip. proto.medium,service, top.d=stport tcposroport
Then Enter a thern clauss...
! 3
Qrder By Column Name Sort By
Enter the column name... Ascending

L
i
.,
[x}
3
3

<

Save Reset Test Rule

4. Click Test Rule.
The following example displays the results under the eth.type, ip.proto, medium, service,
tcp.dstport, and tep.sreport alias columns that were specified in the Select field of the rule.
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Data Soqurce

Sroker - Broker

Format

2018

0z
14

10:37:00

IP Protacol

Hetwork Medium

Network Activity

Service Type

TCP Destination Port

2018 33 10:36:59

TCP Source Pore

Tabular w
Time Range

Past L

2 o Weeks -

| sz relative time calculation

10 P TCP

1 P TCP

13 P TCP

12 P TCP

15 = CF Ethernet OTHER z=h 61252

RSA-Supplied Alias Definitions

The alias files in this section are examples only and are based on current alias definitions in the
Reporting Engine. NetWitness Platform cannot modify these definitions in the Reporting Engine
depending on the changes in the concentrator xml file. Since any changes in the Concentrator xml file
are not reflected in the Reporting Engine.

The details of different meta are explained in each of the meta.aliases.
eth. type

ALIASiFORMAT=$aliaS
0=802.3
257=Experimental
512=Xerox PUP
513=Xerox PUP
1024=Nixdorf
1536=Xerox NS IDP
1537=XNS Address Translation
2048=1IP
2049=X.75 Internet
2050=NBS Internet
2051=ECMA Internet
2052=CHAOSnet
2053=X.25 Level 3
2054=ARP
2055=XNS Compatibility
2076=Symbolics Private
2184=Xyplex
2304=Ungermann-Bass network debugger
2560=Xerox IEEE802.3 PUP
2561=Xerox IEEE802.3 PUP Address Translation
2989=Banyan Systems
2991=Banyon VINES Echo

(3Mb only)
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4096=Berkeley Trailer negotiation

4097=Berkeley Trailer encapsulation for IP

4660=DCA - Multicast

5632=VALID system protocol

6537=Artificial Horizons

6549=Datapoint Corporation (RCL lan protocol)

15360=3Com NBP virtual circuit datagram (like XNS SPP) not registered
15361=3Com NBP System control datagram not registered
15362=3Com NBP Connect request (virtual cct) not registered
15363=3Com NBP Connect repsonse not registered

15364=3Com NBP Connect complete not registered

15365=3Com NBP Close request (virtual cct) not registered
15366=3Com NBP Close response not registered

15367=3Com NBP Datagram (like XNS IDP) not registered
15368=3Com NBP Datagram broadcast not registered
15369=3Com NBP Claim NetBIOS name not registered
15370=3Com NBP Delete Netbios name not registered
15371=3Com NBP Remote adaptor status request not registered
15372=3Com NBP Remote adaptor response not registered
15373=3Com NBP Reset not registered

16972=Information Modes Little Big LAN diagnostic
17185=THD - Diddle

19522=Information Modes Little Big LAN

21000=BBN Simnet Private

24576=DEC unassigned

24577=DEC Maintenance Operation Protocol (MOP) Dump/Load Assistance
24578=DEC Maintenance Operation Protocol (MOP) Remote Console
24579=DECNET Phase IV

24580=DEC Local Area Transport (LAT)

24581=DEC diagnostic protocol (at interface initialization?)
24582=DEC customer protocol

24583=DEC Local Area VAX Cluster (LAVC)

24584=DEC AMBER

24585=DEC MUMPS

24592=3Com Corporation

28672=Ungermann-Bass download

28673=Ungermann-Bass NIUs

28674=Ungermann-Bass diagnostic/loopback
28675=Ungermann-Bass 2?? (NMC to/from UB Bridge)

2867 7=Ungermann-Bass Bridge Spanning Tree

28679=0S/9 Microware

28681=0S/9 Net?

28704=LRT (England) (now Sintrom)

28720=Racal-Interlan

28721=Prime NTS (Network Terminal Service)
28724=Cabletron

32771=Cronus VLN

32772=Cronus Direct

32773=HP Probe protocol

32774=Nestar

32776=AT&amp; T/Stanford Univ.

32784=Excelan

32787=Silicon Graphics diagnostic

32788=Silicon Graphics network games

32789=Silicon Graphics reserved

32790=Silicon Graphics XNS NameServer

32793=Apollo DOMAIN

32814=Tymshare

32815=Tigan

32821=Reverse Address Resolution Protocol (RARP)
32822=RAeonic Systems
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32823=IPX (Novell Netware?)

32824=DEC LanBridge Management
32825=DEC DSM/DDP

32826=DEC Argonaut Console

32827=DEC VAXELN

32828=DEC DNS Naming Service

32829=DEC Ethernet CSMA/CD Encryption Protocol
32830=DEC Distributed Time Service
32831=DEC LAN Traffic Monitor Protocol
32832=DEC PATHWORKS DECnet NETBIOS Emulation
32833=DEC Local Area System Transport
32834=DEC unassigned

32836=Planning Research Corp.
32838=AT&amp; T

32839=AT&amp; T

32840=DEC Availability Manager for Distributed Systems DECamds
32841=ExperData

32859=VMTP

32860=Stanford V Kernel

32861=Evans &amp; Sutherland
32864=Little Machines
32866=Counterpoint Computers
32869=University of Mass. at Amherst
32870=University of Mass. at Amherst
32871=Veeco Integrated Automation
32872=General Dynamics

32873=AT&amp; T

32874=Autophon

32876=ComDesign

32877=Compugraphic Corporation
32878=Landmark Graphics Corporation
32890=Matra

32891=Dansk Data Elektronik
32892=Merit Internodal

32893=Vitalink Communications
32896=Vitalink TransLAN III Management
32897=Counterpoint Computers
32904=Xyplex

32923=EtherTalk - AppleTalk over Ethernet
32924=Datability

32927=Spider Systems Ltd.
32931=Nixdorf Computers

32932=Siemens Gammasonics Inc.
32960=DCA Data Exchange Cluster
32966=Pacer Software

32967=Rpplitek Corporation
32968=Intergraph Corporation
32973=Harris Corporation

32975=Taylor Instrument
32979=Rosemount Corporation

32981=IBM SNA Services over Ethernet
32989=Varian Associates

32990=TRFS (Integrated Solutions Transparent Remote File System)
32992=Allen-Bradley

32996=Datability

33010=Retix

33011=AppleTalk Address Resolution Protocol (AARP)
33012=Kinetics

33015=Apollo Computer

33023=Wellfleet Communications
33026=Wellfleet BOFL

Configure a Rule 41



Reporting User Guide

33027=Wellfleet Communications
33031=Symbolics Private
33067=Talaris

33072=Waterloo Microsystems Inc.
33073=VG Laboratory Systems
33079=IPX

33080=Novell Inc

33081=KTI

33087=M/MUMPS data sharing
33093=Vrije Universiteit (NL)
33094=Vrije Universiteit (NL)
33095=Vrije Universiteit (NL)
33100=SNMP

33103=Technically Elite Concepts
33169=PowerLAN

33149=XTP

33238=Artisoft Lantastic
33239=Artisoft Lantastic

33283=QNX Software Systems Ltd.
33680=Accton Technologies (unregistered)
34091=Talaris multicast
34178=Kalpana

34525=1IPv6

34617=Control Technology Inc.
34618=Control Technology Inc.
34619=Control Technology Inc.
34620=Control Technology Inc.
34848=Hitachi Cable (Optoelectronic Systems Laboratory)
34902=Axis Communications AB
34952=HP LanProbe test?
36864=Loopback (Configuration Test Protocol)
36865=3Com XNS Systems Management
36866=3Com TCP/IP Systems Management
36867=3Com loopback detection
43690=DECNET

64245=Sonix Arpeggio

65280=BBN VITAL-LanBridge cache wakeups
34915=PPPoe

34916=PPPoe

2056=Frame Relay ARP

16962=IEEE bridge spanning protocol
25944=Bridged Ethernet/802.3 packet
65278=ISO CLNP/ISO ES-IS DSAP/SSAP

ip.proto

ALIAS FORMAT=Salias
0=HOPOPT
1=ICMP
2=IGMP
3=GGP
4=IP
5=ST
6=TCP
7=CBT
8=EGP
9=IGP
10=BBN-RCC-M
11=NVP-II
12=PUP
13=ARGUS
14=EMCON
15=XNET
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16=CHAOS
17=UDP
18=MUX
19=DCN-MEAS
20=HMP
21=PRM
22=XNS-IDP
23=TRUNK-1
24=TRUNK-2
25=LEAF-1
26=LEAF-2
27=RDP
28=IRTP
29=IS0-TP4
30=NETBLT
31=MFE-NSP
32=MERIT-INP
33=SEP
34=3PC
35=IDPR
36=XTP
37=DDP
38=IDPR-CMTP
39=TP++
40=1IL
41=TIPv6
42=SDRP
43=IPv6-Rout
44=IPv6-Frag
45=1DRP
46=RSVP
47=GRE

4 8=MHRP

4 9=BNA
50=ESP

51=AH
52=I-NLSP
53=SWIPE
54=NARP
55=MOBILE
56=TLSP
57=SKIP
58=IPv6-ICMP
59=TPv6-NoNx
60=IPv6-Opts
61l=AnyHost
62=CFTP
63=AnyNetwork
64=SAT-EXPAK
65=KRYPTOLAN
66=RVD
67=IPPC
68=AnyFile
69=SAT-MON
70=VISA
71=IPCV
72=CPNX
73=CPHB
7T4=WSN
75=PVP
76=BR-SAT-MO
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77=SUN-ND
78=WB-MON
79=WB-EXPAK
80=ISO-1IP
81=VMTP
82=SECURE-VM
83=VINES
84=TTP
85=NSENET-IG
86=DGP
87=TCF
88=EIGRP
89=0SPFIGP
90=Sprite-RP
91=LARP
92=MTP
93=AX.25
94=TIPIP
95=MICP
96=SCC-SP
97=ETHERIP
98=ENCAP
99=AnyPrivate
100=GMTP
101=IFMP
102=PNNI
103=PIM
104=ARIS
105=SCPS
106=0NX
107=A/N
108=IPComp
109=SNP
110=Compag-Pe
111=IPX-in-1IP
112=VRRP
113=PGM
114=AnyHop
115=1L2TP
116=DDX
117=IATP
118=STP
119=SRP
120=UTI
121=SMP
122=SM
123=PTP
124=ISIS
125=FIRE
126=CRTP
127=CRUDP
128=SSCOPMCE
129=IPLT
130=SPS
131=PIPE Pr
132=SCTP St
133=FC Fi
134=RSVP-E2E-
255=Reserved

medium
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ALIAS FORMAT=$alias
1=Ethernet
2=Tokenring
3=FDDI
4=HDLC
5=NetWitness
6=802.11
7=802.11 Radio
8=802.11 AVS
9=802.11 PPI
10=802.11 PRISM
11=802.11 Management
12=802.11 Control
13=DLT Raw
32=Logs

service

ALIAS FORMAT=$alias
0=0OTHER
20=FTPD
21=FTP
22=SSH
23=TELNET
25=SMTP
53=DNS
67=DHCP
69=TFTP
80=HTTP
110=POP3
111=SUNRPC
119=NNTP
123=NTP
135=RPC
137=NETBIOS
139=SMB
143=IMAP
161=SNMP
179=BGP
443=SSL
502=MODBUS
520=RIP
1024=EXCHANGE
1080=SOCKS
1122=MSN IM
1344=ICAP
1352=NOTES
1433=TDS
1521=TNS
1533=SAMETIME
1719=H.323
1720=RTP
2000=SKINNY
2040=SOULSEEK
204 9=NFS
3270=TN3270
3389=RDP
3700=DB2
5050=YAHOO IM
5060=SIP
5190=A0L IM
5222=Google Talk
5900=VNC
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6346=GNUTELLA
6667=IRC
6801=Net2Phone
6881=BITTORRENT
8000=QQ
8002=YCHAT
8019=WEBMAIL
8082=FIX
20000=DNP3
1000000=KERNEL
1000001=USER
1000003=SYSTEM
1000004=AUTH
1000005=LOGGER
1000006=LPD
1000008=UUCP
1000009=SCHEDULE
1000010=SECURITY
1000013=AUDIT
1000014=ALERT
1000015=CLOCK

46

Configure a Rule



Reporting User Guide

tcp.dstport

ALIAS_FORMAT=$Value
7=echo
9=discard
13=daytime
17=gotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger
80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop?2
110=pop3
l11l=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=1dap
443=https
445=cifs
464=kpasswd
512=exec
513=login
514=cmd
515=printer
520=efs
526=tempo
530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=1daps
749=kerberos—-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sqgl-s
1434=ms-sgl-m

(Salias)

Configure a Rule

77



Reporting User Guide

1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
6667=1irc
9001=tor
9030=tor
9535=man

tcp.srcport

ALIAS FORMAT=$value
7=echo
9=discard
13=daytime
17=qgotd
19=chargen
20=ftp-data
21=ftp
22=ssh
23=telnet
25=smtp
37=time
42=nameserver
43=nicname
53=domain
70=gopher
79=finger
80=http
88=kerberos
101=hostname
102=iso-tsap
107=rtelnet
109=pop?2
110=pop3
111l=sunrpc
113=auth
117=uucp-path
119=nntp
135=epmap
137=netbios-ns
139=netbios-ssn
143=imap
158=pcmail-srv
170=print-srv
179=bgp
194=irc
389=1dap
443=https
445=cifs

(Salias)
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464=kpasswd
512=exec
513=login
514=cmd
515=printer
520=efs
526=tempo
530=courier
531=conference
532=netnews
540=uucp
543=klogin
544=kshell
556=remotefs
636=1daps
749=kerberos-adm
993=imaps
995=pop3s
1109=kpop
1433=ms-sql-s
1434=ms-sgl-m
1512=wins
1524=ingreslock
1723=pptp
2053=knetd
1122=msn im
1352=notes
1521=tns
1533=sametime
1718=h323
1720=rtp
1863=msn im
2049=nfs
3389=rdp
5050=yahoo im
5060=sip
5190=aim
6346=gnuetella
bo667=1irc
9001=tor
9030=tor
9535=man

udp.dstport

ALIAS_FORMAT=$Value
7=echo
9=discard
13=daytime
17=gotd
19=chargen
37=time
39=rlp
42=nameserver
53=domain
67=bootps
68=bootpc
69=tftp
88=kerberos
11l=sunrpc
123=ntp
135=epmap
137=netbios-ns

(Salias)
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138=netbios-dgm
161=snmp
162=snmptrap
213=ipx
443=https
445=cifs
464=kpasswd
500=isakmp
512=biff
513=who
514=syslog
517=talk
518=ntalk
525=timed
533=netwall
550=new-rwho
560=rmonitor
561l=monitor
749=kerberos—adm
1167=phone
1433=ms-sqgl-s
1434=ms-sgl-m
1512=wins
1701=12tp
1812=radiusauth
1813=radacct
2049=nfsd
2504=nlbs

Test a Rule

You can test a rule based on the time range and the data source selected.

To test a rule, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules panel, do one of the following:
o Select a rule and click d in the Rules toolbar.

. Click ®° > Eait
The Build Rule view tab is displayed.
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. Click Test Rule.

The Test Rule view is displayed.

Test Rule

Data Source

~

Format

Time Range
Past v

2 & |Hours ~

[ Use relative time calculation

X Axis

~

Y Axis

Note: When you click Test Rule, the rule is not saved. You have to click Savein the Build Rule
view to save the rule.

. From the Data Source drop-down list, select a data source.
You must select the appropriate data source for the rule defined.

. From the Format drop-down list, select the format in which you want the result displayed.
From the Time Range drop-down list, select one of the following.
o Past -To specify number of years, days, weeks, months, days or hours.

o Range - To specify a date range and time period.

Note: In the User Interface (UI), the date or time displayed depends on the time zone profile
selected by the user.

. X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In X-Axis, the Meta for the 'Group by' rule is displayed. In Y-Axis, the aggregate functions used in
the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for rule. By
default, for Custom Rules with multiple 'Group by', you can select only the first meta in X-Axis.

8. Click Run Test to execute the rule.

The rule data (if any) for the selected time range is displayed.
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Create a Lists or List Group

To create a list, perform the following:

Lists can be added within a group or in the root folder.

I.

Go to Monitor > Reports.
The Manage tab is displayed.

Click Lists.
The List view is displayed.

Manage View

Rules  Reports

Groups

+ Tl
Groups ~

Al

» I Compliance
» [ Fitering Candidates

[ Network Ay

Charts

006000

[LIST] Blacklisted IPs

Merts  [ISSM  warehouse Analytics

Lists

0O o0 oo oolioios

17 %o
e

Blckisced P

Complance Data
Complance Sysems
Content Delvery Networks
Lisof s Hosts
ListofIP Addresses

List of Message ID

Search Report Details

Date Modtied
20170503 0839
20170503 0833
20170503 0834
20170503 0828
2017.05.03 0831
20170503 0832

20170503 08:23

E-JRRE-J0E - J00E - JRNE - J0NE - 200K -3

In the Liststoolbar, click +

The Build List view tab is displayed.
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Manage View [LIST] Content Delivery Ne... @ _

Build List

Mame Content Delivery Networks
Description List of CDNs
List Values Insert Values

Value

www.google.com
ftp.ricrosoft.com
ftp.symantec.com
unisys.skillport.com

Enter value...

[ Quotes will be inserted for all the values

4. In the Name field, enter a unique name for the list.

5. Inthe Description field, enter a description for the list.
6. Inthe List Values field, do one of the following:

o Click Insert Values and enter the values separated by commas. You can paste a list of values
from a file or other lists.

o In the Value column, enter the values.

7. If you want quotes to be inserted directly for the values at runtime, select Quotes will be inserted
for all the values.

8. Click Save.
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To create a list group, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts  Alerts [EES Warehouse Analytics Search Report Details 23
Groups Lists
+ - Cla- + | &
Gme O Mame ~ o Date Modifiea Actions
o (-] [ Blackiisted IPs 2017-05-03 0839 &
» 3 compliance (o] [ Compliance Data 2017-05-03 08:32 Ho
> [ Fiering Canidares e [0 Compliance Systems 2017-05-0308:34 #e
I Netwark Activity (0]
[ Content Delivery Networks 2017-05-03 08:28 e
[ Listof Alias Hosts 2017-05-03 08:31 e
[ Listof IP Addresses 2017-05-0308:32 e
[ Listof Message ID 2017-05-0308:33 e

3. Do the following:

o To create a list group:

1. Inthe Lists Groups panel, click + .
A new list group is added to the List Groups panel.

Groups
+ - Clac
Groups ~

All E

[ situational Awareness 'B
[ Threat 0

[ User Activity O

2. Enter the name for the list group and press ENTER.

o To create a list subgroup:

1. Inthe Lists Groups panel, select the list group to which you want to add a subgroup.
2. Click +
A new list subgroup is added to the list group.

3. Enter the name for the list subgroup and press ENTER.
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You can create a simple or complex report and configure its execution properties by scheduling a report.
A report can include multiple rules and you can schedule different time range to execute the same
report. For example, depending on your requirement, you can schedule a report to run daily, weekly or
monthly.

When you run a report, the results are stored in Reporting Engine.
After you generate a report, you can perform the following:

o Send the reports by email to other users by configuring the output actions. You can also configure the
output actions before generating a report.

o Download the reports as PDF or Comma-Separated Values (CSV) format files.

Note: The cancel operation is not supported for Respond Reports.

Create a Report or Report Group

To create a report to a group or sub-group, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Reports toolbar, click + .
The Build Report tab is displayed.
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4.
5.

6.

RSA Res| ¥ e Monitor Configure  Admin
DVERVIEW REPORTS
Manage [REPT] New Report @
Crtar Bamar NETWITNESS Text Rules
Enter Report Name... R SA PLATEORM
Header 1
QU mMUuSsT a0d 1ext and rules 1o the report.
Header 2
Header 3
Header 4
Table of Contents
Body Text
Comment

RS /\ NETWITNESS' PLATFORM 11.4.0.0

Enter the name of the report.

Drag and drop the text and rules to the report.

Note: The text entered is optional and you may need this option only when you want to display
user-defined headers or content.

Click Save.

A confirmation message that the report is saved successfully is displayed.

To create a group to the default folder or add sub-groups under a report group, perform the

following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Reports Groups panel, click + .
A default group is added in the Report Groups panel.
4. Enter the name of the new group.
5. Press Enter.

The group is added to the Report Groups panel.

Create and Schedule a Report
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Schedule a Report

Note: When you schedule a Warehouse report, you can use a supported task scheduler to allocate
specific resources in a cluster for the scheduled job. For more information on "supported task
schedulers", see Task Scheduler for Warehouse Reporting.

To schedule a report, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.

2. In the Rules panel, click + to create a rule.

3. Click Save.
4. Click Use.
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Build Rule
Rule Type

Mame

Summarize

Group By

Seszion

Metwitness Platform DB

Source and Destination details
Ewvent Count -
ipdst

|IF Address

ip.dst =1

ipdst

Enter a then clausz=...

L |

Column Name Sort By
Total Aszcending
- ~

0 \-'

20 o

Save Reset Test Rule

5. Go to Monitor > Reports.

The Manage tab is displayed.
6. Click Reports.

The Report view is displayed.

7. On the Reports panel, click + to create a report.

8. Enter the Report Name in the field.

9. Add the rule by drag and drop which has the user defined variable from the Rules tab.
10. Click Schedule.

The Schedule Report view is displayed.

Create and Schedule a Report
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If you provide another user with access permissions to a report, you must also provide permissions
for the report group, the rules used in the report, and the rule groups otherwise an error message is
displayed.

11. To execute the reports as per the schedule, select the Enable checkbox.

12. In the Schedule Name field, enter a name for the schedule report configuration.

13. From the Data Source field, select the data source.

Note: If the data source is not listed, then ensure you have Readpermissions set for the data
source. This is applicable for NWDB, Respond and Warehouse data source. For more information,
see "Configure Data Source Permissions" topic in Reporting Engine Configuration Guide.

14. (Optional) From the Warehouse Resource Pool drop-down, select the pools or queues available in
the cluster to schedule the report to run on either the pool or queue. This drop-down list is available
only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine are
listed. If no pools or queues are configured in the Explorer page, this drop-down is disabled and the
jobs are submitted to the clusters without any a queue or pool name.

Note: If the pool or queue configured in the report schedule is removed from the Cluster, then in
the Capacity Scheduler, the queue name remains undefined. However, in the Fair Scheduler, the
specified pool name will be created using the

property mapred.fairscheduler.allow.undeclared.pool.

15. From the Time Zone drop-down, select a time zone to display all the time-related data in a report
output in the specified format. This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

16. From the Run field, select the type of run schedule. (For example, Now or Hourly).

Depending on the type of run schedule, choose one of the following:
o Ifyouselect a Later or Monthly run schedule, you must provide a value for the day and time in
the respective field provided.
o If you select an Hourly run schedule, you must specify the minutes in the At Minute field.
o If you select a Daily run schedule, you must enter a value in the At field.
o Ifyouselect a Weekly run schedule, you must enter a value in the At field and also select the
week days.
Note: While scheduling a report, if you select Past option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.
For information on how to generate a report with variables, see Create a Parameterized Report Using
Variable.

17. (Optional) In the Output Actions panel, do the following:
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18.
19.

20.

a. Enter the email address and subject.
b. Edit the body of the message for the report.
c. Select the format of the attachment.

d. Enter a value for the CSV and Multi-value delimiters.
e. (Optional) In the Other Options field, do the following:

i. Click ¥ and select SFTP, URL, or Network Share output action.

A row gets added with the selected output action.

ii. Select the appropriate options to send the report in PDF or CSV format, or both to the RE
configured SFTP, or URL, or Network Share output action.

(Optional) To add a list in the Dynamic List panel, see Generate a List from the Scheduled Report.

(Optional) To choose a logo in the Logo panel, see "Manage and Select a Report Logo" section in
Manage Lists, Rules or Reports.

Note: If you do not specify a logo, the default RSA logo will be used.

Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.

Report-RuleToTestSpecialChars-1 NETWITNESS
Generated on - 2017-08-09 08:03 (+00:00) PLATFORM
2016 9% 08:03:00 (+00:00) Time Range 2017 95  08:02:59 (+00:00)

-

RuleToTestSpecialChars-1 / nw-conc1 - Concentrator

User Account

L - T T S T

After you create and Schedule a report, you can perform any of the following tasks:

You can notify the email recipient when the report execution completes and send reports in PDF and
CSV formats as attachments in the email.

You can generate a list based on the scheduled report and view them in the Lists module.

You can send a scheduled report in PDF or CSV format, or both to the RE configured SFTP location,
or URL, or Network Share.

You can change the default logo and view them in the scheduled report.
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o You can modify the NetWitness Platform Reporting Engine config details, by navigating to the
Reporting Engine General Tab. See the "Reporting Engine General Tab" topic in the Reporting
Engine Guide.

Examples

When you schedule reports in the Schedule Report view, by default, the results for the Past option are
presented based on the user specified time zone. The following examples provide a clear picture on what
results to expect when you select Hours, Days, Weeks, Months, or Years for the Past option based on
the absolute or relative duration.

Note: By default, the relative duration checkbox is de-selected. This implies that the results for the
Past option are presented based on the absolute duration.

o Based on Absolute duration - Absolute Duration allows a report to be scheduled at an absolute time
with respect to the current time, excluding the seconds and considering the time interval as a whole.
For example, 12.00pm is the absolute time with respect to the current time (12.45 pm).

o Hours - Suppose that you select Hours and specify one hour. If the current user specified time is
4.20PM, the report is generated for the time range, 3.00PM to 4.00PM.

o Days - Suppose that you select Days and specify one day. If the current date is August 27, 2014
and the current user specified time is 10.15AM, the report is generated for the range: August 26,
2014, 12.00AM to August 27, 2014, 12.00AM.

o Weeks - Suppose that you select Weeks and specify one week. If the current date is August 27,
2014 2.30PM and the day is Wednesday, the report is generated for the range: Saturday, August 16,
2014, 12.00AM to Saturday, August 23, 2014, 12.00AM.

o Months - Suppose that you select Months and specify one month. If the current date is August 27,
2014 2.30PM, the report is generated for the range:
July 01, 2014, 12.00AM to July 31, 2014, 12.00AM.

o Years - Suppose that you select Years and specify one year.If the current date is August 27, 2014
2.30PM, the report is generated for the range:
January 01, 2013, 12.00AM to December 31, 2013, 12.00AM.
o Based on Relative duration - Relative Duration allows a report to be scheduled at a time relative to

the current time which might vary based on the current time. For example, 12.45 pm is the relative
time with respect to the current time (12.45 pm).

o Hours - Suppose that you select Hours and specify one hour. If the current user specified time is
4.20PM, the report is generated for the time range, 3.20PM to 4.20PM.

o Days - Suppose that you select Days and specify one day. If the current date is August 27, 2014
and the current user specified time is 10.15AM, the report is generated for the range: August 26,
2014, 10.15AM to August 27, 2014, 10.15AM.

o Weeks - Suppose that you select Weeks and specify one week. If the current date is August 27,
2014 12.30PM and the day is Wednesday, the report is generated for the range: Thursday, August
21,2014 12.30PM to Wednesday, August 27, 2014 12.30PM.
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o Months - Suppose that you select Months and specify one month. If the current date is August 27,

2014, 2.30PM the report is generated for the range:
July 27, 2014 2.30PM to August 27, 2014 2.30PM.

o Years - Suppose that you select Years and specify one year.If the current date is August 27, 2014
2.30PM, the report is generated for the range: August 27, 2013 2.30PM to August 27, 2014 2.30PM.

Generate a List from the Scheduled Report

You can generate a list from the output of the scheduled report. Make sure that your lists are created in
NetWitness Platform prior to generating a list to schedule a report.

To generate a list from the Build Report view, perform the following:

L.

10.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

In the Reports panel, select a report and in Actions column, click ¥ 7 > Schedule Report.

The Schedule Report view tab is displayed.

In the Output Actions section, in Dynamic List panel, click +

The Generate List dialog box opens.

Click Browse.

The List Selection panel is displayed.

Choose a list item and click Select.

The list name gets populated in the List Name field.

Select a valid rule to filter the report results further based on the rule definition.
Select a value for the Column field.

The column forms the values for the list that gets created.

If you want to overwrite the existing list, select the Overwrite Existing List? checkbox.

Click Save.

The list name gets populated in the Generate List panel.

Create and Schedule a Report
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List Mame: $[/Per User Report/List of Service:| | Browse
Rule Access o G v
Calumn filename v

[# Ouerwrite Existing List ?

Cancel Save
11. (Optional) Select a list from the Generate List panel and click = to delete the selected list.

12. (Optional) Select a list from the Generate List panel and click d to edit the list details.

Create a Parameterized Report Using Variable

You use variables for reporting in the RSA NetWitness Platform Reporting module. Parameterized
reporting allows you to specify values dynamically at runtime without changing the rule definition so you
can view the results based on a particular value. You can achieve parameterize reporting by using
variables in the query or rule. For information on adding a rule, see Configure a Rule. At runtime, you
can enter the value for the variable or select the value from the list based on which the result set is
displayed.

The syntax to specify the variable is as follows:

Examples of Supported
Description

Syntax

Insert $ before a variable. columnname=${<variable>}

Enclose a variable within
braces.

The syntax to define the variable is the same for NetWitness DB and Warehouse DB data sources.
When you assign the value of the variable in a Run Configuration, you must enclose the value within
single quotes: '<value>"'.

Note: If you have multiple rules in a parameterized report, you must specify the value individually for
every rule in the scheduler. For example, if you want a report that use five rules that pulls information
related to user.dst and you have specified ${InvestigationUser} variable in every rule, then
you must specify the user name five times.

Some examples where a variable can be used are provided in this section.
View Source IP Addresses for a Specific Destination Country

The following is an example of a NetWitness DB rule to view the source and destination ip addresses
for a specific destination country. Here the value for source country is defined as a variable $ {1ocal
country}.
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P

Monitor C Admin (@  admin v

REPORTS

Manage View [RULE] IP addresses foras... @
Build Rule - -
Meta
Rule Type MetWitness Platform DB BH - Concentrator -
Name P addresses for a specific destination country e X
S
Custom v o5
access.point
Select ip.src, ip.dst, country.dst
h action
Alias Source |P address ad.computer.dst
Where country.src = ${Local_Country} ad.computer.src
ad.domain.dst
ad.domain.src
ad.username.dst
Group By p.sreip.dst.country.dst
ad.username.src
Then Enter a then clause.. b
Lists
e x
b = ~
4= Insert o8
Order By Column Name Sort By = ResortingTest
Enter the column name.. Ascending -
= list123
0 <
imit 20 <
Use Save Reset Test Rule - D

RS /\ NETWITNESS  PLATFORM 11.4.0.0

At runtime, you are prompted to enter the value for the variable. The figure below shows the 1ocal
Country variable where you can enter the value. If you enter the value as United states, all the source
and destination ip addresses with destination country as United states are listed.
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Data Source 2012 35 00:00 IP Addresses For A Specific Destination ... 2013 3 08:00
Conc-240 hd
Format 5L No Source IP Address Destination IP address Destination Country |~
Tabular v 1 United States
Time Range 2 United States
Range v 3 United States 2
From 4 United States
2012-06-0 ] At 00:00 v 5 United States
To ) 6 United States m
2013102 At 08:00 v 5 United States
Variable Value a United States
Country United st... =] United States
7 Select List 10 United States
11 United States
12 United States
13 United States
14 United States
15 United States
186 United States
17 United States il

You can use the above rule to schedule a report. You can schedule two types of reports:
o Report with Dynamic Variables

o Iterative Report

Report with Dynamic Variables

Dynamic variables allows the user to specify the values for a variable defined in a rule while scheduling
a report.

To schedule a report with Dynamic Variable, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.

The Report view is displayed.

On the Reports panel, click + to create a report.
Enter the Report Name in the field.

Add the rule by drag and drop which has the user defined variable from the Rules tab.
Click Schedule.

S

The Schedule Report view tab is displayed.
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Schedule Report

Enable ™
Report Mame Report-IP address for a specific destination country
Schedule Name | Dynamic Variables Report

MetWitness DB | Concentrator-194 - C |+

B Rule: IP address for a specific destination country

local_Country S[Country_List]

] Output Actions

#) Logo

Reset £ Configure

Time Zone UTC {(GMT+00:00) v | [l Set Default
Run Now ~
On Past ¥ 30 & Days v | [ Use relative time calculation
Variables lterative Report [
Variable ~ Value Iterative

7. To execute the reports as per the schedule, select the Enable checkbox.

8. In the Schedule Name field, enter a name for the schedule report configuration.

9. Inthe NetWitness DB drop-down, select the database.

10. From the Time Zone drop-down, select a time zone to display all the time-related data in a report
output in the specified format.This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

11. From the Run field, select the type of run schedule. (For example, Now or Hourly). Depending on

the type of run schedule, do either of the following:

o Ifyouselect a Later or Monthly run schedule, you must provide a value for the day and time in

the respective field provided.

o If you select an Hourly run schedule, you must specify the minutes in the At Minute field.

o Ifyou select a Daily run schedule, you must enter a time value in the At field.

o If you select a Weekly run schedule, you must enter a value in the At field and also select the

week days.

Create and Schedule a Report
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Note: While scheduling a report, if you select Paste option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.

12. 1In the variables field, click lﬁ
13. Do one of the following:

o Enter the value for the variable, or

o Choose the list value for the variable.

List Selection Window

¥ Refresh
List Name ~
25
CJCampliance
= Country_List
CFileering Candidate
= Local_Country
CLlogs
CONetwork Activity
= TCP_Source_Port

[ User Activity

Close Select

14. Click Select.
15. Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.
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Manage View [REPT] Report-IP address fo... [REPT] ReportIP address f_. @
L=
Report-IP address for a specific NETWITNESS 1 I::::ﬂaym -
destination country PLATFORM A
Generated on - 2016-02-19 14:06 (+00:00) < February 2016 - N
2016 | 3 | 14:06:00 (+00:00) Time Range 2016 | | 14:05:59 (+00:00) SomoT oW T oF s

IP address for a specific destination country / Concentrator-194 - Cancentrator

1P Source

— e — [CEREREI AR o |

United States

United States

)
2
3
4

Reports
Time

13:96

View All Destination IP Addresses for a Source IP Address

The following is an example of a Warehouse rule to view all the destination IP addresses for a specific
source IP. The source IP address ip src is defined as a variable $ {IP Address}.

Build Rule

Rule Type ‘Warehouse OB

Expert Mode

Mame Destination IP for 3 specific Source [P
Zelect ip.sre. ip.dst c:}untr_\,-'.:lsl:i

From sessions L

Alias ip.src, ip_dst. country_dst

Where Ip.sre is not MULL and ip.sre = S{IP Address}

Group By

Having

Order By Column Kame Sort By
Enter the column name... Azcending

Limit 20 2

l:l Save Reset Test Rule

At runtime, you are prompted to enter the source IP address. The figure below shows the IP Address

variable, and you can enter a valid source IP address. All the destination IP addresses with the specified
source P are listed.
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10 . . . 10
Data Source 2013 ,, 00:00 Destination IP For Specific Source IP 2013 ,, 08:00
Warehouse - WC20433 v
5L No ip_sre ip_dst country_dst i
Format
Tabular v 1
Time Range 2
Range v 3 2
Frem 4
2013-10-0 ] At 00:00 v 5
To [
2013102 At 0200 v |
Variable Value 1
IP_Addres= WEF R =]
= 10
7 select List

.

Associate a Variable to a List of Values

You can associate the variable to a list. For example, you can create a list called Local Country
and enter all the country names as values. You can select the list Local Country as the value for the
variable Local Country. At Run Configuration, the Local Country list is populated and you can
select the country based on which results are displayed.
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B[] Logs

B[] Network Activity
B[] Per User Report
[ T

Iterative Report

An iterative report generates a report for every value in the list.

To schedule an iterative report, perform the following:

L.

AN

Go to Monitor > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

On the Reports panel, click + to create a report.
Enter a Report name in the field.

Add the rule which has the user defined variable from the Rules tab.

Click Schedule.
The Schedule Report view tab is displayed.

Create and Schedule a Report
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10.

Schedule Report

Enable ™
Report Mame Report-IP address for a specific destination country
Schedule Name | Dynamic Variables Report

MetWitness DB | Concentrator-194 - C |+

Time Zone UTC {GMT+00:00) v | [l Set Default
Run Now ~
On Past ¥ 30 & Days v | [ Use relative time calculation
Variables Iterative Report [
Variable ~ Value Iterative

B Rule: IP address for a specific destination country

local_Country S[Country_List] Mo [

] Output Actions

#) Logo

Reset 4* Configure

To execute the reports as per the schedule, select the Enable checkbox.

In the Schedule Name field, enter a name for the schedule report configuration.

From the Data Source ficld, select the data source.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information, see
"Configure Data Source Permissions" topic in the Reporting Engine Configuration Guide.

(Optional) From the Warehouse Resource Pool drop-down, select the pools or queues available in
the cluster to schedule the report to run on either the pool or queue. This drop-down list is available
only if you select a Warehouse DB report.

Note: All the queues or pools you specified in the Explore page for the Reporting Engine are
listed. If no pools or queues are configured in the Explorer page, this drop-down is disabled and the
jobs are submitted to the clusters without any a queue or pool name.
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Note: If the pool or queue configured in the report schedule is removed from the Cluster, then in
the Capacity Scheduler, the queue name remains undefined. However, in the Fair Scheduler, the
specified pool name will be created using the property
mapred.fairscheduler.allow.undeclared.pool.

11. From the Time Zone drop-down, select a time zone to display all the time-related data in a report
output in the specified format. This setting is configurable from the Reporting Engine Explore view
(/com.rsa.soc.re/configuration/reportoutputformatterconfig/reportoutputformatterconfig).

12. From the Run field, select the type of run schedule. (For example, Now or Hourly). Depending on
the type of run schedule, do either of the following:

If you select a Later or Monthly run schedule, you must provide a value for the day and time in
the respective field provided.

If you select an Hourly run schedule, you must specify the minutes in the At Minute field.
If you select a Daily run schedule, you must enter a time value in the At field.

If you select a Weekly run schedule, you must enter a value in the At field and also select the
week days.

Note: While scheduling a report, if you select Paste option or Range (specific/generic) option or
an end time range very close to the current time, you must ensure that the aggregate data in the
data source is returned. If there is an aggregation delay in the data source, the end time you choose
must account for the delay, otherwise reports lose non-aggregate data for that time range.

13. In the variables field, do the following:

a.

b.

To run iterative reports, select the Iterative Report checkbox.

To Iterate on List value, click *.
The List Selection Window opens.
Choose a list and click Select.

The list item selected gets added to the Iterate on List field.
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d. Select the variable on which the selected list value has to be applied.

Variables Iterative Report M
lterate On List  |$[/Local_Country] R
Apply To var w
Variable ~ Value Iterative

B Rule: My_Rule

r
var $[/Local_Country] Yes

14. Click Schedule.
The scheduled report executes as scheduled and provides the configured outputs.

The following figure shows the Iterative Report view.

Sub Reports

This report has been generated for each value in the configured list. Selectthe report
that you Want 1o view.

X
values State View Report
balivia' Completed @ View
nicaragus’ Completed @ View
honduras' Completed @ View
gibraltar' Completed @ WView
martinique’ Comp ered Wiew
cote dV'hgire' Completed L] WView
congo, the democratic republic of the Completed @ Wiew
faroe islands' Completed @ View
el salvador' Completed @ View
grenada’ Completed @ Wiew
maldives' Completed @ View
maoldova, republic of Completed @ View
tunisia’ Completed @ View
jordan Completed @ WView
french guiana’ Comp ered Wiew
kemiA Camnlered @ Wi v

| Page 1 | ofl | | C Displaying 1 - 25 of 25
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Manage View [RULE] IP address for a spe... [REPT] Report P address fo.. [REPT] ReportIP address f.. ®
B850
Report-IP address for a specific Friday
degtmation count P NETWITNESS February 19, 2016
Y PLATFORM
Generated on - 20160219 14:24 (-00:00) ” e — >
2016 | 3 | 14:24:00 (+00:00) Time Range 2016 % | 14:23:59 (+00:00) somoT ow T F s
12 3 4 5 &
IP address for a specific destination country / Concentrator-194 - Concentrator 7 8 9 10 M 12 13
IP Source IP Destination vtry 1415 16 17 18 JRE
|
2
| Page 1 |of1 | | | PegeSize [30 v Displaying 1 - 207 2
Reports
Time
1423

Create a Report Using a Rule

You can create a report using a rule. When you create a report using a rule, a default report is created
with this single rule. You can further edit the report to add more rules.

To create a report using a rule, perform the following:

1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Choose any of the following:

o Create a report using a rule when you create or edit the rule:

a. Inthe Rules view, select a rule and click B > Use> Report.

The Use Rule dialog is displayed.
e Select a rule in the Rules panel and click B
menu, select Use > Report.

&

o In the Rules panel click "~ > Create Report.

in the Rule toolbar. From the drop-down

Note: Custom rules can be used to create a Report and If you select the view for the rule as "Area" or

"Pie", a window pops up for X-Axis and Y-Axis inputs. By default, you can select only the first meta
in X-Axis.

3. Select New Report or Existing Report based on your requirement.

4. Click Select.
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View a Report

You can view a report or list of all reports. You can also view the scheduled reports to know the state of
the scheduled report. If the scheduled report is in a stop or disable state, you can start or enable the
scheduled report.

After you view a report, you can perform any of the following tasks:

1. You can print, save, email and view reports on full screen.

2. Youcan also select a date from the calendar to view a list of successfully run reports for the chosen
date.

To view a report, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.
3. Inthe Reports panel, select a report and in Actions column, click ¥ " > View Scheduled

Reports.

4. Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled report.

MONITOR

Report Schedule
+ | | ¥ & | ™ AutoRefresh Filter Schedule By Name
O Name ~ Schedule Last Run Duration(H:M:S) Avg(H:M:S) State View Report Actions
O Malware Activiey Hourly 2017-08-0909:15  00:00:03 00:00:02 Completed @ Jie &
| Page 1 |of1 | | C Pagesize (30 v Displaying 1 - 1 of 1
[RS/\ NETWITNESS' PLATFORM 11.2.0.0

5. Select a scheduled report and click View.
One of the following is displayed:

o The selected report.

o The Sub reports panel for a scheduled report having 'Iterative' selected.

For each value in the configured list a report is displayed.
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Note: If the report status is partial or complete, the "last run timestamp" and the "last run

(seconds)" are updated. However, the average time taken to run the report is updated only when
the report status is complete and not when it is partial.

To view a list of all reports, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, click View All Reports.
A list of reports along with their schedule name and time are displayed on the View tab.

Note: If no list is displayed, select a date from the calendar to view a list of reports for
that date.

Investigate  Monitor  Configure  Admin

Chart  Alert  Warehouse Analytics
Reports Wednesday
August 23,2017
Filter By R Or Schedule Name

Rep August 2017~ >

s M T w T F s

2017-08-23 02:00 L
6 7 8 9 10 1M 12
1314 15 16 17 18 19

20 21 2 E

RS /\ NETWITNESS  PLATFORM 11.4.0.0

4. Double-click on a report to view the details of the report.
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5. You can select a scheduled report and print, save as PDF/CSV, send email notifications, or view it
on full screen.

R S/\ Respond Inve ate Monitor Configure Admin

admin v

OVERVIEW REPORTS

Manage View [REPT] [REPT] Aggregation ©

LRy =]

Aggregation NETWITNESS Monday
Generated on - 2017-08-21 09:56 (+00:00) PLATFORM August 21,2017

_ August 2017 - >
2017 % 07:00:00 (+00:00) Time Range 2017 % 08:59:59 (+00:00) —

2 s M T w T F s

. 12 3 4 s
Average Function / nw-malware - Broker
6 7 8 9 10 11 12

Source IP Address Destination IP Address avg(size)

13 14 15 16 17 18 19

1 14641758
~ I =

9059450
3 8684244
4
. Reports
s

Time

6
_ 09:56
8

RS /\ NETWITNESS' PLATFORM 11.400
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Investigate a Report

You can investigate a report by directly navigating to the Investigation View from the report. With the
Investigate a report option, you can investigate each event mentioned in the report.

To investigate a report, perform the following:

L.

Go to Monitor > Reports.

The Manage tab is displayed.

Click Reports.

The Report view is displayed.

In the Reports toolbar, click View All Reports.
The View All Reports tab is displayed.

Note: If no reports are displayed in the View All Reports, select a date for which you want to
display the reports.

Double-click the report name to view the report details.

The Report details screen is displayed.

RSA Respond vestigate ~ Monitor  Configure  Admin

OVERVIEW REPORTS

Manage View [REPT] test chart @

test chart
Generated on - 2017-06-07 10:13 (+00:00) NETWITNESS 0 Wednesday
PLATFORM June7. 2017

2017 §5  07:20:00 (+00:00) Time Range 2017 3§ 07:30:00 (+00:00) DIl ©
S M T W T F s
Session Analysis / Concentrator v
Session Analysis Total events count N > ¢ & i 10
1 watchlist dst 3 " n
2 first carve 4
3 first carve not dns 4
4 session size 100-250k 5
5 ntial beacon 7 Reports
A sessinn size 10-50k 11 Time v

RS /\ NETWITNESSPLATFORM 11.4.00

You can click on the session analysis to investigate on the report.

Note: If you want to manually copy the result data and use it for investigation, make sure that the
binary values are prefixed with 'hex:'.
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Manage Lists, Rules or Reports

You can set access control, delete, edit, import, or export a list, rule or report.

Manage a List

You can perform the following procedures to manage a list.
« Access Control for a List and List Group

o Edit a List

o Delete a List or List Group

o Duplicate a List

o Export a List or List Group

o Import a List or List Group

Access Control for a List and List Group

You can set up the access permissions for the user roles to manage lists or list groups. The Reporting
provides access control at the list and list group level. Only a user who has the right set of permissions
can perform the tasks in the Reporting. The access control is managed by the administrator

from the Admin > Security > Roles tab.

As an administrator you must ensure that the roles created for specific tasks have access to all the
permissions higher in the hierarchy of roles.

Lists or list groups can be assigned to a specific set of user roles. When users log into NetWitness
Platform, they can access only those lists to which they belong. Users who belong to a user role with the
Read & Write access permission have full access rights on the lists. Further, the access can be
strengthened so that lists are accessed only by those who have the Read Only access.

Note: You must have Read Only permission for a list group to view the lists within that group.

For example, if you want Security Analysts to have access to all the lists in a list group, you can set the
permission Read & Write at the list group level. And, if you do not want the Operator role to have
access to a specific set of lists in a list group, you can set the permission No Access at the list group
level.

At the list or list group level, you can set the following access permissions for the user roles in
NetWitness Platform. For more information, see List View:

e Read & Write
e Read Only

e No Access
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Lists Permissions

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators O O O
Analysts

Data_Privacy_Officers
Malware_Analysts
Operators
Response_Administ...

S0C_Managers

000 0|0|0|0
000 0|0|0|0
© ® ® ® ® ® ®

Security_Administra...

Cancel Save

The following table lists the columns in the Lists Permissions panel:

Roles Describes roles of the users logged into the NetWitness Platform user interface.

Read & Allows users to access, view, edit, delete, import, and export lists on the Lists view.

Write Users can also change the permission on the rule.

Read Allows users to only access and view the list on the lists view.
Only

No Doesn't allow users to access or view the lists.

Access

Access Control for a List

To change the list permissions, you must select a list and set access permissions using the List
Permissions panel.

If you want to change the access permission for a specific user role, you must set it at the list level.
Except for administrators, the default permission set for all the other user roles is No Access before
applying job permissions.
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Access Control Multiple Lists

You can select multiple lists at once and set access permissions using the Lists Permissions Panel. The
access permission that you choose is applied to all the selected lists.

Note: The "*" beside the role name indicates that other permissions are available for the user role. If
you want to change the access permission for the required user role, select the user role and change
the access permission.

Lists Permissions

Multiple objects selected

Roles ~ Read & Write Read Only No Access
Administrators ® O O
Analysts O O ®
Data_Privacy_Officers O O ®
Malware_Analysts O O ®
Operators O O ®
S0C_Managers O O ®

Cancel Save

Note: If a user (other than ADMIN) creates a list, ADMIN cannot access that list.

Access Control for a List Group

To change the list group permissions, you must select a list group and set access permissions using the
Lists Permissions panel.

If you want to change the access permission for a specific user role, you must set it at the list group
level. Except for administrators, the default permission set for all the other user roles is No Access
before applying job permissions.

You can also apply permissions to subgroups and lists in the group by selecting the checkbox.
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Lists Permissions

Network Activity

Roles -~ Read & Write Read Only Mo Access
Administrators O] O O
Analysts

Data_Privacy_Officers
Mahware_Analysts
Operators
Response_Administ...

50C_Managers

0000000
OO0 00000
©® ® ® ® ® @

Security_Administra...

[] Apply these permissions to sub-groups and Lists in this group

Cancel Save

The following scenarios describe defining permissions for list groups or subgroups and lists in the groups:

o Scenario 1: Permissions applied to list group or subgroup based on the user role.

Each of the levels will have a permission set depending on the user role. For example, if a list group
is assigned the role of Security Analyst, permissions are set to Read & Write for the list group.

o Scenario 2: Permissions applied to subgroups and lists in the group.

The access permissions that you set can be applied to subgroups and child objects of this group.
Permission at the list group level will be inherited by the subgroups and lists in the group.

Permissions applied to list
Permissions applied to subgroup

Role (Analysts) | group or subgroup based

and lists in the group
on the user role

Group Read & Write Read & Write
Subgroup Read Read & Write - Inherited
Lists Read Read & Write - Inherited

Access permission for a list or list group

Ensure that you have at least Read & Write access permission so that you can set access permissions
for lists or list groups.
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To set access permission for a list, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Lists.
The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details 2
Groups Lists
+ [SAN -2 + | e
aome 1| mame ~ o Date Modified Actions
All [ 5] O Blackiisted IPs 2017-05-03 08:39 & o
» [0 Compliance (o] [ Compliance Data 2017-05.03 08:32 &
[ Fikenng Candicaces o [ Compliance Systems 2017-0503 08:34 &
[ Network Activity o
[0 Content Delivery Networks 2017-05-03 08:28 & o
[ Listof Alias Hosts 2017.05.03 0831 &
[0 Listof 1P Addresses 2017-05.03 08:32 &
[ Listof Message ID 2017-0503 0833 &

3. Inthe Lists panel, select a list.

4. Click 2 > Permissions in the List toolbar.
The List Permissions dialog is displayed.

Lists Permissions

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators . O O
Analysts O O ®
Data_Privacy_Officers O O ()
Malware_Analysts O O O]
Operators O O )
Response_Administ... O O ®
S0C_Managers O O O]
Security_Administra... O O @

Cancel Save
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5. Select the appropriate access permission for each of the user roles and click Save.

A confirmation message that the permission is successfully set for the selected list is displayed.

To set access control for a list group, perform the following:

1. Go to Monitor > Reports.

The Manage tab is displayed.

2. Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics search Report Details &5
Groups Lists
+ - Clwe + 17w
— T mame ~ e Date Modified Actions
&y o [ Blackiistad IPs 2017-05-03 0839 I
» (I compliance (o} [ Compliance Data 2017-05-03 08:33 e
> EaFivering Candidates o [0 Compliance Systems 2017-05-03 08:34 e
DNEMWkA“iViW a [ Content Delivery Networks 2017-05-03 08:28 & ©
[ List of Alias Hosts 2017-05-03 08:31 & ©
[ List of IP Addresses 2017-05-03 08:32 & ©
[ List of Message ID 2017-05-03 08:33 & ©
3. Inthe Lists Groups panel, select a list group.
U - -
4. Click > Permissions.
The List Permissions dialog is displayed.
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Lists Permissions

Cancel Save

Network Activity
Roles ~ Read & Write Read Only
Administrators O] O O
Analysts O O ®
Data_Privacy_Officers O O -
Mahware_Analysts Q O .
Operators @] O 0]
Response_Administ... O O O]
S0C_Managers O O O]
Security_Administra... @) O ®
[] Apply thess permissions to sub-groups and Lists in this group

5. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child objects

of this group.
6. Click Save.

A confirmation message that the permission is successfully set for the selected list group is

displayed.

Edit a List

To edit a list, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.
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Manage View

Rules Reports

Groups
+ - o wo
Groups

All
¥ ClCompliance
¥+ [JFieering Candidates

[INetwork Activity

[LIST] Blacklisted IPs

Charts Alerts Lists Warehouse Analytics

0000

Lists

Name ~ Group

Blacklisted IPs
Compliance Data
Compliance Systems
Content Delivery Networks
List of Alias Hosts

List of IP Addresses

O 0 0O o oo o0g4

List of Message ID

Search Report Details

Date Modified

2017-05-03 08:39

2017-05-03 08:33

2017-05-03 08:34

2017-05-03 08:28

2017-05-03 08:31

2017-05-03 08:32

2017-05-03 08:33

Actions

L= JRHC-JARC- JRNE-TRRE-MNE-

3. Inthe Lists panel, select a list that you want to edit and do one of the following.

e Click lj in the Lists toolbar.

e Inthe Lists panel, click

¥ Edit,

Note: You can only edit one list at a time.

4. Modify the required fields and add new values to the list.
5. Click Save.

A confirmation message that the list is saved successfully is displayed.

Delete a List or List Group

To delete a list, perform the following:

1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Lists.

The List view is displayed.

Manage View

Rules  Reports

Groups

+ Tl
Groups ~

Al

» D3 Compliance

» D Fitring Candicaces

[ Network Ay

Charts

0000

[LIST] Blacklisted IPs

Aerts [ISSM  warehouse Analytics

Lists
| &

Name ~ Group.

Blacklisted IPs.

List of Alias Hosts

List of IP Addresses

O o0 oo oo o/dg

List of Message ID

Search Report Details

Date Modified
2017-05-03 08:29
20170503 08:23
20170503 08:34
2017-05-03 08:28
2017-05-03 08:31
2017-05-03 08:32

20170503 08:23

CIRRE-JRE-J00E - JRNC-00E - 200 -

3. Inthe Lists panel, do one of the following:

« Select a list or multiple lists that you want to delete and click — in the Lists toolbar.

o In the Actions column, click

ﬁv

> Delete.
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A confirmation dialog is displayed.

Do you want to delete the selected List(s)?

Note: Before you delete a list, make sure that the list is not associated with any rule.

4. Click Yes to delete the list.

A confirmation message that the list is deleted is displayed and the selected list is deleted from the
List View panel.

To delete a list group, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.

I view  (LisTIBlackiisted iPs
Rules  Reports  Charts  Alerts Warehouse Analytics Search Report Details [
Groups Lists
+ Tlawe + | *
Groups ~ 1 Name » DsteModiied | Actions
e (-] [ Blackiisted IPs. 2017-05-03 08:39 L]
o [ Compliance Data 2017-05-03 08:33 E)
© | O Complance Systems 20170503 0834 3
O | O ConteneDetvery Necworks 2017.0503 0828 B
[ Listof Aliss Hoses 201705030831 3
[ Listof IP Addresses 20170503 0832 3
[ Listof Messsge ID 2017.0503 0833 )

3. Inthe Lists Groups panel, select the group and click

A confirmation dialog is displayed.

Do you want to delete the selected group?

Caution: If you delete a group, all subgroups and lists in that group are deleted.

4. Click Yes to delete the selected group.
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Note: If you try to delete a list group that has lists referenced in a rule or an alert, a warning message
that Lists are referenced in a rule is displayed.

Duplicate a List

To duplicate a list, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.

Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details )
Groups Lists
+ - C & + |5 &
@ B trme @y Date Modified Actont
e (-] [ Blackiisted IPs. 2017-05-03 08:39 R
» D1 Complance o | o 201705030833 B
» Cfikering Candidaces o o 2017-05-03 08:34 #0
Eiemwerk vy ° [ Content Delivery Networks 201705030828 &o
[ List of Alias Hosts 2017-05-03 08:31 &
[ Listof IP Addresses 2017-05-03 08:32 &
[ Listof Message ID 201705030833 &o
3. Inthe Lists panel, select a list that you want to duplicate.
Note: You can only duplicate one list at a time.
4. In the Lists toolbar, click @
Export a List or List Group
To export a list, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.
Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details )
Groups Lists
+ - C & + |5 &
@ B trme @y Date Modified Actont
e (-] [ Blackiisted IPs. 2017-05-03 08:39 R
» D1 Complance o | o 201705030833 B
YDy Cnddes @ | [ 20170503 0834 ER
Eiemwerk vy ° [ Content Delivery Networks 201705030828 &o
[ List of Alias Hosts 2017-05-03 08:31 &
[ Listof IP Addresses 2017-05-03 08:32 &
[ Listof Message ID 201705030833 &o
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3.

In the Lists panel, do one of the following:

- > Export in the List toolbar.
o 3G

You can export multiple lists at a time. To select multiple lists, select the checkbox of the lists to be
exported. A browser-specific export dialog may be displayed allowing you to open or save the file.

o Select a list and click

e In Actions column, click > Export

To export a list group, perform the following:

You can export selected list groups to an external file that can be later imported to NetWitness Platform.
If nothing is selected in the List Library panel, the entire list tree is exported. When you export, the
result is a single export file in binary format.

I.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Lists.

The List view is displayed.

Manage View [LIST] Blacklisted IPs

Rules Reports Charts Alerts m Warehouse Analytics Search Report Details ke

Groups Lists
+ - me + [
Groups ~ O Name ~ Group Date Modified Actions

e [ Blacklisted IPs 2017-05-03 08:39

» [ Compliance [] Compliance Daca 2017-05-03 08:33

[ Filtering Candidates
s [ Compliance Systems 2017-05-03 08:34

(2 I - - ]

[ Network Activity
[ Content Delivery Networks 2017-05-03 08:28

[ Listof Alias Hosts 2017-05-03 08:31

[ Listof IP Addresses 2017-05-03 08:32

E-JRNE-JRRE- JRNE-JRRE- J0NE- IR0 -3

[ Listof Message ID 2017-05-03 08:33

In the Lists Groups panel, select the list group containing the lists which you want to export.

Click % > Export.

You can export multiple list groups at a time. To select multiple list groups, press and hold the CTRL
button and select the list groups to be exported. The exported file is saved to the local drive.

Import a List or List Group

To import a list, perform the following:

You can import lists from instances of NetWitness Platform into the list tree in the List View panel.
Lists must be in a valid binary file exported from a NetWitness Platform instance.

I.

Go to Monitor> Reports.
The Manage tab is displayed.
Click Lists.

The List view is displayed.
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Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details ke3
Groups Lists
+ SR - 1= + | £
Groups ~ O Name ~ Group Date Modified Actions.
A (5] [] Blacklisted IPs. 2017-05-03 08:38 (.38
» B Cempliance o [ Compliance Dats 2017-05-03 08:33 .=
¥ EaRiering Candidares o [J Compliance Systems 2017-05-03 08:34 (.38
CaNenwort Acty ° [J Content Delivery Networks 2017-05-03 08:28 L« 382
[ List of Alias Hosts 2017-05-03 08:31 L« 382
[ List of IP Addresses 2017-05-03 08:32 L« 382
[ List of Message ID 2017-05-03 08:33 L« 382
3. Inthe Lists toolbar, click 8- > Import.
The Import List dialog box is displayed.
Note: You can import multiple lists at a time. To select multiple lists, press and hold the CTRL
button and select the lists to be imported.
4. Click Browse and select archived file containing the lists.
Import List
+ Browse... Delete
File Name ~ Overwrite ?
Archive.zip CList
5. Click Import.
Note: During the import process, if a duplicate list exists and you do not select the overwrite option,
the list is imported and no message about duplicate lists is displayed.
To import a list group, perform the following:
You can import list groups from instances of NetWitness Platform into the list tree in the List Groups
panel. Lists must be in a valid binary file exported from a NetWitness Platform instance.
1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Lists.
The List view is displayed.
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Manage View [LIST] Blacklisted IPs
Rules Reports Charts Alerts Lists Warehouse Analytics Search Report Details ¥
Groups Lists
+ Clme + I L
Groups ~ O Name ~ Group Date Modified Actions.
o (5] [0 Blacklisted IPs 2017-05-03 08:38 F1C
» O Compliance o [ Compliance Dats 2017-05-03 08:33 # o
» [ fikenng Candidaces ° [ Compliance Systems 2017-05-03 08:34 -
I Netwaork Activity (o]
[ Content Delivery Networks 2017-05-03 08:28 L XS
[ Listof Alias Hosts 2017-05-03 08:31 L XS
[ Listof IP Addresses 2017-05-03 08:32 L XS
[ Listof Message ID 2017-05-03 08:33 L XS
& -

3. Inthe Lists Groups panel, click > Import.
The Import List dialog box is displayed.

4. Click Browse and select archived file containing the list groups.

Import List

=+ Browse... Delete
File Name ~ Owverwrite ?
Archive.zip Clist

Close Import

You can import multiple list groups at a time. To select multiple list groups, press and hold the CTRL
button and select the list groups to be imported.

5. Click Import.

Note: During the import process, if a duplicate list group exists and you do not select the overwrite
option, the list group is imported and no message about duplicate list group is displayed.

Manage a Rule

Y ou can perform the following procedures to manage a rule.

o Access Control for a Rule and Rule Group

o Delete a Rule or Rule Group

o Duplicate a Rule
» Edit a Rule

o View Dependents of a Rule

o Export a Rule or Rule Group
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Access Control for a Rule and Rule Group

To set access permissions the user will have depending on the user role to manage a rule or rule group.
The Reporting provides access control at the rule and rule group level. Only a user who has the right set
of permissions can perform the tasks in the Reporting. The access control is managed by the
administrator from the Admin > Security > Roles tab.

When creating users and user roles, the administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Rules or Rule Groups can be tied to a specific set of user roles so that when a user logs into NetWitness
Platform, the only rules they can access are rules accessible to the group to which the user belongs.
Users that belong to a user role with the ‘Read & Write’ access permission have full access rights on the
rule. Further, the access can be tightened so that rules are accessed only by those who have the ‘Read
Only’ access.

Note: You must at least have ‘Read Only’ permission on a group to view the rules within that group.

At the rule level, you can set the following access permissions for the user roles:
e Read & Write
e Read Only

e No Access

Suppose, you want the Security Analysts to have access to all the rules in a Rule Group, you can set the
permission 'Read & Write' at the Rule Group level. And, if you do not want the Operator role to have
access to a specific set of rules in a rule group, you can set the permission 'No Access' at the Rule
Group level. The permission is set only for the rule group but not the rules or subgroups in the Rule
Group.

Access Control for a Rule Group

When you want to change the rule group permissions, you must select a rule group and set access
permissions using the Rule Permissions panel.

Before applying rule group permissions, the default permission set for all the user roles is 'No Access'
permission, and the checkboxes are deselected.
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Rules Permissions

Roles ~ Read & Write Read Only Mo Access
Administrators 2 -
Analystl 8

Analysts s

Ewvent Stream A... 2
Malware_Analysts .

Managers 8

Operators 8

Security ) =

[ Apply these permissions to sub-groups and Rules in this group

Cancel sSave

If you want to change the access permission for a specific user role, you must set these at the rule group
level, as shown in the figure. Suppose, you want the Administrators to have access to all the rules in a
Rule Group, you can set the permission 'Read & Write' in the Rule Group Permissions panel.
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Rules Permissions

Cancel sSave

Roles ~ Read & Write Read Only Mo Access
Administrators . O O
Analystl L

Analysts L
Ewvent Stream A... L
Malware_Analysts D] D] -
Managers L
Operators L
Security L

[ Apply these permissions to sub-groups and Rules in this group

You can also apply permissions to subgroups and rules in the group by selecting the checkbox.

The two scenarios are explained in brief:

o Scenario 1: Permissions applied to Rule Group/ Sub Group/ Rules based on the user role.

o Scenario 2: Permissions applied to Sub Group and Rules in the Group.

Permissions applied to Rule Group/

Role
Sub Group/ Rules based on the user
(Analysts)
role
Group Read & Write
Sub Group Read
Rules Read

Permissions applied to Sub

group and Rules in the

Group

Read & Write
Read & Write - Inherited
Read & Write - Inherited

The access permissions that you set can be applied to subgroups and child objects of this group.

The Rule Group will be assigned the role of a Security Analyst and permissions are set to Read &

Write rule group.

For scenario 1, each of the levels will have a permission set depending on the user role. For scenario 2,
the permission at the Rule Group level will be inherited by the Sub Group and Rules in the Group.

Manage Lists, Rules or Reports

94



Reporting User Guide

Access Control for a Rule

When you want to change the rule permissions, you must select a rule and set their access permissions
using the Rule Permissions panel.

Before applying the Rule permissions, the default permission set for all the user roles is 'No Access'
permission and the checkbox is deselected.

Rules Permissions

Source and Destination Details

Roles = Read & Write Read only No ACcess
Admin1 .
Adminlstrators L
Analystl .
Analysts »
Malware_Analysts 2
Operator] »
Operators »
50C_Managers .

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the rule level,
as shown in the figure. Suppose, you want the Administrators to have access to a specific rule, you can
set the permission 'Read & Write' in the Rule Permissions panel.
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Rules Permissions

Source and Destination Details

Roles - Read & Write Read Only Mo ACcess
Administrators L -
Analystl s

Analysts )

Event Stream A_.. )
Malware_Analysts .

Managers =

Operators )

Security L

Users * M

Cancel Save

Access Control for a Rule When Multiple Rules are Selected

When you want to change permissions of multiple rules, you can select multiple rules at a time and set
their access permissions using the Rules Permissions Panel. The access permission that you choose will
be applied to all the selected rules.

Note: The '*' besides the role name indicates the other permissions available on the user role. If you
want to change the access permission for the required user role, select the user role and change the
access permission.
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Rules Permissions

Multiple objects selected

Roles ~ Read & Write Read Only Mo Access
Administrators® -
Analystl*

Analysts .

Event Stream A... .
Malware_Analysts .

Managers .

Operators .

Security®

|Jzers* -
“*=* indicates other permissions on the object. Select the required cbject only to modify
the permission

Cancel Save

Log in as a specific user and view the access details

When you log in to the NetWitness Platform UI as a user having 'Read access' permission, all the rules

will be denoted with the symbol (m) and when you click on the symbol the 'Read Only' callout is
displayed on the Rules panel.

When you log in to the NetWitness Platform

UI as a user not having 'Read & Write' access permission on a Rule, all the rules will be denoted with
the symbol ( %) and the rules appear grayed out on the Rules List panel.

The following figure shows the Rules panel when logged in with minimal 'Read & Write' access
permission.

[ wname ~ Type Group Date Modified Actions
O *(raw_log)-RULE Warehouse Aggregare Function 2014-07-12 09:46 f+ 28

O Warehouse Regular 2014-07-1607:34 f+ 28

[ Accounts Created MetWitness DB |dentity Management 2014-07-1410:56 Fo O

[ Accounts Created SAW M Warehouse Compliance_old 2014-07-1405:40 Fo O

[ Accounts Created SAW Warehouse ‘Warehouse 2014-07-25 059:48 Fo O

[ Accounts Created SAW(T) Warehouse ‘Warehouse 2014-07-25 0354 Fo O

[ Accounts Deleted MetWitness DB |dentity Management 2014-06-26 08:35 Fo O

Note: If a user (other than administrator) creates a rule, ADMIN cannot access that rule.

Tabular Listing

The following table lists the columns in the Rules Permissions panel:
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Roles The role of the user logged into the NetWitness Platform user interface.

Read & The user can access, view, edit, delete, import, and export rules on the Rules view. The

Write user can also change the permission on the rule.

Read The user can only access and view the rule on the Rules view

Only

No The user cannot access or view the rule for which this permission is set.
Access

Set Access Control for a Rule

You can set access control for a rule. The Reporting Engine provides access control at the rule level.
Only a user who has the right set of permissions can perform tasks on the rule. The administrator when
creating users and roles must ensure that the roles created for specific tasks have access to all the
permissions higher in the hierarchy of roles.

At the rule level, you can set the following access permissions for the user roles in NetWitness Platform:
o Read & Write — View or edit the rules in the rule group.
o Read Only — View the rules in the rule group.

o No Access — Cannot view or edit the rules in the rule group.

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
rule.

To set access control for a rule, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules panel, select the rule.

3. Click - > Permissions in the Rule toolbar.

The Rules Permissions dialog is displayed.

Manage Lists, Rules or Reports 98



Reporting User Guide

Rules Permissions

Cleartext Authentications by Service

Roles ~ Read & Write Read Only Mo Access
Administrators L)

Analysts L
Data_Privacy_Officers L)
Malware_Analysts O
Operators O
Fespond_Administr... O
S0C_Managers &
UEBA_Analysts &

Cancel Save

4. Select the following appropriate access permission for the user role and click Save.
o Read & Write
o Read Only

e No Access

Set Access Control for a Rule Group

You can set access control at the rule group level. Only a user who has the right set of permissions can
perform the tasks on the rule. The administrator when creating users and roles must ensure that the roles
created for specific tasks have access to all the permissions higher in the hierarchy of roles.

At the rule group level, you can set the following access permissions for the user roles in NetWitness
Platform:

o Read & Write — View or edit the rules in the rule group.
o Read Only — View the rules in the rule group.

o No Access — Cannot view or edit the rule in the rule groups.

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
rule group.

To set access control for a rule group, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.
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2. Inthe Rules Groups panel, select the rule group and Click ﬁ and select Permissions.

The Rules Permissions dialog is displayed.

Rules Permissions

Cleartext Authentications by Service

Roles ~ Read & Write Read Only Mo Access
Administrators &

Analysts L)
Data_Privacy_Officers *
Malware_Analysts O
Cperators L)
Respond_Administr... L)
S0C_Managers )
UEBA_Analysts o

Cancel Save

3. (Optional) Select the appropriate checkbox to apply these permissions to subgroups and child objects
of this group.

4. Click Save.

A confirmation message that permission is successfully set for the selected rule group is displayed.

Delete a Rule or Rule Group
To delete a rule, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. In the Rules panel, do one of the following.

e Select a rule and click = in the Rule toolbar.

o Click e > Delete.

A confirmation dialog is displayed.
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Do you want to delete the selected Rule(s)?

Note: If a rule is being used in a report, a warning that the rule is in use and cannot be deleted
is displayed.

3. Click Yes to delete the rule.

A confirmation message that the rule is deleted successfully is displayed and the selected rule is
deleted from the Rules panel.

To delete a rule group, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.

2. Inthe Rules Groups panel, select the rule group that you want to delete.
3. Click =.

A confirmation dialog is displayed.

Do you want ta delete the selected group?

Note: If any one of the rules in the group is being used in reports, a warning that the rule is in use
and cannot be deleted is displayed.

4. Click Yes to delete the group.

A confirmation message that the group is deleted successfully is displayed and the selected group is
deleted from the Rule Groups panel.

Duplicate a Rule

To duplicate a rule, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules panel, select a rule that you want to duplicate.

3. In the Rule toolbar, click TZ:j
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Edit a Rule

To edit a rule, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. In the Rules panel, do one of the following:

e Select a rule and click lj in the Rule toolbar.

. Click ® ' > Edit.
The Build Rule view tab is displayed.

Session

=]
L)

u
L]
L)

Save Reset Test Rule

MNetWitness Platform DB

Mame Analyst rule

Summarize Custom -

Select username.bin. user.src.bin, user.srcbin

Alias

Where wsername.bin exists | | user.dstbin exists | | user.srcbin exists

Group By wsername.bin.user_src.bin,user.src.bin

Ih_?_l_'l_ Enter a then clause..
L

Order 2y Column Name Sort By
Enter the column name... Azcending
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Note: If a rule is edited, the updated rule definition is applied to the Reports, Charts, and Alerts
where the rule is included.

3. Modify the required fields.
4. Click Save.

A confirmation message that the rule is saved successfully is displayed.

When you edit a rule, ensure to re-select the Rule for which you want the Chart to be generated, so that
the edited rule is applied. If you do not re-select the Rule and attempt to save or test the rule, the rule is

saved and a warning message is displayed.

View Dependents of a Rule

You can view dependents of a rule. You must traverse a rule list, select a rule for which you want to

identify the dependency over a report, chart, or alert.

The following figure shows the Rule View where you select the rule

Detalils'.

'Access to Compliance Data

‘Admin Access to Compiiance Systems Denaiis

Admin Access to Compiisnce Systems Summary

Alert |05 by Profiled Source [P

| Page |1 |of18 | 3 B | O Pagesize 30 ~

Type Group

Netiiitness DB Compiiance

gement

zgemant

zgement

Date Moamed Actions

011125 (48 - o

- JINE- JRNE - JMAE- AR - ARAE- JRAE- 2R - JRAE- AMRE- MAE - JMAE - JRAE - JHRE -

-
2014-05-01 1125

Displaying 1- 30 of 211

The following figure shows the dependency of the rule over alerts and reports.
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Rule Dependencies

The following entities reference this rule:
Entity Name Path

B Reports =

All compliance

Pavan/Al compliance
CEAE G . Crrnmlizme Dot i o —
SSAE1E- Compliznce Report Compliznce/SSAE-16/55AE 16-C...
Access to Compliance Data - Detail

Compliance’Access to Complianc. .

BASEL Il - Compliznce Repart Compliznce/BASEL I/BASELI1-C...

SO - Comoliznc oot N - - .
50K - Compliznce Report Compliance/S00050X - Complian. ..

FERPA - Compliance Report Compliznce/ FERPA/FERPA - Com...

PAA - Compliznce Report N )
HIPAA - Compliznee Report Compliance/HIPAA/HIPAA - Com...

The following table lists the various columns in the Rule Dependencies dialog and their description.

Entity Name  The name of the entity referencing the rule.

Path The path where the entity is located in the user interface.
To view dependents of a rule, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Rules.
The Rule view is displayed.

3. Inthe Rules panel, select a rule and in Actions column, click B > Dependents.
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The Rule Dependencies dialog is displayed.

Rule Dependencies

The fallewving entities reference this rule:
Entity Name Psth

B Reports -
Pavan/Al complisnoe

arnce Report Compliance/S5AE-16/S5AE 16-C...

Compliance/Access to Complianc. ..

BASEL Il - Compliance Report Compliance/BASEL [/BASEL Il - C...

Compliance/50X50% - Complian. ..

pliantE REport Compliance/FERPA/FERPA - Com...

RiatiLE mEpst Compliance/HIPAAHIPAS - Com. . -

Export a Rule or Rule Group

Note: Make sure that you have rules in the rule group.

To export a rule, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.

In the Rules panel, do one of the following:

-

o Select a rule and click
e Click BC > Export.

2. A browser-specific export dialog may be displayed, allowing you to open or save the file. You can
export multiple rules at a time. To select multiple rule, press and hold the CTRL button and select the
rules to be exported.

> Export in the Rule toolbar.

To export a rule group, perform the following :
1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules Groups panel, select the rule group containing the rules which you want to export.
You can export multiple rules groups at a time. To select multiple rule groups, press and hold the
CTRL button and select the rules groups to be exported.

3. Click L > Export.
A browser-specific export dialog may be displayed allowing you to open or save the file.
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Manage a Report

You can perform the following procedures to manage a report.

« Access Control for a Report or Report Group

o Delete a Report or Report Group

« Duplicate a Report

« Edit a Report
« Refresh a Report Group or Report List

« Edit a Scheduled Report
o Delete a Scheduled Report

o Export a Report
o Export a Report Group

o Import a Report or Report Group
o Enable or Disable a Scheduled Report

o Start or Stop a Scheduled Report

o View an Execution History of a Scheduled Report

o Manage and Select a Report Logo

o Search Reporting Details

Access Control for a Report or Report Group

This section covers the access permissions the user has depending on the user role to manage a report
and report group. The Reporting provides access control at the report and report group level. The user
who has the right set of permissions can only perform the tasks in reporting module. The access control
is managed by the administrator from the Admin > Security > Roles tab.

When creating users and user roles, the administrator must ensure that the roles created for specific
tasks have access to all the permissions higher in the hierarchy of roles.

Reports and Report Groups can be tied to a specific set of user roles so that when a user logs into
NetWitness Platform, the reports with the access rights for the specific user role can be viewed. Users
that belong to a user role with the ‘Read & Write’ access permission can define reports. Further, the
access can be tightened so that reports are accessed only by those who have the ‘Read Only’ access.

Note: You must have ‘Read Only’ permission for a group to view the reports within that group.

At the report level, you can set the following access permissions for the user roles in NetWitness
Platform:
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o Read & Write
e Read Only

e No Access

Suppose, you want the NetWitness Platform to have access to all the reports in a Report Group, you can
set the permission 'Read & Write' at the Report Group level. And, if you do not want the Operator role
to have access to a specific set of reports in a report group, you can set the permission 'No Access' at
the Report Group level.

The permission is set only for the report group but not the reports, rules, or subgroups in the Report
Group.

Access Control for a Report Group

When you want to change the report group permissions, you must select a report group and set access
permissions using the Reports Permissions panel.

Before applying report group permissions, the default permission set for all the user roles is 'No Access',
except for Administrators, as shown in the figure.

Reports Permissions

Roles = Read & Write Read Only Mo ACCESS
Admin . -
Adminlstrators $

Analyst] 2

Analysts 2

Malware_Analysts
Cperator]

Ciperators

["1 Apply these permissions to sub-groups and Reports in this group

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the report
group level, as shown in the figure. <suppose,>Administrators to have access to all the reports in a
Report Group, you can set the permission 'Read & Write' in the Report Group Permissions panel.

You can also apply permissions to subgroups and reports in the group, as well as apply read-only
permission to rules in the reports by selecting the appropriate checkboxes, as shown in the figure.
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Reports Permissions

Roles =~ Redd & Write Read Only Mo ACCEss
Admin1 @ @ ® -
Administrators ® @ Q

Analyst] o ] -

Analysts o o Ll
Malware_Analysts 0] @] ]

Operator] o @ Il L
Operators Q o ®

[+ Apply these permissions to sub-groups and Reports in this group

™ Apply Read-only permizsion to Rules in the Reports

Cancel Save

The three scenarios are explained in brief:
o Scenario 1: Permissions applied to Report Group/ Sub Group/ Report based on the user role.

o Scenario 2: Permissions applied to Sub Group and Report in the Group.

o Scenario 3: Read-only permission applied to Rules in the Report.

Permissions Permissions
oy applied to Report | applied to Sub Permission (Read-
ole
Group/ Sub Group/ | group and only) applied to
(Analyst) . .
Report based on Reportin the Rules in the Report
the user role Group
Group Read & Read & Write Read & Write Read & Write
Write
Sub Read Read Read & Write - Read & Write
Group Inherited
Report Read Read Read & Write - Read & Write
Inherited
Rules Read Read Read Read

The Report Group will be assigned the role of a Security Analyst and permissions are set to Read &
Write report group.
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For scenario 1, each of the levels has a permission set depending on the user role. For scenario 2, the
permission at the Report Group level (Read & Write) is inherited by the Sub Group and Reports in the
Group. For scenario 3, the Read permission is set for the Rules except that the permission set for the
rules cannot be higher than the permissions set for the Report Group.

Access Control for a Report

When you want to change the report permissions, you must select a report and set their access
permissions using the Report Permissions panel.

'

Before applying the Report permissions, the default permission set for all the user roles is 'No Access
permission and the checkbox is unchecked, as shown in the figure.

Reports Permissions

Aggregate Functions

Roles ~ Read & Write Read Only Mo ACCess
Admind .
Adminlstrators .
Analystl $
Analysts .
Malware_Analysts >
Cperator] .
Ciperators .
50C_Managers .
[1 Apply Read-only permission to Rules in the Reports

Cancel Save

If you want to change the access permission for a specific user role, you must set these at the report
level, as shown in the figure. Suppose, you want the Administrators to have access to a specific report,
you can set the permission 'Read & Write' in the Report Permissions panel.

You can apply read-only permission to rules in the reports by selecting the checkbox, as shown in the
figure.
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Reports Permissions

Aggregate Functions

Roles ~ Read & Write Read Only Mo Access
Admint @ < ®
Administrators ® Q Q
Analyst Q o -
Analysts Q o ]
Malware_Analysts Q o =
Operator] Q o =
Operators Q Q =
SOC_Managers o o ®
[] Apply Read-only permission to Rules in the Reports

Cancel Save

The two scenarios are explained in brief:
o Scenario 1: Permissions applied to Report Group/ Sub Group/ Report/ Rules.

o Scenario 2: Read-only permission applied to Rules in the Report.

Permissions applied to

Role Report Group/ Sub Group/ | Permission (Read-only)

(Analysts) | Report/ Rules based on applied to Rules in the Report

the user role

Group Read & Read & Write Read & Write
Write

Sub Read Read Read & Write

Group

Report Read Read Read & Write

Rules Read Read Read

The Report will be assigned the role of a Security Analyst and permissions are set to Read &
Write reports.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the Rules except that the permission for the rules cannot be higher than the
permission for the Reports.
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Note: If the permission for the rules is higher than the permission for the Reports then the permission
is be applied only to the reports. For example, if you set the permissions for the Report Group as No
Access and then specify the option Apply Read-only permission to Rules in the Reports, then the read-
only permission is not set for the rules.

Access Control for a Report When Multiple Reports are Selected

When you want to change permissions of multiple reports, you must select several reports and set their
access permissions using the Report Permissions panel. The access permission that you choose is
applied to all the selected reports.

Reports Permissions

Multiple objects selected

Roles =~ Read & write Read Only Mo Access
Adminl 2
Administrators .

Analyst] .
Analysts s
Malware_Analysts L
Operator] .
Operators .
S0C_Managers s
[] Apply Read-cnly permission to Rules in the Reports

Cancel Save

Access Control for a Report When Multiple Reports with several rules are Selected

When you want to change permissions when multiple reports with several rules are selected, you must
select the checkbox in the Report Permissions panel, as shown in the figure. The read-only access
permission is applied to all the rules of the selected reports, provided that the permission of the rules are
lower than the permission of the reports.
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Reports Permissions

Multiple objects selected

Roles = Read & Write Read Only Mo Access
Admin L
Administrators .

Analystl .
Analysts 2
Malware_Analysts s
Operator] ®
Operators 2
50C_Managers s
¥ Apply Read-only permission to Rules in the Reports

Cancel Save

Log in as a specific user and view the access details

When you log in to the NetWitness Platform UI as a user having 'Read access' permission, all the

reports is denoted with the symbol (I:D) and when you click on the symbol the 'Read Only' callout is
displayed on the Reports panel.

When you log in to the NetWitness Platform Ul as a user not having 'Read & Write' access
permission on a Report, all the reports are denoted with the symbol ( #) and the reports appear grayed
out on the Reports panel.

The following figure shows the Reports panel when logged in with minimal 'Read & Write' access
permission.

[ | Name ~ Group Date Modifled # Schedules  Actlons

b 0 % -

b 0 =2

] ] % -

b 0 =2
Note: If a User (other than the super user) creates a report there will be no access to that report for
the super user.

Tabular Listing

The following table lists the various columns in the Reports Permissions Panel:
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Roles
Read & Write

Read Only

No Access

Apply these permissions

to subgroups and Reports in
this group

Apply Read-only

permission to Rules in the
Reports

The role of the user logged into the NetWitness Platform UI.

The user can access, view, edit, import, export, and delete the report
on the Reports view. The user can also change the permission on the
report.

The user can only access and view the report on the Reports view.

The user cannot access or view the report for which this permission is
set.

Select the checkbox to apply the selected permissions to the report
group, subgroups in the group and reports in the group.

Note: This checkbox is populated only when you set access
permissions for a Report Group.

Select the checkbox to automatically apply permissions to the rules in
the reports.

Set Access Control for a Report

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a

report.

To set access permissions for a report, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.

The Report view is displayed.

3. Inthe Reports panel, select a report.

4. Click ¥ ~ > Permissions.

The Reports Permissions dialog is displayed.
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Reports Permissions

Aggregate Functions

Roles = Read & Write Read Only Mo ACCESS
Admin 2
Administrators 2

Analyst] .
Analysts .
MalwareAnalysts 2
COperator] 2
Cperators .
50C_Managers .
[[] Apply Read-only permission to Rules in the Reports

Cancel Save

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox, if you want to provide read access permission to rules in the reports.

Note: On selecting the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

7. Click Save.

A confirmation message that the permission is set for the selected report is displayed.
Set Access Control for a Report Group

Prerequisites

Make sure that you have a minimal 'Read & Write' access permission to set access permissions for a
report group.

To set access permissions for a Report Group, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Reports Groups panel, select or right-click on a report group.

4. Click ¥~ > Permissions.
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The Reports Permissions dialog box is displayed.

Reports Permissions

Roles = Read & write Read Only Mo Access
Admin . -
Administrators 2

Analyst] .

Analysts .
MalwareAnalysts .

Operator] .

Operators .

[7] Apply these permissions to sub-groups and Reports in this group

Cancel Save

4. Based on the user role, select the appropriate buttons.

5. (Optional) Select the appropriate checkbox to apply the selected permissions to subgroups and reports
in the group.

6. (Optional) Select the appropriate checkbox to provide read access permission to rules in the reports.

Note: On selecting the check box, all dependent rules is given READ access permission, provided
the permissions for the report is higher compared to the permissions of the rules.

7. Click Save.

A confirmation message that the permission is successfully set for the selected report group is
displayed.

Delete a Report or Report Group

To delete reports in a group or subgroup from the Reports panel:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Reports panel, do one of the following:
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o Select the reports and click =.

o Click 3. > Delete.

A confirmation dialog is displayed.

Do you want to delete the selected Report(s)?

4. Click Yes to delete the report.

A confirmation message that the report is deleted successfully is displayed and the selected report is

deleted from the Reports panel.

Delete a Report Group

Prerequisites

Make sure that you have no reports associated with the report group.

To delete report groups in the default folder or subgroups under a report group, perform the following:

1.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

. In the Reports Groups panel, select the report group and click =.

A confirmation dialog is displayed.

Do you want to delete the selected group?

Click Yes to delete the group.

A confirmation message that the group is deleted successfully is displayed and the selected group is
deleted from the Report Groups panel.

Duplicate a Report

You can duplicate a report to schedule multiple report for the same report. The duplicated report is
displayed in the Reports panel with suffixes. For example, Report (1).

Generally, the duplicate option is used in two scenarios:
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o You want to make a copy of the report, to move the same report to another group.

e You want to retain most of the configuration settings for an object but modify few of these settings.
For example, when you have a complex query in a rule or several rules in a report, it is very much
appropriate to use the duplicate option.

To duplicate an existing report, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report that you want to duplicate and click IJ—E:j
The report is saved successfully and added to the Report list.

You can move the duplicated report to another group.

Edit a Report

To edit reports in a group or subgroup from the Reports panel, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.

The Report view is displayed.

3. Select a report and in Actions column, click &> Edit.
The Build Report view tab is displayed.

1P sre report RSN sz | [ R

Heager 1 Hl

B P Sources Tabular
Header2 H2

B P Sources Line ~ | Optiens 9 | Heacers H3

Header4. H4

4. Modify the text and add more rules to the report (if required).
5. Click Save.

A confirmation message that the report is saved successfully is displayed.
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Refresh a Report Group or Report List

You can refresh a report group or reports to view the re-arrangement of groups or reports.
To refresh a report group or reports, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Do the following to move the group or reports to a new location:
o In the Reports Groups panel, drag and drop the group.

« In the Reports panel, drag and drop the reports to the desired group in the Report Groups panel.
The report group or reports are moved to the new location.

4. Do the following to refresh a group or report list:

-
o In the Reports Groups panel, click %
The report group gets refreshed.

 In the Reports panel, click < .
The Report list gets refreshed.

Edit a Scheduled Report
To edit a scheduled report from the Scheduled Reports List panel, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report and in Actions column, click # /> View Scheduled
Reports.

The Report Schedule tab is displayed.
4. In the Report Schedule panel, do one of the following:

e Select a report and click E] .

o Select a report and click ¥ " > Edit Schedule.
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The Schedule Report tab is displayed.
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5.

10.

11.

12.

13.

In the Schedule Report tab, do the following:
a. Inthe Schedule Name field, modify the name for the schedule report configuration.

b. To execute the reports as per the schedule, select the Enable checkbox.

c. From the Data Source field, select the datasource.

Note: If the data source is not listed, ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information,
see "Configure Data Source Permissions" topic in the Reporting Engine Configuration Guide.

(Optional) From the Warehouse Resource Pool drop-down, select the pool or queue for the report.

Note: The Warehouse Resource Pool drop- down is displayed only if the Warehouse Rule is
selected. If no pools or queues are entered for the Reporting Engine, this field is disabled.

From the Run field, select the type of run schedule. (For example, Now or Hourly).

Select the date range to run the query based on absolute duration or select the Use relative time
duration checkbox to run the query based on relative duration.

(Optional) In the Output Actions panel, do the following:
a. Type the email address and subject.

b. Edit the body of the message for the report.

c. Select the format of the attachment.

d. Type a value for the CSV and Multivalue delimiters.
(Optional) In the Other Options field, do the following:

a. Click ¥ ° > SFTP or URL or Network Share. Based on the selected option, a row gets added
in the Other options field.

b. Select the appropriate options to send the report in PDF or CSV format to the configured SFTP,
URL or Network Share.

(Optional) To add a list in the Dynamic List panel, see Generate a List from the Scheduled Report
section in Create and Schedule a Report.

(Optional) To choose another logo in the Logo panel, see Manage and Select a Report Logo section.

Note: If you do not specify a logo, the default RSA logo is used.

Click Schedule.

The scheduled report executes as scheduled and provides the configured outputs.

Delete a Scheduled Report

To delete a scheduled report from the Scheduled Reports List panel, perform the following:

1.

Go to Monitor > Reports.
The Manage tab is displayed.
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2. Click Reports.
The Report view is displayed.

3. Inthe Reports toolbar, click View All Schedules.
View Report Schedule is displayed.

4. In the Report Schedule panel, select the report.

5. Click #.2 >Delete Schedule.

A confirmation dialog is displayed.

Do you want to delete the selected Schedule(s)?

6. Click Yes to delete the scheduled report.

A confirmation message that the scheduled report is deleted successfully is displayed and the
selected schedule is deleted from the Scheduled Reports List panel.

Export a Report

You can export the selected reports to an external file that can be later imported to another NetWitness

Platform environment.

Prerequisites

Make sure that you have reports in the report group.

To export selected reports in the Report Groups panel to an external file, perform the following:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
In the Reports panel, do one of the following:

e Select a report and click 8> Export.

« Click > Export.
3. You can export multiple reports at a time. To select multiple reports, check the checkbox of the
report to be exported. The exported file is saved to the local drive in an archived format.

Open CSV files with Unicode characters in MS Excel
To open downloaded CSV files containing Unicode characters in MS Excel, follow these steps:

1. Download and save the CSV file.

2. Open Microsoft Excel and navigate to the Data tab.
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3. Click on From Text menu item; find the CSV file that you downloaded and click Import.
The Text Import Wizard is displayed.

Select Delimited or Fixed Width data type from the Original data type radio button.
Click File origin drop down list and select 65001: Unicode (UTF-8) and click Next.

Select the delimiter that was used in the file that you imported and click Next.

N S ok

Select the data format for each column of data that you want to import and click Finish.
The correct output is displayed in an MS Excel sheet.

Export a Report Group

You can export a selected report groups to an external file that can be later imported to another
NetWitness Platform environment.
Prerequisites
Make sure that you have reports in the Report Group.
To export selected report groups in the Report Groups panel to an external file, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. In the Reports Groups panel, select a report group and click ® “ and select one of the following:
o Export - This selection exports a report in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.
You can export multiple report groups at a time. To select multiple report groups, press and hold

the CTRL button and select the report groups to be exported. The exported file is saved to the
local drive.

Import a Report or Report Group

You can import a group containing subgroups and reports from other instances of NetWitness Platform
into Report Groups panel. Reports must be in a valid binary file that was exported from another
NetWitness Platform instance.

During the import process, you select the binary file and specify whether existing reports with the same
name must be overwritten or not by the reports contained in the binary import file.

o If you choose to overwrite, all duplicate rules, lists and reports are overwritten by the contents of the

binary import file.

« If you choose not to overwrite, and a duplicate rule, list or report exists in the target folder, the import
fails and display a message about duplicate reports.

Y ou cannot import reports to a specific report group. The imported files are stored in the Allroot folder.
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Prerequisites

Make sure that you have the reports or report groups exported from other instances of NetWitness
Platform.

To import groups containing subgroups and reports from other instances of NetWitness Platform into
Report Groups panel, perform the following:

L.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Reports.

The Report view is displayed.

3. Inthe Reports Groups panel, select a folder to import the file.

10.

Do one of the following:
« In the Reports Groups toolbar, click 3 “ > Import to import a group.

o In the Reports toolbar, click # * > Import to import a report.
The Import Report dialog is displayed. You can import multiple reports and report groups at a
time. To select multiple reports or report groups, press and hold the CTRL button and select the
reports or report groups to be imported.

Click Browse to select the binary file.

NetWitness Platformprovides a file system view of the files.

Locate the binary file and click Open.

The file gets added to the Import Report list.

(Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, check the Rule checkbox. If you do not select the Overwrite option, and an

identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

(Optional) To overwrite any existing list in the library with an identically named list in the binary
file, check the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

(Optional) To overwrite any existing report in the library with an identically named report in the
binary file when importing, check the Report checkbox. If you do not select the Overwrite option,
and an identical report is encountered in the binary file, the binary file is imported and no error
message is displayed.

Click Import to import the binary file.
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Enable or Disable a Scheduled Report

To enable or disable a scheduled report from the Scheduled Reports List panel, perform the
following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report and click # " > View Scheduled Reports.
View Report Schedule is displayed.

4. Select a report from the Report Schedule panel.

5. Inthe Actions column, click % 0 > Enable.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. 1Inthe Actions column, click ¥ 0 > Disable.
The state of the report is changed to ‘Inactive’.

Start or Stop a Scheduled Report

To start or stop a scheduled report, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report and click # " > View Scheduled Reports.
The Report Schedule view is displayed.

4. Select a report from the Scheduled Reports List panel.

5. Inthe Actions column, click ¥ > Start.
The state of the report is changed to ‘Running’, if the report is scheduled to run immediately.

6. Inthe Actions column, click = > Stop.
The state of the report is changed to ‘Completed’.

View an Execution History of a Scheduled Report

You can view the execution history of a scheduled report. You can view the history of a scheduled report
that is run. You can view the history based on the following criteria:
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o Number of past schedules executed

o Start date and end date for the date range

You can view the details such as how many times the scheduled report was executed, the time of
execution (seconds), execution state. You can also view the report generated on a full screen.

To view the execution history of a scheduled report, perform the following:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, do one of the following:
« Click 2 > View Scheduled Reports.

o Click the #Schedules column.
The Schedule Reports view tab is displayed with the status of each of the scheduled report.

4. Do one of the following:
o Select a scheduled report and click ¥ " > Execution History.

e Select a scheduled report and click 9
The Execution History view is displayed.

Note: By default, you can view 10 number of execution history of a scheduled report. The
execution history shown depends on the Retain Report History Configuration set on the Generaltab
of the Admin > Services > Reporting Engine Configview.

For example, if you set the Retain Report History Configuration to 100 days, the data displayed on
the Execution History view. is the past 100 days execution history details considering the current
date information.

5. From the Get history by: field, select the type of history to be fetched. (For example, Past or Range
(Specific))

6. In the Count field, enter the number of executions to be displayed.

7. Click Show History.
The execution history of the scheduled report is displayed.

Manage and Select a Report Logo

Prerequisites

Make sure that you have the Reporting Engine service defined prior to managing a logo.
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Manage Report Logos

To manage logos, perform the following:
1. Go to Admin > Services.

The Services view is displayed.

2. Inthe Services panel, select an Reporting Engine service and click % *

The services config view is displayed.
3. Select the Manage Logos tab.
All the available logos are displayed.

Add a Logo
To add a logo, perform the following:

1. Inthe Manage Logos tab, click +

A file browser opens where you can choose the file from the local drive.

2. Select the logo and click Open.
The selected logo gets added to the Manage Logos section.

Delete a Logo

To delete a logo, perform the following:

1. Inthe Manage Logos tab, do one of the following:
o Select the logo and click = .

e Perform (Ctrl+click) to select multiple logos and click =.

A confirmation dialog is displayed.

n Are you sure you want to delete the selected logos?

2. If you want to delete the logo, click Yes.
The selected logo is deleted from the Manage Logos section.
Set Default Logo
To set a default logo, perform the following:
In the Manage Logos tab, select a logo and click & Setdefault

The chosen logo is set as the default logo for the RE service.

Selecta Logo

To select a logo, perform the following:

View > Config.
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1. Go to Monitor> Reports.

The Manage tab is displayed.
2. Click Reports.

The Report view is displayed.

3. Inthe Reports panel, select a report.

4. Click ® > View Scheduled Reports.

The View scheduled reports view tab is displayed.

5. Select a scheduled report and in Actions column, click ¥ " > Edit Schedule.

The Schedule Report view tab is displayed.

6. Inthe Logo panel, click Change Logo.

The Change a Logo dialog box is displayed.

7. Do one of the following:

o Click Upload new logo to upload another logo.

o Select a logo from the list.
8. Click Select.

The selected logo is available on the Logo panel.

Search Reporting Details

This section provides instructions on how to perform a keyword search on name and content for each of
the Reporting components. You can perform a keyword search on name and content for each of the
Reporting components (Rule/Report/Chart/Alert/List) on the Reporting UI.

Note: You cannot search based on date and numeric values.

Groups
+ Cl o
Groups ~
Al
» [ aggregate Funcrion
[ma}
rO
[ma}
[ compliance
» (3 custom Rules
[ Data Exfiltration
[ Filtering Candidate
[ Filtering Candidates
rO
» [ identity Management
[a}
rO

Charts

o®0eBooocobool

<)

Alerts Lists Warehouse Analytics
Rules
+ "ol ¥

]| Name ~

[1  Access to Compliance Data Details
Access to Compliance Data Summary
Accounts Created

1 Accounts Created SAW

Accounts Delsted

] Accounts Deleted SAW
Accounts Disabled

[]  Accounts Disabled SAW
Accounts Modified

[0 Accounts Modified SAW

| Page 1 | of17 | » M | C PageSize 30 ~

Type

Netwitness DB

NetWitness DE

NetWitness DB

Warehouse

NetWitness DB

Warehouse

NetWitness DB

Warehouse

NetWitness DB

Warehouse

Group

Compliance
Compliance
Identity Management
‘Warehouse
Identity Managemant
‘Warehouse
Identity Managemant
‘Warehouse
Identity Management

Warehouse

The following figure shows the search parameters available in the Reporting Module:

]

[ Rule
[0 Report
[] Chart
[ Alert
List
[ Name
[0 Content

Date Modifled

2014-09-01 11

2014-09-01 112

2014-09-01 11:25

2014-09-01 11:25

2014-08-01 11:25

2014-09-01 11:25

2014-08-01 11:25

2014-09-01 11:25

2014-03-01 11:25

=T ARNE- 0K - ARAE - TURE - JRRE- 200 -

2014-09-01 11:25

Displaying 1 - 30 of 505

The following are the search parameters available on the Reporting Ul:
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1. Search for entities (rule, report, chart, alert, list).

2. Search for the entities based on either the name or content.

Note: Searches are case insensitive. For example, Completed is equivalent to completed.

Prerequisites

In the Reporting Module, you can perform a keyword search based on the name and content (definition).
In this context, content implies definition of each of the reporting components. For instance, the value
defined in the rule, report, report schedule, chart, and alert panel. You can also prioritize your search by

selecting either or all of the components: Rule, Report, Chart, Alert, or List.

Note: You cannot search based on the List values and list path stored in schedule definition panel.

For example, to search for the rule name (ExpertRule), you must select Rule, Name, and Content in the

filtering options drop-down to view all the rule names that matched the search. You can
similarly search for a report, chart, alert, or list definition.

To search for reporting details from the Manage tab, perform the following:
1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click ® and select the appropriate criteria to search.
3. Inthe Search field, enter the text to be searched.

The search drop-down list is displayed:

m Reports Charts Alerts Lists Warehouse Analytics ‘ experv] ‘ﬁ‘
™ Expert Rule - Hourly Repart
Groups Rules & import-Export Reports
Rep
o ® .
+ oI -1 + - EORN I | Page |1 | of1 | | C
Groups ~ Name ~ Type Group Dte MioaTTed RetTons
All @ - Access to Compliance Data Details NetWitness DB Compliance 201409011125 | 8% -
» [ Aggregate Function (5]
Access to Compliance Data Summary NetWitness DB Compliance 201408011125 |83
o 124
) Accounts Created Netwitness DB Identity Management 2014-09-01 11:25 3
[} [ ] Accounts Created SAW Warshouse  Waremouse 201408011125 | 8%
[ compliance e
Accounts Deleted NetWitness DB Identity Management 201409011125 |3
» [J Custom Rules o
. s s 0801 11:25
[ Data Extiitration [+ Accounts Deleted SAW Warehouse  Warehouse 201408011125 | 8%
ClFiering Cangideze (0 Accounts Disabled NetWitness DB Identity Management 201408011125 |3
[ Fileering Candidates. 0
Accounts Disabled SAW Warshouse  Warehouse 2014-09.0111:25 |3
o [15]
< 1 = / )14-09-01 11:25
» Dl icentity Monagemen: @) Accounts Modified Netwitness DB Identity Management 2014-08-01 11:2; -3
O [ ] Accounts Modified SAW Warshouse  Warehouse 201409011125 (g3 = M
¥ [ Network Activity D - | Page 1 of17 | » M | C PageSize 30 v Displaying 1 - 30 of 505

Search Syntax and Different Types of Search

The following table explains the search syntax and the possible searches that can be performed on the

Reporting UI.
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Search Types Description

Word or phrase based search Word Based Search:

To search for a word such as "action" or "meta", you must enter the
word in the search box.

The following figure shows the search results for the text action.

actic-n| |ﬁ

- action meta (>ample/DemolDemosample/action meta) «

ﬂ""— action meta (Samplef Dem/attion meta)

- Login-Action

{HE-IM Alert Hules! | est-Login-Acion)

{

&7 action meta
chart (sample/Demodaction meta chart)

- Login-Action

. (Per User Based Heport | Est-Login-Acton)
2 Login-
Action (Test-Login-Action)

@ : L
% Dynamic Report With List for IP SRC

(Per User based Heport/Liynamic Keport With List tor (¥ SHL)
™ Source and Destination Details
tAseregate FunchonHule Brouc>ource and Lestinaton

| Page |1 | oft1 | |

Phrase based search:

A Phrase is a group of words surrounded by double quotes such as
"action meta". To search for a phrase, you must enclose phrases in
double-quotes in the search box.

The following figure shows the search results for the phrase "action

"
meta’.
"action meta’ |ﬂ
& action meta (TR 2L TR
- arction meta (5ample/Demo/Demaozamplelaction meta)
ﬁ"" action meta chart (Sample/Dema/action meta chart)
| Page 1 of1 | |
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Wildcard Search (Single/
Multiple/ Special Character
Search)

The question mark "?" symbol
is used to perform a single
character wild card search and
asterisk "*" symbol is used to
perform multiple character
wildcard search.

Single character search:

The single character wildcard search looks for terms that match
with the single character replaced. For example, to search for
"Expert" or "Export" you can use the search syntax:

Exp?rt

The following figure shows the search results for the wildcard
character Exp?rt.

Exp?r‘tI |'1:"
=7 Import-Export Reports

{Report Groupdimport-Export Reports)
'FExper‘t Rule - : e : i

{Expert Rule - Hourly Report)

Hourly Report

ffd] Import-Export Reports
{Report GroupsImport-Export Reports)

| C

| Page 1 of1 |

Multiple character search:

Multiple character wildcard search looks for 0 or more characters.
For example, to search for Expert, or Experts, you can use the
search syntax:

Expert*
The following figure shows the search results for the wildcard
multiple character Expert®.

Exper‘t*l |'1:"
= Expert Rule - Hourly Report

(Expert Rule - Hourly Report)

% Import-Export Reports
{Repart GroupsImport-Export Reports)

| Page |1 | of1 | | ¢

Special character search:

Certain punctuation and special characters are ignored during
search (@#$%"&*(){}"~=+-[1\?|!:,.). For example, a search for
action-login will be interpreted during search as "action" "login",
that is, if rules exist with name "action-login" and "action@login"
and search string is "action-login", the search result will return both
the rules.

“actinn-lE,%i.'.'.'."l |ﬂ

(RE-IM Alert Rules/Test-Login-Action)

™ ‘Login-Action
™ Login-Action

(Per User Based Heport/ | est-Login-Action)

@ Login-
Action (Test-Login-Action)
| Page 1 | oft1 | | O
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Search Types Description
Search based on name or Search based on name:
content

When you want to search based on the name of a report,
select Reportand Namebox from the filtering options drop-down.

For example, to search for the report name "Report With Multiple
Rules", you can use the search syntax:

"Access to Compliance Data"

Note: When you search for a report, it implies you can search for
the report schedules as well.

The search result will return the report containing the specific

name.
"Access to Compliance Data”| |¢'
2 Access to Compliance Data - Detail i
o (Compliance/Access to Compliance Data - Detail)
¥ Access . "

to Compliance Data - Top 25
= {Lomplance/Access to Lomplance Lkata - |op £2)
& SSAE

16 - Compliance Report
(Lomphances>Ak-1bisbAE Th - Lomphance Heport)

% GPG-

13 - Compliance Report

o (Lomphance/P-130M-13 - Lomphance Heport)
Al

CDI"I"I|:I|iEII'ICE (Pavan/All compliznce])

¥ sox- Compliance Report

= (Compliance/S00050X - Compliance Report)
% NERC-CIP -

— ' n

| Page |1 | oft1 | |

Search based on content:

When you want to search for the content within an alert, say alert
description, select Alert and Content box from the filtering

options drop-down. For example, to search for the alert description
"Device IP Got Detected", you can use the search syntax:

"Device IP Got Detected"

+ = @ | ®Enable ODisable | & & | B Template  E View Schedule <& View Alerts
[l Enabled | Pushed 2 Name Description
o e Yes AT-09863 TCO40 Device IP Got Detected
O @ Mo Con-Broker
o e No Payload

The search will return the result having the specific content.

"Device |P Got Detected”| |ﬁ|
& AT-09863 TCO40 (AT-02863TC040)
| Page |1 | of1 | | &
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The Reporting module user interface provides access to NetWitness charts. The following topics discuss
charts:

o Configure and Generate a Chart

o Configure a Chart
o Schedule a Chart

o View a Chart
o Testa Chart

» Investigate a Chart

o Manage a Chart Group and Chart

Configure and Generate a Chart

Chart is a graphical visualization of data. You can view different kinds of charts, including multiple
types of plot, line, bar, and area charts.

Any NWDB rule in the Reporting Engine system which is not sorted by none can be used to instantly
create a chart. For more information on "How to create an NWDB rule", see Configure a Rule.

The chart interval can be adjusted from the chart definition panel itself. Every time a chart is executed,
it stores its result data locally in the Reporting Engine, so that it can be reviewed in either the Dashboard
View or Chart View without any performance considerations.

The following is an overview of the entire process of configuring and generating a chart.

| |
| | Schedule a Chart r..l
-
|
|
- >
Test a Chart Investigate a Chart

Configure Reporting Engine J‘ Configure a Chart

Manage Chart Groups
and Charts

Setup Access Control for
Charts

Modify or Delete a Chart

Import and Export a Chart

To configure and generate a chart, perform the following:
1. Configure Reporting Engine

2. Configure an NWDB rule

3. Configure a Chart
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Schedule a Chart
View a Chart
Test a Chart

Investigate a Chart

e A A o

Manage a Chart Group and Chart

Configure Reporting Engine

Y ou must configure the Reporting Engine before you can configure and generate a chart. You must also
specify the data source in the Reporting Engine from which the data is extracted. For more information
on how to configure a Reporting Engine, see "Configure Reporting Engine" topic in Reporting Engine
Configuration Guide.

Configure an NWDB Rule

The NetWitness rule which is not sorted by none is used to create a chart. The NetWitness database
extracts the meta from the Reporting Engine and provides the meta for rules. These rules are an essential
building block in managing a chart.

Note: If the rule contains the lookup and add, sum count, or sum values rule actions, the associated
chart will not contain data. Do not use lookup and add function in a rule to create a chart or a report
in a chart format as the output of the lookup and add function in a rule will not be displayed on the
chart and may result in graphical representation of incorrect information. Also, the PDF for that chart
created may show an empty chart or incorrect representation of data.

Configure a Chart
You can configure a chart using the NWDB rules.

Schedule a Chart

After a chart is defined with the required components, you can configure its execution properties by
scheduling a chart. Here, you can quickly view, add, and edit the schedule details for a chart.

View a Chart
You can view the scheduled charts in the Chart View.

Test a Chart

You can run the test on a chart and view all the chart details based on the selected time range.

Access Control for a Chart

The Reporting Module provides access control at the chart level. Only a user who has the right set of
permissions can perform the tasks in Reporting module. The access control is managed by the
administrator from the Administration > Security > Roles tab.

When you create users and user roles, ensure that the roles that you create for specific tasks have access
to all the necessary permissions. This could require permissions at several levels of the role hierarchy.

Charts can be tied to a specific set of user roles so that when a user logs in NetWitness, the charts with
the access rights for the specific user role can be viewed. Users that belong to a user role with the 'Read
& Write' access permission can define charts. Further, the access can be tightened so that charts are
accessed only by those who have the 'Read Only' access.
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At the chart level, you can set the following access permissions for the user roles in NetWitness:
o Read & Write
e Read Only

e No Access

To change the access permission for a specific user role, you must set the permission at the chart level.
For example, for Administrators to have access to a specific chart, you could set the permission 'Read
& Write' in the Charts Permissions dialog.

You can apply read-only permission to rules in the charts by selecting the checkbox.

Two scenarios that describe how to set access control are explained here:
o Scenario 1: Permissions applied to Chart Group/ Subgroup/ Chart/ Rules based on the user role.

o Scenario 2: Read-only permission applied to Rules in the Chart.

Permissions applied

to chart group, Permissions (Read-only)
RO subgroup, chart or applied to rules in the
(Analyst)
rules based on the chart
user role
Group Read & Write Read & Write Read & Write
Subgroup Read Read Read & Write
Chart Read Read Read & Write
Rules Read Read Read

The chart is assigned the role of a Security Analyst and permissions are set to 'Read & Write' charts.

For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the rules except that the permission for the rules cannot be higher than the
permission for the charts.

Note: If the permission for the rules is higher than the permission for the chart, the permission is not
applied. For example, if you set the permissions for the Report Group as No Access and specify the
option Apply Read-only permission to Rules in the Reports, the read-only permission is not set for the
rules.

Access Control for a Chart When Multiple Charts are Selected

To change permissions for multiple charts, you must select several charts and set their access
permissions using the Charts Permissions panel. The access permission that you choose is applied to all
the selected charts.
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Access Control for a Chart When Multiple Charts with Several Rules are Selected

To change access permissions for a specific user role when multiple charts with several rules are
selected, select the checkbox in the Charts Permissions panel.

The read-only access permission is applied to all the rules of the selected charts, provided that the
permission of the rules are lower than the permission of the charts.

Note: If a user (other than the super user) creates a chart, the super user cannot access that chart.

Access Control for a Chart Group

To change chart group permissions, select a chart group and set the access permissions using the Charts
Permissions panel. Before chart group permissions are applied, the default permission set for all the user
roles is 'No Access'.

To change the access permission for a specific user role, set the permission at the chart group level. For
example, for administrators to have access to all the charts in a Chart Group, set the permission 'Read &
Write' in the Charts Group Permissions panel.

You can also apply permissions to subgroups and charts in the group, and apply read-only permission to
rules in the charts by selecting the appropriate checkboxes.

Three scenarios that describe how to set access control are explained here:
o Scenario 1: Permissions applied to chart groups, subgroups, or charts based on user roles.
o Scenario 2: Permissions applied to subgroups and charts in the group.

o Scenario 3: Read-only permission applied to rules in the chart.

Permissions

Permissions

applied to . -
applied to Permissions (Read-
Role chart groups, .
subgroups and | only) applied to rules
(Analyst) |subgroups, or . .
charts in the in the chart
charts based
group
on user roles
Group Read & Read & Write Read & Write Read & Write
Write
Subgroup Read Read Read & Write - Read & Write
Inherited
Chart Read Read Read & Write - Read & Write
Inherited
Rules Read Read Read Read

The chart group is assigned the role of a Security Analyst and permissions are set to 'Read & Write'.

For scenario 1, each of the levels will have a permission set depending on the user role.
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For scenario 2, the permission at the chart group level will be inherited by the subgroup and by charts in
the group.

For scenario 3, the Read permission is set for the rules. However, the permission set for the rules cannot
be higher than the permissions set for the chart group.

The following table lists the columns in the Charts Permissions panel:

Roles The role of the user logged into the NetWitness UI.

Read & Write The user can access, view, edit, import, export, and delete the chart
in the Charts view. The user can also change the permission for the
chart.

Read Only The user can only access and view charts on the Charts view.

No Access The user cannot access or view charts for which this permission is
set.

1 Apply these permissions to  Select the checkbox to apply the selected permissions to the chart
sub-groups and Charts in this ~ &rOuP, subgroups in the group and charts in the group.

group Note: This checkbox is populated only when you set access
permissions for a Chart Group.

1 Apply Read-only Select the checkbox to automatically apply permissions to the rules in

permission to Rules in the the charts.

Charts

Configure a Chart

After a chart is defined with the NetWitness rules with NWDB as the data source, you can configure its
execution properties.

Create a Chart Group
To add groups to the default folder or to add subgroups under a chart group:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Charts.

The Chart view is displayed.
3. Inthe Charts Groups panel, click +

A default group is added in the Chart Groups panel.
4. Enter the name of the new group.

5. Press Enter.
The group is added to the Chart Groups panel.
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Create a Chart
To add charts to a group or subgroup:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Charts to display the Chart view.

3. In the Charts toolbar, click +
The Build Chart tab is displayed.

Build Chart

Enable ™

MName

Rule Basis Select Rule Browse
Data Source Broker W

Interval (Minutes) |5 o

Limit 10 -

Test Chart Reset

4. Enter the name of the chart.

5. For the Reporting Engine to collect the data and generate chart results, select the Enable checkbox.
6. In the Rule Basis field, do the following:

a. Click Browse. The Add Rule dialog box is displayed.

b. Navigate the Rule tree and select a rule.

c. Click Select.
7. The Rule appears in the Rule Basis field.

8. Select the data source from the Data Source drop-down list.

Note: If the default data source is configured in the Reporting Engine, then the data source is
displayed by default on the Build Chart page. If the data source is not displayed, ensure you
have Read permissions set for the data source. This is applicable for NWDB and Warehouse
data sources. For more information, see the "Configure Data Source Permissions" topic in the
Host and Services Configuration Guide.

9. (Optional) To modify the Interval value, click the up or down arrow.
The Interval value is the interval in minutes at which the rule which forms the basis of the chart is
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run to collect data.
10. Select the Limit value to limit the number of records to be displayed.

11. X-Axis and Y-Axis are used to specify the meta to be plotted in charts.
In the X-Axis, the meta for the 'Group by' rule is displayed. In the Y-Axis, the aggregate functions
used in the rule are displayed.

Note: Sum, Count, Countdistinct and Average are the supported aggregate functions for chart.

By default, for Custom Rules with multiple 'Group by', you can select only the first meta in X-
Axis.

12. Click Save.
A confirmation message that the chart is saved successfully is displayed.

Schedule a Chart

Y ou must schedule a chart to further investigate on the chart details.

By enabling a chart, the chart executes as scheduled and provides the configured output with the state of
the chart changed to ‘Scheduled’.

To schedule a chart:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. Inthe Charts panel, select a chart or several charts that display © in the Enabled column.

4. Click ® .
A confirmation message indicates that the chart(s) state is changed successfully.

View a Chart

After you view a chart, you can perform the tasks:
e You can print, save, email and view charts on full screen.

e You can also select a date from the calendar to view a list of successfully run charts for the chosen
date.

To view a chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
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3. Inthe Charts panel, Select a chart and click & > View.

The View Chart view tab is displayed.
In Chart Options, do the following:
a. Select the Time Range.

Note: When you select the Time Range option, you can select a pre-set time range such as last
hour, last 3 hours and the Last N Days...or you can customize the selection by choosing Last N
Days or Custom. If you select Last N Days option, you can view the historical data for a
maximum of 15 days. If you select the Custom option, you can select a start date and end date
to view the data for the selected date range.

. Select the Series, either Chart Values over Time or Chart with Totals.

When you select Chart Values over Time, the chart displays the change in values for the
selected time. When you select Chart with Totals, the chart displays a total for each aggregate
value for the selected time.

. Select Items To Plot to define the number of events to view on the chart.
. From the Chart Type drop-down list, select the chart type.
. Click Reload to reload the selected chart.

If there is a delay in retrieving the historical data for the selected time range, a message is
displayed.

After the chart is generated, a notification is displayed in the notification tray available in the
NetWitness toolbar. For more information on the NetWitness toolbar, see the "Browser Window" topic
in the NetWitness Getting Started Guide.

View all Charts List

To view a list of all the charts:

1.

Go to Monitor > Reports.

The Manage tab is displayed.

Click Charts.

The Chart view is displayed.

. In the Charts toolbar, click View All Charts.

All the executed charts for the selected date are displayed in a new tab.

Note:
* If no list is displayed, you can select a date from the calendar to view a list of charts.
* If you want to view a specific chart, enter the chart name in the search criteria.

Click the chart name to view the chart details for that date.

Test a Chart

You can test a chart in the Test a Chart view.
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To test a chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Do one of the following:

o In the Charts toolbar, click +

o Inthe Charts panel, double-click a chart or select a chart and click d

o Inthe Charts panel, select a chart and in Actions column, click £ C > Edit.
The Build Chart view tab is displayed.

4. Click Test Chart to view the chart.
The View Chart view tab is displayed.

5. Inthe Time Range drop-down, select the hours range.

6. Select the Series, either Chart Values over Time or Chart with Totals.

7. Inthe Items To Plot field, select the number of items to plot.

8. From the Chart Type drop-down list, select the chart type.

9. Click Run Test to run the test.

The chart data (if any) for the selected time range is displayed.

Investigate a Chart

You can investigate the chart by navigating directly to the Investigation module from the chart.
To investigate a chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Inthe Charts toolbar, click View All Charts.

All the executed charts for the selected date from the Chart Options panel are displayed on a new
tab.

4. Double-click the chart name to view the chart details such as the time at which the chart is executed
and the default data source used for the chart execution.

5. Do one of the following:
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o Click a data point on the chart to investigate.

o In the toolbar, click Investigate to investigate for the entire time range.

Manage a Chart Group and Chart

You can manage chart groups and charts using the following procedures.

Manage a Chart Group

Depending on the access permissions set for the user role, you can modify or delete, import or export,
drag and drop a chart, or refresh a chart group.

Modify a Chart Group

To modify a chart group in the default folder or subgroups under a chart group:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Inthe Charts Groups panel, select the chart group to modify.

The selected chart group is modified and can be viewed on the Charts Groups panel.
Delete a Chart Group

To delete a chart group in the default folder or subgroups under a chart group:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Inthe Charts Groups panel, select the group and click =.
A confirmation dialog asks for confirmation that you want to delete the selected group.
4. Click Yes to delete the group.
The selected group is deleted from the Chart Groups panel.

Import a Chart Group

To import chart groups from other instances of NetWitness Platform:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
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3. From the Charts Groups panel, select a folder to import the file.

10.

Do one of the following:
.ﬁ v

The Import Chart dialog box is displayed.

e In the Chart Groups panel, click > Import.

e You can import multiple chart groups at the same time. To select multiple chart groups, press and
hold the CTRL button and select the chart groups to be imported.

Click Browse to select the binary file.

NetWitness provides a file system view of the files.
Locate the binary file and click Open.

The file is added to the Import Chart list.

(Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, select the Rule checkbox. If you do not select the Overwrite option, and an
identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

(Optional) To overwrite any existing list in the library with an identically named list in the binary
file, select the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

(Optional) To overwrite any existing chart in the library with an identically named chart in the binary
file when importing, select the Chart checkbox. If you do not select the Overwrite option and an
identical chart is encountered in the binary file, the binary file is imported and no error message is
displayed.

Click Import to import the binary file.

Export a Chart Group

To export selected chart groups:

1.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Charts.

The Chart view is displayed.

In the Charts Groups panel, select a chart group and click 8- and do one of the following:

o Export - This selection exports a chart in a .zip file.

o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.
You can export multiple chart groups at the same time. To select multiple chart groups, press and

hold the CTRL button and select the chart groups to be exported. The exported file is saved to the
local drive.
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Drag and Drop Chart to a Group

To drag and drop a chart from the Charts panel to a group in the Charts Groups panel:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. Select a chart from the Chart panel and drag and drop the chart to a group in the Chart Groups
panel.

The chart is copied to the group in the Chart Groups panel.
Refresh a Chart Group

To refresh chart groups:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Inthe Charts Groups panel, drag and drop the group.

The chart group is moved to the new location.

. ~y
4. 1Inthe Charts Groups panel, Click * .
The chart group is refreshed.
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Manage a Chart

Depending on the access permissions set for the user role, you can modify or delete, duplicate, import
and export, enable or disable charts, search for existing charts, and refresh a chart list.

Access Control for a Chart

To set access permissions for a chart:

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. Inthe Charts panel, select a chart.

4. Click - > Permissions.

The Charts Permissions dialog box is displayed.

5. Based on the user role, select the appropriate buttons.

6. (Optional) Select the checkbox if you want to provide read access permission to dependent rules.

Note: On selecting the check box, all dependent rules with No access permission are granted a
READ access permission.

7. Click Save.

A confirmation message that the permission is successfully set for the selected chart is displayed.
Modify a Chart

To modify a chart in a group or subgroup:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.
3. Inthe Charts panel, do one of the following:

o Double-click a chart or select a chart and click d

e Select a chart and click - > Edit.
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8.
9.
10.

The Build Chart view tab is displayed.

[CHRT] Cleartext Authentic... &

Build Chart

Enable ™

Mame Cleartext Authentications by Service

Rule Basis fser Activity/Cleartext Authentications by Ser | Browse
Data Source Choose ... “

Interval (Minutes) |15 o

Limit 10 s

Test Chart Reset

Modify the name of the chart.

For the Reporting Engine to collect the data and generate chart results, select the Enable checkbox.

(Optional) In the Rule Basis field, do the following:
a. Click Browse.
The Add Rule dialog is displayed.
b. Navigate the Rule tree and select a rule.
c. Click Select.
The Rule appears in the Rule Basis field.

Select the data source from the Data Source drop-down list.

Note: If the data source is not listed, then ensure you have Read permissions set for the
data source. This is applicable for NWDB and Warehouse data sources. For more
information, see the "Configure Data Source Permissions" topic in the Host and Services
Configuration Guide.

(Optional) To modify the Interval value, click the up or down arrows.
Select the limit value to limit the number of records to be displayed.

Click Save.

A confirmation message that the chart is modified successfully is displayed.
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Delete a Chart

To delete a chart in a group or subgroup:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Charts.
The Chart view is displayed.

3. In the Charts panel, do one of the following:

o Select the charts and click = .

o Click & > Delete.
A confirmation message asks if you want to delete the selected chart.

4. Click Yes to delete the chart.

A confirmation message that the chart is deleted successfully is displayed and the selected chart is

deleted from the Charts panel.
Duplicate a Chart
To duplicate an existing chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. From the Charts panel, select a chart to be duplicated.

4. 1In the Charts toolbar, click TZ:j
The chart is duplicated and gets added to the Charts panel.

Import a Chart

To import charts from other instances of NetWitness:

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. From the Charts Groups panel, select a folder from which to import the file.

4. Do one of the following:
.ﬁ v

The Import Chart dialog box is displayed.

e In the Chart toolbar, click > Import.
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10.

e You can import multiple charts at the same time. To select multiple charts, press and hold the
CTRL button and select the charts to be imported.

Click Browse to select the binary file.

NetWitness provides a file system view of the files.

Locate the binary file and click Open.

The file is added to the Import Chart list.

(Optional) To overwrite any existing rule in the library with an identically named rule in the binary
file when importing, select the Rule checkbox. If you do not select the Overwrite option, and an

identical rule is encountered in the binary file, the binary file is imported and no error message is
displayed.

(Optional) To overwrite any existing list in the library with an identically named list in the binary
file, select the List checkbox. If you do not select the Overwrite option, and an identical list is
encountered in the binary file, the binary file is imported and no error message is displayed.

(Optional) To overwrite any existing chart in the library with an identically named chart in the binary
file when importing, select the Chart checkbox. If you do not select the Overwrite option and an
identical chart is encountered in the binary file, the binary file is imported and no error message is
displayed.

Click Import to import the binary file.

Export a Chart

To export selected charts to an external file:

L.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Charts.

The Chart view is displayed.

.ﬁ.v

o Export - This selection exports a chart in a .zip file.

In the Charts panel, select a chart and click and do one of the following:

o Export as Text - This selection exports a chart from the Reporting Engine in a .zip file which
contains the data in text format.

Y ou can export multiple charts at the same time. To select multiple charts, select the checkboxes of
the charts to be exported. The exported file is saved to the local drive.

Enable a Chart

To enable a chart:

L.

2.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Charts.
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The Chart view is displayed.

3. Inthe Charts panel, select a chart or several charts that display © in the Enabled column.
4. Click #.

A confirmation message indicates that the chart(s) state is changed successfully.

Disable a Chart

To disable a chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. Inthe Charts panel, select a chart or several charts that display ® in the Enabled column.

4. Click <.

A confirmation message indicates that the chart(s) status is changed successfully.
Search an Existing Chart

To search for an existing chart:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Charts.
The Chart view is displayed.

3. Inthe Charts toolbar, enter text in the Search text box.

4. Click o > Chart.
All charts that match the search string are displayed in the search drop-down list.

En1ai|| |'fj

™ Email Senders {User Activity/Email Senders)
“;'} Email senders {User Activity/Email Senders)
| Page 1 of1 | | C

Refresh a Chart

To refresh charts:
1. Go to Monitor > Reports.

The Manage tab is displayed.
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2. Click Charts.
The Chart view is displayed.

3. Inthe Charts panel, drag and drop the charts to the desired group in the Charts Groups panel.
The charts are moved to the new location.

4. Do either of the following:

o In the Charts panel, click C .

o In the Charts toolbar panel, select Auto Refresh.
The Chart list is refreshed.
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Working with Alerts

The Alerting module user interface provides access to NetWitness alerts. The following topics discuss
alerts:

o Alerting Overview

« Configure Reporting Engine

o Configure an Alert

o Schedule an Alert

o View an Alert

» Investigate an Alert

o Manage an Alert and Alert Template

Alerting Overview

Alerts can be used to generate timely insights about current security issues, vulnerabilities, and exploits.
For example, when a malicious email is sent from a compromised account, you would need an alert that
automatically notifies you when such an event occurs.

The following concepts of alerting will help you understand more about alert rules, conditions,
notifications, and templates.

Alert Rules

Alert rules specify the logic for alert generation. Alert rules allow you to set up threshold limits and
define how to be notified if these limits are exceeded. For example, you may set up a rule to be alerted
if the CPU usage remains abnormally high for 5 minutes or more.

Alert Definitions

The alert definition is similar to defining rules for reports. These rules must be defined based on your
use case. Alert definitions are made by selecting the alert rules you define in the Build Rule view. You
select this rule while defining an alert.

Note: You can only alert using rules defined for NetWitness data source.

Once an alert is created, this data is collected from the Reporting Engine and displayed on the user
interface.

Once an alert is defined, you can schedule the alert to run every minute (by default), or run at the
present time, or run at the near future.

Note: In the NetWitness Platform user interface, wherever Date and Time is displayed, it is always
according to the user selected time zone profile.
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Create/Modify Alert

Enzble 0
Rule Basis: Logen Failures Browse
Data Sources:  nw-concd - Concentratar ~| [ Push to decoders

Description

Severity: 1] -

Notification: ] Record [ sMTP [ ShMP [ Syslog
Record SMTP SNMP Syslog
Execute Each event v
Body User: ${meta.user.dst} {Full Name: ${meta.corp.name} - Department: ${meta.corp.dep} - Status: ${meta.corp.status} - Privileges: ${meta.corp.privileges}), Hostname: §{metz.alias.host}
Sody Template v

Alert Notifications
The following are the components required to configure alert notifications:

« Notification server — Notification Server is used to send alert notifications. For example, SMTP mail
server. Once you configure a notification server, you can add it to a rule. When the rule triggers an
alert, the rule will use that server to send alert notifications.

« Notifications — Alert outputs, which can be email, SMTP, SNMP, and Syslog.

o Templates — The pre-defined format of an alert message.

When ever the rule condition is encountered, alerts get generated based on the severity level and notifies
the user depending on the notification method set for that specific alert. The following are the various
notification methods:

o Email/ SMTP: Simple Mail Transfer Protocol (SMTP) sends alert emails for system activity. Email
alerts can be sent to their intended recipients by selecting SMTP as notification type.

o SNMP: Simple Network Management Protocol (SNMP) sends alerts to multiple computers for SNMP
traps. SNMP alerts can be sent to other computers by selecting SNMP as notification type.

o Syslog: Syslog alerts generate notifications from Syslog messages. Syslog alerts can be sent by
selecting Syslog as notification type.

Alerts can be configured to notify events that require attention, or as mechanisms to take automated
actions based on conditions configured in an alert. An alert is sent when conditions within the entity have
met the criteria selected for the alert. The notification criteria determines when and at what frequency
the alert is generated.
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Alert Templates

Alert templates are pre-defined format for an alert message. You can use these templates to create
alerts.

Access Control for Alerting

Depending on the user role, the user is provided with specific set of access permissions in order to
manage an alert. The Administrator manages the access rights provided to each user role from the
Administration > Security > Roles tab. You can set access permissions for the user roles to manage an
alert. The Reporting module provides access control at the alert level.

Note: Reporting Engine Alert permissions are prefixed with 'RE' to distinguish them from Event
Streaming Analysis (ESA).

When you create users and user roles, ensure that the roles that you create for specific tasks have access
to all the necessary permissions. This could require permissions at several levels of the role hierarchy.

Alerts can be combined with a specific set of user roles so that when a user logs into NetWitness, the
only alerts they can access are alerts accessible by the role to which the user belongs. Users that belong
to a user role with the ‘Read & Write’ access permission can define alerts. The access can further be
tightened so that the alerts are accessed only by those who have the ‘Read Only’ access.

At the alert level, you can set the following access permissions for the user roles in NetWitness:
o Read & Write
e Read Only

e No Access

Note: Before applying the Alert permissions, the default permission set for all the user roles is 'No
Access' permission and the checkbox is unchecked.

If you want to change the access permission for a specific user role, you must set it at the alert level.
Except for administrators, the default permission set for all the other user roles is 'No Access'
permission.

The two scenarios are explained in brief:

o Scenario 1: Permissions applied to alert/ rules based on the user role.

o Scenario 2: Read-only permission applied to rules in the Alert.

Permissions Permission
Role applied to Alert/ (Read-only)
(Analysts) Rules based on the | applied to Rules
user role in the Alert
Alert Read & Write Read & Write Read & Write
Rules Read Read Read

The Alert is assigned the role of a Security Analyst and permissions are set to Read & Write alerts.
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For scenario 1, each of the levels has a permission set based on the user role. For scenario 2, the Read
permission is set for the Rules except that the permission for the rules must not be higher than the
permission for the Alerts.

If the permission for the rules is higher than the permission for the Alerts, the permission is not applied.
For example, if you set the permissions for the Alert as No Access and then specify the option Apply
Read-only permission to Rules in the Alerts, the read-only permission is not set for the rules.

Access Control for an Alert When Multiple Alerts are Selected

When you want to change permissions of multiple alerts, you must select several alerts and set their
access permissions using the Alert Permissions panel. The access permission that you choose is applied
to all the selected alerts.

Log in as a specific user and view the access details

When you log in to the NetWitness Ul as a user having Read access permission, all the alerts will be

denoted with the symbol (m) and when you click on the symbol the 'Read Only' callout is displayed on
the Alert panel.

When you log in to the NetWitness UI as a user not having Read & Write access permission on an
Alert, all the alerts will be denoted with the symbol ( %) and the alerts appear grayed out on the Alert
panel.

The following figure shows the Alert panel when logged in with minimal Read & Write access
permission.

1 enabled = Pushed? Name Description Actions
[ ] No ST_Communication to Blacklisted Hosts Record
No Firewall Denied Connections Record

[ ]
L] Mo Firewall Destination IP Addresses Record
[ ]

Ooooaog

Yes Top 10 Destination IP Addresses Record

Note: If a user (other than ADMIN) creates an alert, ADMIN cannot access that alert.

The following table lists the various columns in the Alert Permissions panel:

Roles The role of the user logged into the NetWitness user interface.

Read & Write The user can access, view, edit, import, export, and delete the alert on the
Alerts page. The user can also change the permission on the alert.

Read Only The user can only access and view the alert on the Alerts page.
No Access The user cannot access or view the alert for which this permission is set.
i The user can automatically apply permissions to the rules in the alerts.

Apply Read-only
permission to Rules in the
Alerts

The following is an overview of the entire process of alerting:
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|
|
| |
Configure Reporting Engine =o'N Configure an Alert P
| |
\ |

|
|
Schedule an Alert > View an Alert
/ |
Investigate an Alert

Manage Alerts and
Alert Templates

Setup Access Control for
Alerts

Modify or Delete an Alert

Import and Export an Alert

To configure and generate an alert on Reporting Engine, perform the following:
1. Configure Reporting Engine

Configure an Alert

Schedule an Alert

View an Alert

Investigate an Alert

A

Manage an Alert and Alert Template

Configure Reporting Engine

Ensure that:

o You have Decoders that are connected to the Concentrator added to the Reporting Engine for the
selected data source, before creating an alert rule.

o You have installed and configured a Syslog server that supports TCP/TLS in your environment. For
example, WinSyslog. You can configure the Reporting Engine to send Syslog messages over TCP
with Transport Layer Security (TLS) when an alert is triggered.

To configure the Reporting Engine to send Syslog alerts over TCP with Transport Layer Security (TLS):

1. Obtain the required certificates.

Append the CA certificate to the ca.pem file on the NetWitness server.

Configure the Syslog server to accept messages from client machines.

RN

Configure the delivery of alert messages in the NetWitness UI.

Task 1: Obtain the required certificates
To generate certificates for configuring Reporting Engine to send Syslog messages over TCP with TLS:
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1. Generate a Certifying Authority (CA) certificate. For more information,
see http://www.rsyslog.com/doc/tls_cert ca.html.

Note: You can ignore this step if you already have a CA running in your environment.

2. Generate a key pair for the Syslog server. For more information, see http://www.rsyslog.com/doc/tls
cert machine.html.

Note: You can ignore this step if you have already configured security for the Syslog server using the
key and certificates generated by the same CA.

Task 2: Append the CA certificate to the ca.pem file on the NetWitness Server
To append an existing CA certificate to the ca.pem file:

1. Manually append the contents of the CA certificate that you generated to the
/ete/pki/CA/certs/ca.pem file.

2. Run the following command on the NetWitness server to have the certificate populate to the

Truststore:
keytool -import -file /etc/pki/CA/certs/ca.pem -keystore cacerts

Task 3: Configure the Syslog Server to accept messages from client machines

To configure the Syslog server to accept messages from client machines that have the same CA
certificates:

1. Copy the following files to your secure TCP server target location:

e ca_cert.pem
e server cert.pem

o server_key.pem
Where:

ca_cert.pem - is the CA certificate
server_cert.pem - is the server certificate
server_key.pem - is the server key
For more information, see the documentation specific to your Syslog server. If you are using
rsyslog, refer to http://www.rsyslog.com/doc/tls cert server.html.
Task 4: Configure the delivery of alert messages in NetWitness

Configure Reporting Engine to send Syslog messages over TCP with Transport Layer Security (TLS)
when an alert is triggered by enabling SECURE_TCP in the Qutput Actions tab for the Reporting
Engine service in the Reporting Engine Services Config View. For more information, see the
"Reporting Engine Output Actions" topic in the Host and Services Configuration Guide.
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Configure an Alert

You can configure an alert by setting up alert notifications and adding a notification method to a rule.

Note: Only Administrators can set up these notifications.

To configure an alert:

1.

Go to Monitor> Reports.
The Manage tab is displayed.
Click Alerts.

The Alert view is displayed.

. In the Alert toolbar, click +.

The Create/Modify Alert panel is displayed.
Click Enable to enable the alert.

5. In the Rule Basis field:

a. Click Browse.
The Lookup Rule Basis dialog box is displayed.
b. Navigate the Rule tree and select a rule.
c. Click OK.
The Rule name is displayed in the Rule Basis field.

6. From the Data Sources drop-down list, select a data source.
Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse Connector data sources. For more
information, see ""Configure Data Source Permissions' topic in the Host and Services
Configuration Guide.
7. Select the Push to decoders checkbox for the Reporting Engine to send the rule to the Decoder.
8. (Optional) Enter an alert description in the Description field.
9. From the Severity drop-down list, select the severity level.
10. In the Notification field:
a. Select the appropriate notification.
The selected notification tab is displayed in the Create/Modify Alert dialog box.
b. (Optional) Deselect the notification to disable the notification tab.
c. Define an action in one of the Notification tabs:
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i. Inthe Record tab field:
a. From the Execute drop-down list, select the frequency for recording an alert.

b. Enter the RECORD message. You can create a new message or select a template in the
Body Template field and modify the template here.

c. (Optional) If templates have been defined, select a template for the RECORD message
that you can use as is or modify.

1. In the SMTP tab field:

a. From the Execute drop-down list, select a value to identify the number of times to send an
email message for the alert.

b. Enter an email address or comma-separated list of email addresses to send this alert.
c. Enter the subject of the email message.

d. Enter the body of the message. You can create a new message or select a template in the
Body Template field and modify the template here.
iii. In the SNMP tab field:

a. From the Execute drop-down list, select a value to identify the number of times that you
want to send an SNMP message for the alert.

b. Enter the SNMP message. You can create a new message or select a template in the
Body Template field and modify the template here.

iv. In the Syslog tab field:

Note: You can configure Multiple Syslog servers on the Syslog Configuration panel. For
more information, see '""Reporting Engine Output Actions' topic in the Host and Services
Configuration Guide.

a. Click F.
The New Syslog Configuration dialog box is displayed.
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MNew Syslog Configuration

Syslog Configs  |Choose ... il
Execute Once v
Facility Local7 (23] o
Severity Warning v
Body https://${sa.host}/investigation/

${device.id}/navigate/event/DETAILS/
${meta.sessionid}

Body Template |Choose .. b

Cancel Save

b. From the Syslog Configs drop-down list, select a value for the syslog configuration.

c. From the Execute drop-down list, select a value to identify the number of times to send a
Syslog message for the alert.

d. From the Facility drop-down list, select the facility.
e. From the Severity drop-down list, select the severity level.

f. Enter the Syslog message. You can create a new message or select a template in the
Body Template field and modify the template here.

Note: If you want to add a metakey, specify the same in the format: ${meta.metakey}.
For example, ${meta.ip.dst}.

g. Click Save.
The Syslog configuration gets added to the alert.

11. Click Create.

NetWitness creates an alert with a confirmation message that the alert is saved successfully.
NetWitness generates the alert and executes the output actions every minute.

Schedule an Alert

Y ou must schedule an alert to search for events on a regular schedule.

To schedule an alert:

1. Go to Monitor> Reports to view the Manage tab.
2. Click Alerts to open the Alert view.

3. Select an alert to schedule.
4

. On the Alert toolbar, click Enable.
The selected alert is scheduled.
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View an Alert

You can view an alert or a list of all alerts.

You can view the alerts triggered and investigate any alert in the Investigation module and customize
these views to show alerts for a specific period of time, and set the maximum number of alerts displayed
in a single page.

To view an alert:
1. Go to Monitor> Reports to view the Manage tab.
2. Click Alerts to open the Alert view.

3. On the Alert toolbar, click View Alerts.
The View Alerts view is displayed.

Investigate an Alert

You can investigate every alert that is triggered on the Alert View. For more detailed investigation on a
particular alert, you can view the alert on the Investigation module.

To investigate an alert:
1. Inthe Alert section toolbar, click View Alerts to navigate to the View Alerts view.
2. Do one of the following:
F]
o Click the T button against the alert you want to investigate.

The Investigation module displays the details of the first session that registered the match for the
given alert for immediate analysis.

o Click on the alert name of the alert you want to investigate.
The Investigation module displays all matches for that particular alert for the hour surrounding the
registered alert.

Manage an Alert and Alert Template
You can manage alerts, scheduled alerts, and alert templates using the following procedures.

Manage an Alert

Depending on the access permissions set for the user role, you can modify or delete, import and export,
enable or disable alerts, view or refresh an alert list.

Access Control for an Alert When a Single Alert is Selected

To set access permissions for an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.
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2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert panel, select an alert.

4. Click % ~ > Permissions.

The Alert Permissions dialog box is displayed.
5. Based on the user role, select the appropriate options.

6. (Optional) Select the checkbox if you want to automatically provide read access permission to
dependent rules.

Note: When the check box is selected, all dependent rules with the No access permission will be
given the READ access permission.

7. Click Save.
A confirmation message that the permission is successfully set for the selected alert is displayed.
Access Control for an Alert When Multiple Alerts are Selected
To change permissions of multiple alerts:
1. Inthe Alerts panel, select all the alerts whose permissions must be set.

2. Click > Permissions.
The Alert Permissions dialog box is displayed.

3. Select the permission to set for the respective user role.

4. Click Save.
A confirmation message that the permission is successfully set for all the selected alerts is displayed.

Edit an Alert

For example, if you want to be notified about the alert over an email on a different Email ID, you will
have to modify the alert notification section with the new Email ID details to be reverted over an email
when an alert is generated. Additionally, you can also modify the alert description and alert notification
in the Create or Modify Alert panel.

To edit an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
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3. Inthe Alert panel, select an alert and click lﬁ
The Create or Modify Alert tab is displayed.

Manage View [ALRT] Firewall Denied Con... ®
Create/Modify Alert
Enable o4
RuleBasis:  Firewall Denied Connections Browse
Data Sources: | Broker ~| [ Pushto decoders
Description
Severity: [esaSeverityHigh] v
Notification: [ Record O smTP [ SNMP 0 Syslog
Record SMTP SNMP Syslog
Execute Once v
Body
Bady Template ~

4. Inthe Rule Basis field, navigate the rule tree and select another rule.
The Rule name is displayed in the Rule Basis field.

5. (Optional) Select a data source from the Data Sources drop-down list.

Note: If the data source is not listed, then ensure you have Read permissions set for the data
source. This is applicable for NWDB and Warehouse data source. For more information, see
"Configure Data Source Permissions" topic in the Host and Services Configuration Guide.

6. (Optional) Modify the alert description in the Description field.
7. Modify the appropriate Notification tabs — RECORD, SMTP, SNMP, and Syslog.

8. Click Save.
A confirmation message that the alert is modified successfully is displayed.

Delete an Alert

To delete an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert panel, select the alert and click ~ .
A warning dialog asks for confirmation that you want to remove the selected alerts.

Warning

Are you sure you want to remove selected alert(s)?
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4.

Click Yes to delete the alert.
A confirmation message that the alert is deleted successfully is displayed and the selected alert is
deleted from the Alert panel.

Import an Alert

To import an alert from other instances of NetWitness in the Alerts panel:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click ¥ ~ > Import.
The Import Alert dialog box is displayed.

4. Click Browse to select the binary file.

NetWitness provides a file system view of the files. You can import multiple alerts at a time. To
select multiple alerts, select the checkbox of the alert to be imported.

5. Locate the binary file, and click Open.

The file is added to the Import Alert list.

6. (Optional) To overwrite any existing alert in the library with an identically named alert in the binary
file when importing, select the Alert checkbox. If you do not select the Overwrite option, and an
identical alert is encountered in the binary file, the binary file is imported and no error message is
displayed.

7. Click Import to import the binary file.

Export an Alert

To export an alert to an external file that can be later imported to NetWitness:

1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Alerts.
The Alert view is displayed.
3. Inthe Alert panel, select an alert and click # ~ and do one of the following:
o Export - This selection exports an alert in a .zip file.
o Export as Text - This selection exports all the content from the Reporting Engine in a .zip file
which contains the data in text format.
You can export multiple alerts at a time. To select multiple alerts, check the checkbox of the alert
to be exported.
4. Click #& ~ > Export.
The exported binary file is saved to the local drive.
Enable an Alert

To enable an alert:

163

Working with Alerts



Reporting User Guide

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert panel, select the alert that displays © in the Enabled column.

& Enable
4. Click

A confirmation message shows that the change to the alert(s) state was successful.

Disable an Alert

To disable an alert:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert panel, select the alert that displays in the Enabled column.

4 click ' Disable
A confirmation message shows that the alert(s) status is changed successfully.

View an Alert List
To view an alert list:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click View Alerts.
The View Alerts view tab is displayed.

4. Select the last number of days from the drop-down list.

5. Enter a value for the Max no of alerts.
The alerts list is displayed based on the chosen filter value.

Refresh an Alert List
To refresh the list of alerts:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

=y
3. From the Alert toolbar, click ™ to refresh the alerts list.
The Alert panel is refreshed.
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Manage a Scheduled Alert

You can enable or disable a scheduled alert, and view all scheduled alerts.

Enable a Scheduled Alert
To enable a scheduled alert:

L.

Go to Monitor> Reports.
The Manage tab is displayed.

Click Alerts.
The Alert view is displayed.

Click E View Schedule'
The View Alerts Schedule view tab is displayed.
In the Alerts Schedule List panel, select the scheduled alert (s) to be enabled.

Click #.
A confirmation message indicates that the alert(s) status is changed successfully and the alert is now
available in the Alert panel.

Disable a Scheduled Alert
To disable a scheduled alert:

I.

Go to Monitor> Reports.
The Manage tab is displayed.

Click Alerts.
The Alert view is displayed.

Click [ View Schedule
The View Alerts Schedule view tab is displayed.
In the Alerts Schedule List panel, select the scheduled alert (s) to be disabled.

Click ©.
A confirmation message indicates that the alert(s) status is changed successfully and the alert is now
available in the Alert panel.

View all Alerts Scheduled

To view all the alerts scheduled:

1. Go to Monitor> Reports.
The Manage tab is displayed.
2. Click Alerts.
The Alert view is displayed.
3. Inthe Alert toolbar, click View Schedule.
The View Alerts Schedule view is displayed with a list of all the scheduled alerts.
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Manage an Alert Template

Y ou can modify or delete an alert template, and view all alert templates.

Editan Alert Template

To edit an alert template:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.
3. Click M Template
The Alert Template view is displayed.

—

4. Inthe Alert Template panel, select a template and click Ill"
The Create/Modify Template dialog box is displayed.

5. Click Save.
A confirmation message that the template is modified successfully is displayed.

Delete an Alert Template
To delete an alert template:

1. Go to Monitor> Reports.
The Manage tab is displayed.

2. Click Alerts.
The Alert view is displayed.

3. Click B Template_
The Template view tab is displayed.

4. Inthe Alert Template panel, select a template and click = .
A confirmation dialog is displayed.

Are you sure you want to delete selected template(s)?

5. Click Yes to delete the template.
A confirmation message that the template is deleted successfully is displayed.

View all Alert Templates
To view all alert template messages:

1. Go to Monitor> Reports.
The Manage tab is displayed.
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2. Click Alerts.
The Alert view is displayed.

3. Inthe Alert toolbar, click Template.
The Template view tab is displayed with a list of templates.

List of Available Variables

Below are the list of variables available on the Reporting Engine notification for Reporting Engine alerts.

Name: ${name}

Severity: ${severity}

alert count: ${count}

Start session id = ${sidl}
end session id = ${sid2}

data source id = ${device.id}
netwitness host = ${nw.host}

See below example for how to use metadata information on the notification template.

To use ip.src and ip.dst meta, use the format ${meta.<meta-name>}.

ip.src meta
ip.dst meta

S{meta.ip.src}
S$S{meta.ip.dst}
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This section provides information about the Reporting user interface. You can look at your place in the
workflow for creating and generating a report with theNetWitness Platform, get a quick look at the
important features, and follow links to the detailed concepts and procedures.
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Build Chart View

In the Build Chart view, you can define and test a chart. You build a chart by assigning a name and then
selecting a rule to include.

Note: Only the NetWitness Platform DB rules can be used in charts.

| Schedule a Chart —
|
—p —
| Test a Chart Investigate a Chart

Workflow

You are here

Configure Reporting Engine Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart* Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.

Quick View
The following figure is an example of the Build Chart view.
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Build Chart

Enable ™

Mame

Rule Basis Select Rule Browse
Data Source Broker ~

Interval (Minutes) |5 o

Limit 10 o

Test Chart Reset

The following table describes the features in the Build Chart view.

o o

Enable Specifies if the Reporting Engine must collect the data and generate chart results. If the
Enable checkbox is not selected, the results are not rendered.
Chart Identifies the name of the chart.
Name
Rule Displays the Add Rules dialog box from which you select a rule that is the basis of a chart.
Basis The rule that you select must be a rule which is not sorted by none.
Data If the default data source is configured in the Reporting Engine, the data source is
Source displayed on the Build Chart page. If a chart is configured to run on any other data source,
that data source is displayed on the Build Chart page instead of the default data source.
The Reporting module works with the following data sources:
o Broker
o Concentrator
o Decoder
o Log Decoder
o Log Collector
Interval  The chart data refresh interval in minutes.
(Minutes)
Limit The number of records for which a chart is generated.
Save Saves a chart to the database.
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oo

Test Plots a test chart based on the chart definition.
Chart
Reset Resets the chart details.
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Build List View

In the Build List view, you can enter or import values to create a list and save or reset the values. You
can use lists when you are writing reporting rules to simplify the process of specifying values in the rule.

Workflow

This workflow shows the procedure to define lists or list groups. You can set access control at the list or
list group level so that only users with specific roles can access the lists.

Y ou must ensure that Reporting Engine is configured on the NetWitness Platform.

You are here

Configure Reporting

Create and Schedule a

> View a Report

Investigate a Report
Manage Lists, Rules or

Engine

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.
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Related Topics
o List View

o Lists Permissions Dialog

Quick View

The following figure shows the Build List View.

Reporting References

173



Reporting User Guide

Manage View [LIST] Content Delivery Ne...

Build List

Mame Content Delivery Networks
Description List of CDNs
List Values Insert Values

Value

www.google.com
ftp.microsoft.com
ftp.symantec.com
unisys.skillport.com

Enter value...

[ ] Quotes will be inserted for all the values

To access this view

1.

2.

Go to Monitor > Reports.
The Manage tab is displayed.
Click Lists.
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The Lists view is displayed.

3. In the Lists toolbar, click T
The Build List tab is displayed.

The following table describes the features in the Build List view.

o Jowomn

Name Identifies and labels the list.
Description Provides a short description for the list.

List Values Provides the grid of values associated with selected list from the List Library panel. You
can import these values from a file or list. You can also enter values manually.

Quotes will Automatically includes quotes for the values at runtime if checkbox is selected. If the
be inserted  checkbox is not selected and if a value in the list contains a comma, then that value has
for all the to be enclosed within single quotes. This syntax does not apply to list values for

values an NWDB rule.

Save Saves the rule which can be used to create a report, a chart or an alert.

Reset Deletes all the information from the fields.
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Build Report View
In the Build Report view, you can create a report, add text and rules, and schedule a report.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

|
Creat d Schedul |
reate and Schedule a .
View a Report
Report J" P

|

|

Configure Reporting . |
Configure a Rule >

I

Engine

Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Report

o Report View
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o Scheduled Reports View

« Reports Permissions Dialog

Quick View
The following figure shows the Build Report View.

R SA Respond Inve ate Monitor Configure Admin
OVERVIEW REPORTS
Manage View [REPT] New Report @
: NETWITNESS Text m
Enter Report Name... R SA PLATFORM -
Header |
ou mu atexta rules to the rep
Head
Head
Header 4
Table of C

To access this view
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Reports view is displayed.

3. Inthe Reports toolbar, click + .
The Build Report tab is displayed.

The Build Report view consists of the following panels:

Report Panel
Text Panel
Rules Panel

Report Panel

The Report panel allows you to create a report by assigning a name to the report. The content in a report
depends on the items selected from the Text and Rules panels.
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Aggregate Functions R SA ?fmggfass'

|WJ Count Aggregate Function Tabular v|| Options ®

|WJ Sum Aggregate Function Tabular v|| Options ®

When you add rules to a report, you can change the output format of these rules either to tabular, area,
line or pie by clicking the ¥ button.

The following table lists the features of the Report Panel and the description.

o o

Name This field allows you enter the name of the report.

Options  This field allows you to select the output format of the report such as Tabular, Area, Bar,
Bubble, Column, Line, Pie, Step Line, Step Area, Spline Area and Spline.

Schedule Clicking this option generates the report.

Save Clicking this option saves the report.

Text Panel

The Text panel consists of a list of text elements that add to the look and feel of the report. You can use

these text elements to format the report.

o To add more structure to reports, you can use these headers defined in the Text panel to indent up to
four levels. This allows you to identify specific sections in a report that can be included in the Table
of Contents for easy navigation in the report result.

o To add headers to the Report panel, drag and drop H1, H2, H3, or H4 onto the Report pane based on
the desired level of indentation.

178 Reporting References



Reporting User Guide

Text Rules
Header 1 H1
Header 2 H?
Header 3 H3
Header 4 H4

Table of Cantents

Body Text

Caomment

The following table lists the text elements used to format a report:

Header 1 The Header 1 element adds a first-level heading to
H1 the report definition.

Header 2 The Header 2 element adds a second-level heading
H? to the report definition.

Header 3 The Header 3 element adds a third-level heading to
H3 the report definition.
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Header 4 The Header 4 element adds a fourth-level heading
H4 to the report definition.
Table of Contents The Table of Contents adds table of contents to the
= report definition.
Body Text The Body Text element adds body text to the report
= definition.
Comment The Comment element adds comments to the report

definition.

Note: The Comment element is not displayed
when you view all the reports.

Rules Panel

The Rules panel consists of a list of rules that are defined in the Rules. From the rules list, you can drag
and drop rules onto the Report panel to associate those rules with the report.

You can search for a specific rule using search text box provided in the Rules panel.
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Text Rules

Filter

B []10.4 System Test Upgrade Set
|=m All Risk Suspicious By Session Size
|Em All Risk Warning By Destination [P
|=@ All Risk Warning By Session Size
|Em All Risk Warning By Seurce [P

b [ JDarshan-Regression

» [JHunting

b [Jldentity

b [(Jldentity Management

b [JSIT10.3.2

»[JSIT104.02

b [ Security Analytics

b [ Situational &wareness

b [ ]Threat

b [ User Activity

Q
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Build Rule View

The Build Rule view explains the actions and associated procedures that you can perform under Rules.

Workflow

This workflow shows the procedure to create or deploy a rule.

Configure Reporting

Engine

You are here

Create and Schedule a .
Report > View a Report

Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Configure Reporting Engine

Create a List or List
Group/Create or Deploy a
Rule/Test a Rule*

Create and Schedule a Report

View a report or list of all
reports

Investigate a Report

Manage/Access Control for
lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics

o Rule Permissions Dialog

o Rule View

For more information, see "Step 3: Configure
Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Configure a Rule

Create and Schedule a Report

View a Report

Investigate a Report

Manage Lists, Rules or Reports
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Quick View

nvestigate Monitor Configure Admin

Build Rule

Rule Type

Group By

IS H o ¥ [
coummneme | somey
Limie
Save Reset Test Rule
R'S/\ NETWITNESS® PLATFORM 11.4.00

To access the Build Rule view:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. In the Rules toolbar, click + > NetWitness Platform DB.
The Build Rule view tab is displayed
Features

The Build Rule view includes the following panels.

Rule panel
Meta panel
Lists panel

Rule Panel

The Rule panel allows you to create a rule for the selected database type.
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The following figure shows the Rule panel.

Build Rule

Rule Type NetWitness Platform DB

Name Source and Destination details

Summarize  Event Count v

Select ip.dst

Alias IF Addresz

Where ip.dst =1

Group By ipdst

Then Enter @ then clauze..
! »

. Column Name Sort By
Total Azcending

Reset Test Rule

The following table describes the features in the Rule panel.

Fowrs [Desrbton

Rule Type A drop-down list of supported database types for which you can create rules. The options
are: NetWitness DB and Warehouse DB.

Name The name of the rule that you are creating or editing.

Summarize A drop-down list of summarize options. The options are: None, Event Count, Packet
Count, Session Count and Custom.

Select The meta key for which you need the aggregate values; for example, ip.dest.
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O

Where A Where clause that defines the conditions that trigger the rule execution; for example,
ip.dest = 127.0.0.1.

Group By  The grouping method for the results. For example, specifying ip.dest produces a report in
which like ip.dest values are grouped.

Then A Then clause that defines the rule actions for additional processing on the output.

Order By  The sequencing method used to show results. For example, specifying Order By the value
in the Total column, Ascending, produces a report in which the results are sorted in
ascending order based on the value in the Total column.

Session A selection list for the session threshold, which specifies maximum number of sessions
Threshold  that should be processed for aggregate functions.

Limit A selection list for the maximum number of result rows to be fetched.
Use Clicking Use enables you to use the Rule to generate a Report, Alert of Chart.
Save Clicking Save saves the rule that you are editing and the Build Rule panel remains open.

Before testing a rule, you must save it if you want to keep your changes.
Reset Clicking Reset clears all the field information .

Test Rule  Clicking test rule opens the Test Rule dialog.

Test Rule Dialog
To access the Test Rule view:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. In the Rules panel, do one of the following:

e Select a rule and click |ﬁ in the Rules toolbar.

. Click ¥ 7 - Eait
The Build Rule view tab is displayed.
3. Click Test Rule.

Reporting References 185



Reporting User Guide

The Test Rule view is displayed.

Data Source

Format

Time Range
Past

X Axis

Y Axis

2 % | Hours

[[] Use relative time calculation

w

The following table describes the features in the Test Rule Dialog.

Fors focron

Data Source

Format

Time Range

Use relative
time
calculation

A drop-down list of data sources for the type of rule you are testing. Possible data
sources are: Concentrator, Broker, Decoder or Log Decoder.

A drop-down list of the formats for displaying results for the rule. Possible formats are:
Tabular, Area, Bar, Bubble, Column, Line, Pie, Step Line, Step Area, Spline Area, and
Spline.

A drop-down list of time range specification methods.

o Selecting Past allows you to specify a number of years, months, days, weeks, or
hours. For example, Hours, Days, Weeks, Months, or Years.

o Selecting Range allows you to specify a date range and time period. For example,
start date to end date.

In the user interface, the date or time displayed depends on the time zone profile
selected by the user.

Selecting this option calculates the time range relative to the current time.
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o o

X Axis X-Axis and Y-Axis specify the metadata to be plotted in charts.
In the X-Axis drop-down list, the meta types for the Group by setting in the rule are
listed. You can select multiple meta types when the rule has a single Group by setting.
For Custom Rules with multiple Group by values, you can select only the first meta
type for the X-Axis.

Y Axis In the Y-Axis drop-down list, the aggregate functions used in the rule are listed. Sum,
Count, Countdistinct and Average are the supported aggregate functions for rules.
You can select one or more aggregate functions.

Run Test Clicking Run Test executes a test of the rule last saved in the Rule Builder dialog.
When the test is complete, the rule data (if any) for the selected time range is
displayed.

Meta Panel

The Meta panel provides a list of available meta types that you can use to build the rule. You can use the
meta types in the Select, Where, and Then clauses. The Reporting Engine maintains an active list of the
available meta names by continuously synchronizing with the data source to which it is connected.

The following figure displays the Meta panel.
Meta

NWAPPLIANCET1877-WorkBench : newct »

Filter *

05 -

S00ess. point |:|
action

ad.computer.dst

ad.compUter.src

ad.domain.dst

ad.domain.src

sd.uzernamedst

SO.USErname.src -

4 | | »

The following table describes the features in the Meta panel.

Choose Based on the rule type that you have selected, the available data sources are displayed
in the drop-down list of the Meta panel. Select the required data source. The available
meta types for the data source are displayed. Select a meta.

Filter Filter the meta for a specific meta value.

Lists Panel

A List is a placeholder for a set of values that you can use in a meta or a variable. For example, you can
define a list with all the whitelisted event source IP addresses. Once the List is defined then you can use
the List name in the rule. This provides the flexibility of adding, modifying, and deleting the list values.
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The Lists panel is a collection of Lists. The Reporting Engine maintains an active list of the available list
names by continuously synchronizing with the collection to which it is connected.

The following figure displays the Lists panel.

Lists

Filter b
+= Inzert ~ o one
0[] Compliance -
@[] Fitering Candidate
i= Local Country
0[] Logs

0 ] Metwork Activity

0[] Per Uszer Report
0[] Test-41_Fina

0[] Test-List§_Fina

K

The following table describes the features in the Lists panel.

% - Import or Export a list.

| Import
‘ Export
E Refresh the Lists.
¥ nsert If you select the NetWitness DB rule type, the options Where and Then are displayed.
| e | Insert the list in the Where or Then clause in the rule.
] Then ‘
¥ Inzert - If you select the Warehouse DB rule type, the option Where is displayed. Insert the list
| where | in the Where clause in the rule.
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Chart Permissions Dialog

In the Chart Permissions dialog, you can manage access permissions for user roles at the chart and chart
group level. Only a user with the 'Read & Write' permission can configure the chart in the Reporting

module.
Schedule a Chart —p
-
Test a Chart Investigate a Chart

Workflow

-
Configure Reporting Engine JIN Configure a Chart
-

| You are here l |
]

| Manage Chart Groups [
' and Charts |
| |

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart*

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View

The Chart permissions dialog allows you to set chart permissions depending on the user role.

The following figure is an example with the important features labeled.

Charts Permissions

Behaviors of Compromise

Roles ~ Read & Write Read Only Mo Access
Administrators L
Analysts -

Data_Privacy_Officers -
Malware_Analysts -
Operators -
Respond_Administr... -
S50C_Managers -
UEBA_Analysts -

[ Apply Read-only permission to Rules in the Charts

Cancel

Click Monitor> Reports to view the Manage tab.

Click Charts to open the Chart view.

In the Charts panel, select a report and click % * > Permissions. The Chart Permissions dialog
box is displayed.

Based on the user role, select the appropriate options.

(Optional) Select the checkbox if you want to automatically provide read access permission to

dependent rules.

I Click Save.

The following table lists the columns in the Charts Permission dialog.

Roles Displays all the user roles in the NetWitness user interface.

Read & Write Allows you to apply 'Read&Write' access to the chart.
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Read Only
No Access

] Apply these

permissions to sub-
groups and Charts in
this group

] Apply Read-only

permission to Rules in
the Charts

Cancel

Save

Allows you to apply only 'Read' access to the chart.
By selecting this permission, you cannot access or view the chart.

Allows you to apply permissions to the chart group, subgroups in the group
and charts in the group.

Note: This checkbox is populated only when you set access permissions for
a Chart Group.

Allows you to automatically apply permissions to the rules in the charts.

Cancels all the changes made to the permissions.

Saves the selection and provides access to the role based on the selection.
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Chart View

In the Chart View, you can see the available charts and groups in a grid format and also schedule them
by enabling the charts.

Workflow

You are here

| \
| |
Schedule a Chart T.
-
| \
| [
— —4
Test a Chart Investigate a Chart

Configure Reporting Engine A Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart* Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View

The following figure is an example with the important features labeled.

RSA Respond n Monitor Configure Admin z admin
OVERVIEW REPORTS
Manage View
Rules Reports 1 Lists Warehouse Analytics Search Report Details -3
a
Groups Charts ¥
+ - T ® ‘+ | | = % © | @viewAllCharts ¥ Auto Refresh ‘
Groups ~ Enabled Name ~ Group State Duration(H:M:S) Avg(H:M:S) Max{H:M:S) View Chart Actions
AX [ 2 ] Cleartext Authentications by Sery User Acti..  Inactive &
@ Cleartex ords by Service User Acti...  Inactive &
e Email Senders Inacti &
° Firewall Denied Connections Situation...  Inactive £
Firewall Destination IP Addresses Situation...  Inactive &
Firewall Events Situation...  Inactive &
Firewall Systems Situation...  Inactive F
Firewall Users Situation...  Inactive 3
IDS Signatures Siuation...  Inactive -]
Log Destination Ports Situation...  Inactive &
Log Event Categories Situation...  Inactive £ -
| Page 1 of1 | | C PageSize 30 ~ Displaying 1 - 28 of 28

R'S /A NETWITNESS' PLATFORM 11.400

The Chart view includes the following panels:

Charts Groups panel
Charts toolbar

Charts panel

Charts Groups Panel

The Charts Groups panel allows you to organize charts in a group. You can create a group, add charts to
the group and move charts among groups. The following figure shows the Charts Groups panel.

Groups
+ (SN - 2=
Groups ~

All
Cis 1 Aon -
D_'l tuational AWareness

[ Threat

[ User Activity

The Charts Groups Panel includes the following options:
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o o

+ Adds a new chart to the Reporting module.
— Deletes one or more selected charts.
z Edits a chart.
o Refreshes the view.
& Provides the following options: Import, Export and Permissions.
Charts Toolbar

The Charts toolbar allows you to add, modify, delete, duplicate, activate, deactivate, import and
export a chart. You can also set access permissions for charts in a group.

+ | | # © | @viewallCharts ™ Auto Refresh

The Chart toolbar includes the following options:

P Jpmerpien

+ Adds a new chart to the Reporting module.
- Deletes one or more selected charts.

z Edit charts.

® Enables the selected charts.

o Disables the selected charts.

= Creates a duplicate copy of the selected chart.

L JC Provides the following options: Import, Export, Export as Text and Permissions.

View All Charts Displays all the executed charts.

Auto Refresh Automatically refreshes the charts list.

Charts Panel

The Charts Panel presents all the charts in a tabular or grid format.
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[ Enabled | Name ~ Group State Duration(H:M:S) Avg(H:M:S) Max(H:M:S) View Chart Actions

O Cleartexs Authensications by Servi... User Acti.. Inactive e =

o o Cleartext Passwords by Service User Acti..  Inactive B

o o Email Senders User Acti.. Inactive £ 30

o o Firewall Denied Connections Situation... Inactive [ 30

o o Firewall Destination IP Addresses Situation...  Inactive & -

o o Firewall Events Situation...  Inactive B

[me] Firewall Systems Situation... Inactive f. 30

o o Firewall Users Situation... Inactive [ 30

o o 1DS Signatures Situation... Inactive o JO

o o Log Destinaticn Perts Situation...  Inactive B

o o Log Event Categories Situation... Inactive [ 30 .
| Page 1 of1 | | C' PageSize |30 ~ Displaying 1 - 28 of 28

The following table lists the columns in the Chart panel and their description.

Description
Enabled ® - The chart is enabled.
© - The chart is disabled.
Name The name of the chart.
Group The Chart Group to which the chart belongs.
State The state of the chart:
o Queued

o Completed
o Failed

Duration The time taken to execute the latest chart.
(H:M:S)

Avg(H:M:S) The average time taken to run the chart.
Max(H:M:S) The maximum time taken to run the chart.
View Chart A hyperlink that redirects to the View a Chart panel.

o 3G The actions menu has the following options: Enable, Disable, View, Delete, Edit,
and Export.
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Execution History Panel

The Execution History panel allows you to fetch and display history details.
Workflow

This workflow shows the procedure to view report or report groups.

You are here

| :

|
Configure Reporting Create and Schedule a ‘ |

View a Report
Engine Report Jl-’ - |
|
| \ .
Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report
Analyst reports*

Administrator / Investigate a Report Investigate a Report
Analyst

Administrator / Manage/Access control for lists, Manage Lists, Rules or Reports
Analyst rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Report

o Generate List Panel
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o Scheduled Reports View

Quick View

The following figure is an example of the Execution History view.

Dynamic Report With List for Alias Host: Execution History
[

Execution Date ~ Execution Duratlon (5ec) State View Report

Get history by:
Past # Executions w | ||| 2014-08-31 D&:58 2703435 Completed View

2014-08-30 15:24 3158.262 Completed Wiew
10 ]

Show History

| Page |1 | oft | | C Displaying 1-2 of 2

Features
The View Execution History has the following panels:
Execution History Options panel
Execution History Output panel
To access this view:
1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, do one of the following:

e Hover the mouse over a report and click . > View Scheduled Reports.

o Click #Schedules column.
The Schedule Reports view is displayed with the status of each of the scheduled report.

4. Select a scheduled report and do one of the following:
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e Click s Execution History.

o Click ®© from the Scheduled Reports Toolbar Panel.

Execution History Options Panel

The Execution History Options panel allows you to fetch the history details based on either past n
number of scheduled reports or a specific date range.

The following table lists the operations in the Execution History Options panel:

Get history by:

From
To

Count

Show History

This is the criteria to view the execution history:

o Past # Executions: The past n number of scheduled reports.

By default this option is displayed.

« Range (specific): The start date and end date for the date
range.

Note: The From and To field is populated in the NetWitness
Platform UI only when you select 'Range (Specific)' from
the Get history by list.

The start date for the date range.
The end date for the date range.

The number of execution history of the scheduled report to be
displayed.

Shows the history details based on the selected criteria.

Execution History Output Panel

The Execution History Output panel displays the history details with the execution date, execution
duration (seconds), state of the scheduled report, and a link to view the report.

The following table lists the various columns in the Execution History Output panel:

The date on which the scheduled report was executed. By default, the execution

Execution Date

date is in descending order.

Execution Duration The time duration taken to execute the scheduled report.

(Sec)
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State The state of the scheduled report:

o Scheduled: If a report is scheduled to run on an hourly, daily, weekly, monthly,
or later time, the state of the report is displayed as scheduled, for the first run.

o Queued: If a report is still waiting to get executed, the state of the report is
displayed as queued.

o Running: If the report schedule is in progress, the state of the report is
displayed as running.

o Partial: If in a report with several rules, a single rule execution failed or an
output action failed or creation of PDF/CSV failed, the state of the report is
displayed as partial. For example, consider a report with five rules and

four rules are executed successfully and one fails, then the state is displayed
as Partial.

o Failed: If in a report with several rules, all the rule schedule executions failed,
the state of the report is displayed as failed.

o Completed: If a report schedule is successfully executed, the state of the
report is displayed as completed.

o Canceled: When cancel request is completed, the state of the report is
displayed as canceled.

o Inactive: If a report schedule is disabled, the state of the report is displayed as
Inactive.

o Not available: If the report schedule executed information is not available, the
state of the report is displayed as not available.

View Report The hyperlink to View a Report on full screen.
Close Closes the execution history view.
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Generate List Panel

The Generate List dialog allows you to generate and customize a list.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |
! |

Configure a Rule -"l'b- Create and Schedule a . View a Report
I

Engine

Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.
Related Topics

o List View

 Build List View
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o Lists Permissions Dialog

Quick View

The following figure is an example of the Generate List dialog.

Generate List

List Name: $[/Per User Report/List of Service!| | Browse
Rule Access o G v
Calumn filename v

[ Qverwrite Existing List ?

Cancel Save

To access this view:
1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report and click ¥ " > Schedule Report.

The Schedule a Report view tab is displayed.

4. Inthe Output Actions section, in Dynamic List panel, click +
The Generate List dialog is displayed.

Features
The following table lists the features in the Generate List dialog.

Fad Joeerpen

List Name The name of the list chosen from the List Selection panel.

Browse Click this button to select a list from the List Selection Window dialog.

Rule Select a rule to be used to create the list.

Column Select a value for the column.

Overwrite Existing Overwrites the existing list.

List?

Save Adds the desired list to the Generate List panel of the Schedule Report
view.

The List Selection Window dialog consists of lists that are defined in the Lists panel. Here, you can
select a list to associate it with the report. The following figure shows the dialog.
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List Selection Window

2 Refresh

List Name =~

==
==|:|C0r'1plian:e
@ [ Filtering Candidate

= Local_Country

20 Logs
& [ Network Activity
@[ Per User Report
-+ All_FInal

= Lists_Final

3

Clase Select
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Import Chart Dialog

In the Import Chart dialog, you can import charts containing subgroups and charts from other instances of
NetWitness into the Chart Groups panel. Charts must be in a valid binary file that was exported from

another NetWitness instance.
Schedule a Chart —p
-
Test a Chart Investigate a Chart

Workflow

-
Configure Reporting Engine JIN Configure a Chart
-

| You are here l |
]

| Manage Chart Groups [
' and Charts |
| |

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart*

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View

This dialog displays differently when you use it to import groups containing subgroups and charts from
other instances of NetWitness into the Chart Groups panel.

The following figure is an example of the Import Chart dialog.

mport Chart

4+ Browse.. = Delete

File Name Overwrite 7

Click Monitor> Reports to view the Manage tab.

Click Charts to open the Chart view.
In the Charts Groups panel, select a folder to import the file.

In the Charts Groups panel or Charts toolbar, click ﬁ v > Import to import the file.

The following table describes the features in the Import Chart dialog.

Fetrs [Descrpton

Browse Displays a view of the local file system so that you can select the chart to be imported.

Delete Deletes an imported report from the list of imported charts.

File Name Displays a list of chart files that will be imported to your Charts module when you click
Import.

Overwrite? Allows you to select the option to overwrite an existing version of the chart you are
importing. If you do not select the Overwrite option, a duplicate file is imported and no
error message is displayed.

Close Closes the dialog. If you have charts to select for import, but have not clicked Import.
The charts are not imported, and are not saved in this dialog.

Import Imports the selected charts to your Charts module.
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Import Report Dialog

In Import Report dialog, you can import groups containing subgroups and reports from other instances of
NetWitness Platform into Report Groups panel. Reports must be in a valid binary file that was exported
from another NetWitness Platform instance.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~ /

You are here |

: I Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.
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Related Topics
o Configure and Generate a Report

o Report View
o Build Report View

o Reports Permissions Dialog

Quick View

=+ Browse.. = Delets

Flle Name

Overwrite ?

o

To access the Import Report dialog:

1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.

3. Inthe Reports Groups panel, select a folder to import the file.

4. Do one of the following:

o In the Reports Groups panel, click * * > Import to import a group.

« In the Reports toolbar, click % * > Import to import a report.

The following table lists the features of the Import Report dialog.

Fetrs [Descrpton

Browse This option displays a view of the local file system so that you can select the report to be
imported.

Delete This option deletes an imported report from the list of imported reports.

File Name Displays a list of report files that will be imported to your Reports module when you
click Import.

Overwrite? Allows you to select the option to overwrite an existing version of the report you are
importing. If you do not select the Overwrite option, a duplicate file is imported and no
error message is displayed.

Close This option closes the dialog. If you select a report and not clicked Import. The reports
are not imported, and are not saved in this dialog.

Import This option imports the selected reports to your Reports module.
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Investigate a Chart View

In the Investigate a Chart view, you can view and investigate chart details. There are options for filtering
and sorting the information in the chart, as well as options for the type of chart, the number of items to
chart, and charting values or totals. When viewing a chart, you can open the charted sessions in the

Investigation module and save the chart as a PDF.
Schedule a Chart —
-
| You are here |
- |
\ Investigate a Chart |
‘ |
| [

Workflow

Configure Reporting Engine Configure a Chart

—>
l Test a Chart
Manage Chart Groups
and Charts

What do you want to do?

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engin" in the Reporting Engine Configuration
Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart™ Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View
The following figure is an example with the important features labeled.
Manage View [CHRT] Cleartext Password... @
—47
D Investigate = Full Screen
‘ Investigate 1= Full 5 H z! 2 Friday
Behaviors of Compromise Sepuamber 25,2017
Display M XAxis MY Axis  Legends . s e 20T .
S M T w T F S
1 2
. 3 4 5 6 7 8 9
g N 10 n 12 13 14 15 16
é 17 8 19 20 21 22 23
g 24 25 26 27 28 E
032 03:30 034 035 04 04:10 0420 043 044 0450 05:00 05 Charts
- EMPTY ~ -~ !
Behaviors of Compromise
|
Chart Options
Time Range Series Items To Plot Chart Type
Last3Hours v @ Cha e |5 ° Line ~
The View a Chart panel includes the following panels:
Chart toolbar
Chart Output panel
Chart Calendar panel
Chart Options panel
Chart Executed list
Chart Toolbar

The Chart toolbar has options that allow you to investigate, and view the chart on another screen.

{i:‘ Investigate & Full Screen

The following table lists the options in the Chart toolbar.

Investigate  Investigates the chart details.

' Full Screen  Displays the chart on a full screen. :
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Lists Permissions Dialog

In the Lists Permissions dialog, you can manage access permissions for a user role at the list or list
group level. Only a user with Read and Write permission can configure the list in the Reporting
Module.

Workflow

This workflow shows the procedure to manage lists or list groups. You can set access control at the list
or list group level so that only users with specific roles can access the lists. You can use lists to define
rules for generating reports, charts and alerts.

You must ensure that Reporting Engine is configured on NetWitness Platform.

Configure Reporting . Create and Schedule a .
Engine Configure a Rule Report — View a Report

\

~ /

You are here |

: I Investigate a Report
Manage Lists, Rules or |

: Reports |

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.

Reporting References 209



Reporting User Guide

Related Topics
o List View

o List section in the "Role Permissions" topic in the System Security and User Management Guide.

Quick View

The following figures are examples of the Lists Permissions dialog and List Group Permission dialog:

Blacklisted IPs

Roles ~ Read & Write Read Only Mo Access
Administrators 0] (@] O
Analysts @] @] ®
Data_Privacy_Officers O O ®
Malware_Analysts O O .
Operators O @] O]
Response_Administ... O @] ®
S0C_Managers O O -
Security_Administra... O O (O]

Cancel Save

rmissions

Network Activity

Roles ~ Read & Write Read Only Mo Access
Administrators ®
Analysts @] @] G
Data_Privacy_Officers O O .
Malware_Analysts @] @] G
Operators O O ®
Response_Administ... @] @] ®©
S0C_Managers ®
Security_Administra... @] O ®
[] Apply these permissions to sub-groups and Lists in this group

Cancel Save

To access this view
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1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Lists.

The Lists view is displayed.

3. Inthe Lists view, select a report.

4. TIn the Lists toolbar, click ¥ “ > Permissions.
The Reports Permissions dialog is displayed.

The following table describes the features in the Lists Permissions dialog:

o= o

Roles

Read & Write

Read Only
No Access

Apply these permissions to
subgroups and lists in this

groups
Cancel

Save

Describes roles of the users logged into the NetWitness Platform user
interface.

Allows users to access, view, edit, delete, import, and export lists on
the Lists view. Users can also change the permission on the rule.

Allows users to only access and view the list on the lists view.
Doesn't allow users to access or view the lists.

Automatically applies permissions to the subgroups and lists in the
groups, if checkbox is selected.

Cancels all the changes made to the permissions.

Saves the selections and provides access to the roles based on the
selections.
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List View
In the List view you can see available lists and groups in a grid.

Workflow

This workflow shows the procedure to define lists or list groups. You can set access control at the list or
list group level so that only users with specific roles can access the lists. You can use lists to define
rules for generating reports, charts and alerts.

Y ou must ensure that Reporting Engine is configured on NetWitness Platform.

You are here

Configure Reporting

Create and Schedule a

> View a Report

Investigate a Report
Manage Lists, Rules or

Engine

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

212 Reporting References



Reporting User Guide

Related Topics
o Lists Permissions Dialog

o Build List View

Quick View

The following figure shows the List view.

Manage
2
Rules  Reports  Charts  Alerts m Warehouse Analytics 3 Search Report Details &
Groups Lists ‘/H
+ [+ N -] + | =
Groups ~ 1 mame ~ Group. Date Modstied Actions.
i o ] Blackisted IPs 20170503 08:39 @&
& Compliunce O | |0 complancebata 201705030833 &
Catew Geeup L] Compliance Symems 2017:05-03 08:34 £
¥ CJFikering Candidates o
1 Content Delivery Neswarks 20170503 08:28 -
5 Networte Actvity o
[ List of Alss Hosts 20170503 08:31 £
[ Listof IP Addresses 2017-0502 08:32 @&
) Listof Message 1D 2017-0503 08:33 &
| Page 1 of1 | & PagesSize 30 Displaying 1-7of 7

To access this view

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Lists.
The Lists view is displayed.

The List view includes the following panels:

Lists Groups panel
Lists toolbar
Lists panel

Lists Groups Panel

The Lists Groups panel provides a list of groups used to organize lists and has a toolbar that allows you
to create and manage the groups.

e e N

+ Allows users to add a new group to the Reporting module.
- Allows users to delete groups.
o Refreshes the view.
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o o

E e Allows users to access following options: Import, Export and Permissions.

You can perform the following actions using the Lists Groups panel.

o Refresh lists in a group.

o Move lists between different groups. You can move a list from one group to another by dragging and
dropping the list in the required group.

o Create list groups.
o Delete list groups.
o Import list groups.
o Export list groups.

o Set access control for list groups.

Lists Toolbar

e e

+ Allows user to add a new list to the Reporting module.
- Allows user to delete one or more selected lists.
z Allows user to edit lists.
T:=j Creates a duplicate copy of the selected list.
T Allows user to access the following options: Import, Export and Permissions.

Lists Panel
The Lists panel displays all the lists defined in a tabular format.

Name Displays the name of the list.

Note: For Name field, the icon to extend the column size is not displayed at the
end of the column field. You have to hover the mouse a little to the left side to
see the icon for extending the column.

Group Displays the list group to which the list belongs.

Date Modified  Displays the date and time when the list was modified.
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Reports Permissions Dialog

In the Reports Permissions dialog, the users with 'Read & Write' access permission can configure
permissions.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~ /

You are here |

: I Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.
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Related Topics
o Configure and Generate a Report

o Report View
o Build Report View

o Import Report Dialog

Quick View

Reports Permissions
Aggregate Functions
Roles ~ Read & Write Read Only M@ ACCess
Adminl o o -
Administrators =
Analyst] -
Analysts 8] 8] L]
MalwareAnalysts o (&) L3
Operator] -
Cperators o (&) L3
50C_Managers (o] (o] (1]
[] Apply Read-only permission to Rules in the Reports

Cancel Save

To display the Reports Permissions dialog:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, select a report.

4. Click ¥~ > Permissions.
The Reports Permissions dialog is displayed.

Note: When you select the check box, all dependent rules are given READ access permission,
provided the permissions for the report is higher compared to the permissions of the rules.

The following table describes the features in the Reports Permissions dialog.

o= o

Roles Displays all the roles who can get access to the permissions.
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Read&Write

Read Only

No Access

Apply Read-only permissions to
Rules in the Reports

Cancel

Save

Allows you to get Read&Write access to the Rules in the
Reports.

Allows you to get Read Only permissions to the Rules in the
Reports.

If you select this option, you will not get permission to the
Rules in the Reports.

Allows to set Read Only permissions to the Rules in the
Reports for all the roles .

This option cancels all the changes made to the permissions.

This option saves the selections and provides access to the
roles based on the selections.
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Report View
In the Report view, you can create and manage the report or report groups.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

|
- . |
Configure Reporting Create and Schedule a View a Report

|

|

i |
Configure a Rule >

|

Engine

Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Build Report View

o Import Report Dialog
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o Scheduled Reports View

« Reports Permissions Dialog

Quick View

RSA Respond Investigate Monitor Configure Admin ©) admin
OVERVIEW REPORTS
Manage 1
Rules Charts Alerts Lists Warehouse Analytics 2 3 Search Report Details =]
Groups Reports
+ Tl®- ‘ + —Z | B % | @ viewAl Reports
Groups ~ O Name ~ Group Date Modified #Schedules | Actions
2l [ Malware Activity Report Hunting 2017-08-07 08:55 1 e
[ DarshanRegression O Hunting Summary Hunting 2017-08-07 06:10 1 e
[runing O A Warning Situationa 20170 1 &5
O s ytics Administration Report Securi 2017 ] B
[ Identity Management Situational Awareness 2017+ 1 &
[0 Report-RuleTo Darshan-Regression 2017 1 &
[ Report-RuleTo Darshan-Reg 2017 1 f 38
[ ReportRuleTo Darshan-Regression 2017-08-09 06:11 1 &
¥ Report-RuleToTestSpecialChars-4 Darshan-Regression 2017-08-09 06:11 1 &
| Page 1 |of1 | | C Pogesize 30 ~ Displaying 1-9 0f 9

To access this view:

1. Go toMonitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Reports view is displayed.

Features

The Report view includes the following sections:

Reports Groups panel
Reports toolbar
Reports panel

Report Groups Panel

The Report Groups panel allows you to organize reports in a group. You can create a report group, add
reports to the group, and move reports among groups. You can view all reports by selecting All option
under the Groups column.
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Groups
+ (ORI - 2
Groups ~

All
[ Aggregation
[ JHunting

[ Security Analytics

000090

[ Situational &wareness

N

-+ This option allows you to add a new report to the Reporting module.

= This option allows you to delete one or more selected report.

E This option refreshes the view.

& The actions menu has the following options: Import, Export and
Permissions.

Reports Toolbar

The Reports toolbar allows you to add, modify, delete, duplicate, import and export reports. You can also
set access permissions for a report in a group.

-+ | # ~ | @ view all Reports View All Schedules
m

== This option allows you to add a new report to the Reporting module.

- This option allows you to delete one or more selected reports.

This option allows you to edit a chart.

@ N

This option creates a duplicate copy of the selected report.

- 25 The actions menu has the following options: Import, Export , Export as Text and
Permissions.
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o o

Buenareots his option allows you to view a list of reports along with their schedule name and time.

View A This optior: allows you to view all the scheduled reports.

Report List Panel

The Report List panel lists all the reports in a tabular format.
0| name ~ Group Date Modfied #schedules | Actlons
[ Analyst Report 20716-01-14 23:40 1 &
[] DPOReport 2016-01-14 23:41 1 0 c
[ Report-All-Meta-Types 2015-12-01 1334 1 fe
[ Report-All-Meta-vValid-Types 2015-12-01 10:00 1 &
[ Report-All-Rule-Actions 20151201 13:34 1 4 c
[ Report-Rule_1 201502-25 15:41 0 &
O test 20151201 10:02 0 -

| Page |1 |of1 | | C PageSize 30 ~ Displaying 1-7 of 7

The following table describes the columns in the Report List panel.

Name The name of the report.

Group The Report Group to which the report belongs.
Date The date and time when the report was modified.
Modified

#Schedules The count indicates the number of schedules created for a report.

Actions The actions menu has the following options: Schedule Report, View Scheduled Reports,
Delete, Edit, and Export.
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Rule Permissions Dialog

The Reporting module provides access control at the rule level. Only a user who has the right set of
permissions can perform tasks on the rule. When creating user roles, the administrator must ensure that
the roles created for specific tasks have access to all the permissions higher in the hierarchy of roles.

Workflow

This workflow shows the procedure to manage rule or rule groups.

Configure Reporting

Engine

~ /

You are here |

Manage Lists, Rules or
Reports

What do you want to do?

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Administrator /
Analyst

Configure Reporting Engine

Create a List or List
Group/Create or Deploy a
Rule/Test a Rule

Create and Schedule a Report

View a report or list of all
reports

Investigate a Report

Manage/Access Control for
lists, Rules or Reports*

*Y ou can complete these tasks here.

Related Topics

e Rule View

Create and Schedule a
Report — View a Report

\

Investigate a Report

For more information, see "Step 3: Configure
Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide

Configure a Rule

Create and Schedule a Report

View a Report

Investigate a Report

Manage Lists, Rules or Reports

222
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Quick View

This figure shows the Rules Permissions dialog for a single rule.

Rules Permissions

Roles = Read & Write
AdminT

Adminlstrators

Analyst1

Analysts

IMalware_Analysts

Operator]

Cperators

50C_Managers

This figure shows the Rules Permissions dialog when multiple rules are selected.

Rules Permissions

Roles ~ Read & Write
Administrators®

Analyst1*

Analysts

Event Stream A...

Malware_Analysts

Managers

Operators

Security®

Users*

the permissicn

Source and Destination Details

Multiple objects selected

Read only MO ACCESS

Cancel Save

Read Only Mo Access

-

“**" indicates other permissions on the object. Select the required cbject only to medify

Cancel Save

The dialog has a different appearance for rule groups versus rules. To access the dialog:

1. Go to Monitor > Reports.

The Manage tab is displayed.
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2. Inthe Rules panel, select one or more rules or a rule group.

3. Click % > Permissions in the toolbar.

The Rules Permissions dialog is displayed.

Fows Jowerpnen

Roles column Lists the NetWitness Platform user roles, both built-in and custom roles. Each
user who is logged in to NetWitness Platform has user roles assigned.

When multiple rules are selected, the asterisk beside the role name, for
example, Security*, indicates there are other permissions available on that
user role. To change the other permissions, you must select the user role and
change the access permission.

Read & Write When the checkbox in this column is selected, the corresponding user role has
column permission to view, edit, delete, import, and export rules in the Rules view. The
user can also change the permission on the rule.

Read Only column When the checkbox in this column is selected, the corresponding user role has
permission to view the rules in the rule group.

No Access column ~ When the checkbox in this column is selected, the corresponding user role
cannot view or edit the rules in the rule group.

Before applying rule permissions, this is the default permission set for all the
user roles though the checkbox is unchecked.

Apply these When checked, NetWitness Platform applies permissions to sub-groups and
permissions to sub-  rules in the group.

groups and Rules in

this group checkbox

Cancel option Clicking Cancel closes the dialog without saving any changes made.
Save option Clicking Save closes the dialog and updates the rule group permissions for user
roles.

If specified, the access permissions are applied to subgroups and child objects
of this group.

When multiple rules are selected, the access permission is applied to all the
selected rules.
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Rule View

The Rule view is the user interface for managing rules.

Workflow

This workflow shows the procedure to define rule or rule groups.
You are here

Configure Reporting

Create and Schedule a .
Report > View a Report

Investigate a Report

Engine

Manage Lists, Rules or
Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a

Rule/Test a Rule*

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Rule Permissions Dialog

o Build Rule View
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Quick View

R

S A Respond Investigate Monitor Configure Admin

VERVIEW REPORTS

Accounts Deletsd

Accounts Disabled

Accounts Modified

All Risk Suspicious By Session Size
[ Identity Managemeant

All Risk Warning By Destination IP

[se

ity Analytics

»[IsIT103.2 All Risk Warning By

» CISIT10.4.0.2 All Risk Warning By Source IP
[ Sitational Awareness Behaviors of Compromise

[ Threat

Behaviors of Compromise Detail

O o ooolobooooiolo

Cleartext Authentications by Service

| page 1 ofs | } M | C PagesSize 30

NetWimess ..

m Reports harts Alerts Lists ‘Warehouse Analytics Search Report Details &
Groups Rules
= 2
+ s -2 + - | e | Fe
Groups ~ Name ~ Type Group Date Modified Actions
Al Accounts Created NetWitness ... Identity Management 2017-08-07 10:05 |

Identity Management

.. Identity Management

.. Identity Management

. Hunting

Hunting

. User Activity

2017-08-07 10:15 & -

2017-08

2017-08-07 1045 | 8% =

2017-08-0702:53 | -

Displaying 1-30of 135

To access the Rules view:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Rules.
The Rules view is displayed.

The Rule view includes the following panels.

Rules Groups

Rules panel

Rules Toolbar

Rule Groups Panel

The Rule Groups panel allows you to organize rules into groups using the options in the toolbar. You can
create groups and sub-groups and add rules to them. You can also group and move rules between

different groups.

The following figure shows the groups in the Rule Groups panel:

226
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Groups
+ (ORI - 2=

Groups ~

3

All

b [ Ageregate Function
» [ All-Rules_Final
[ Coemmand and Contral
[ cCampliance
[ Data Exfiltraticn
[CJFiltering Candidate
[JFiltering Candidates
¥ [Jldentity Management
L&A Rules
b [ Metwork Activity
|
3

000000 Booobob

L |

The following table describes the features in the Rule Groups Panel.

o o

-+ This option allows you to add a new rule group to the Reporting module.

This option allows you to delete one or more rule groups.

ﬂ This option refreshes the rule group list.
o T The actions menu has the following options: Import, Export and Permissions.
All Displays a list of all the rule groups.

Rule Toolbar

The Rule toolbar allows you to add, delete, edit, and duplicate a rule. The following figure shows the
toolbar.

+ - | o | Fe

The following table describes the features in the Rule Toolbar

T

=+ This option allows you to add a new rule to the Reporting module.
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Description

This option allows you to delete one or more selected rules.

This option allows you to edit a rule.
This option allows you to duplicate a rule.

The actions menu has the following options: Use, Import, Export
and Permissions.

This option allows you to select the rule type.

Rule List Panel

The following figure shows the list of rules in the Rule List panel.

O Name ~ Type Group Date Modified Actions

] Accounts Crested NetWitness...  Identity Management 201708071015 | & = -
[ Accounts Deleted NetWitness... Identity Management 2017-08-07 10:13 [+ 2

[0 Accounts Disabled NetWitness... Identity Management 201708071015 |

[0 Accounts Modified NetWitness...  Identity Management 2017-08-0710:15 | =

[] Al Risk Suspicious By Session Size MetWitness... 20170807 09:44 | £ &

[ Al Risk Warning By Destination [P NetWitness... 2017-08-07 10:10 [+ 2

[ All Risk Warning By Session Size NetWitness... 2017-08-0710:10 | =

[ All Risk Warning By Source IP NetWitness... 2017-08-0710:10 | =

[0 Behaviors of Compromise NetWitness... Hunting 2017-08-07 06:02 [« X5

[ Behaviors of Compromise Detail NetWitness... Hunting 2017-08-07 06:02 [+ 2

[] Clesrtext Authentications by Service NetWitness..  User Activity 2017-08-0708:53 | - -

| Page 1 of5 | » ) | C PageSize 30 ~ Displaying 1 - 30 of 135

The following table describes the features in the Rule List Panel.

Description

Name Displays the name of the rule that you are created or edited.
Note: For the Name field, the icon to extend the column size is not displayed at the end
of the column field. You have to hover the mouse a little to the left side to see the icon
for extending the column.

Type Displays the supported database type for the rule you created.

Group Displays the values which are grouped.

Date Displays the date when the rule was last modified.

Modified

Actions  Displays the actions menu has the following options: Create Alert, Create Chart, Create

Report, Delete, Edit, Export, and Dependents.
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Select a Logo Dialog

In the Select a Logo dialog, you can upload a new logo that is not available in Reporting Engine Services
Config view or choose an existing logo from the Reporting Engine Services Config view.

Workflow

This workflow shows the procedure to manage reports or report groups.

Configure Reporting Create and Schedule a .
Engine Report — View a Report

\

~ /

You are here |

: I Investigate a Report
Manage Lists, Rules or |

| Reports |

|

|

What do you want to do?

Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*You can complete these tasks here.
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Related Topics
o Configure and Generate a Report

o Scheduled Reports View

o Report View

Quick View

Change Logo

Upload new logo

or select from exist ng l0gos...

B_R5A
U] =mc| =8 eme

Cancel

To access this dialog:
1. Go to Monitor > Reports.

The Manage tab is displayed.
2. Click Reports.
The Reports view is displayed.
3. Inthe Reports panel, select a report.

4. Click # > View Scheduled Reports.
The View scheduled reports view tab is displayed.

5. Select a scheduled report and click ¥ " > Edit Schedule.
The Schedule a Report view tab is displayed.

6. Click the Logo panel.
The Change a Logo dialog box is displayed.

The following table lists the fields in the Select a Logo dialog.
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o owmen

Upload new logo
Select
Cancel

Set Default

Click the icon to upload a new logo from the local directory.
Select a logo from the existing list to be used as a logo in the scheduled report.
Cancels the logo selection and returns to the Schedule a Report panel.

Select a logo to set it as the default logo.
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Schedule a Chart View
In the Schedule a Chart View, you can enable or disable a chart.

Workflow

You are here

| \
| |
Schedule a Chart T.
-
\
[
—

Configure Reporting Engine A Configure a Chart

|
|
—
l Test a Chart Investigate a Chart
Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart* Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart

Quick View
The following figure shows the Schedule a Chart view.
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Monitor Configure Admin

Manage
Rules Reports Alerts Lists Warehouse Analytics Search Report Details e
Groups Charts ,/n !
+ T + | | # o | [@viewAllCharts ™ Auto Refresh ‘
Groups ~ [T Enabled | Name ~ Group State Duration(H:M:5) Avg(H:M:5) Max(H:M:S) View Chart Actio
Al (2] O © Cleartext Authentications by Servi User Acti..  Inactive e
Dseustional Avareness @) 0 C Cleartex: Passwords by Service User Acti..  Inactive &
[ Threat .
° [m] Email Senders User Acti..  Inactive & ©
[ user Activity (] -
0 ¢ Firewa I Denied Connections Situation. nactive *#©
0 C Firewall Destination IP Addresses Situation nactive e
O C Firewall Events uation...  Inactive &5
mpe nactive &
0 C nactive e
O C IDS Signatures Situation...  Inactive (-8
O C Log Destination Ports Situation...  Inactive [ 38
0 C Log Event Categories Situation Inactive e .
| Page 1 | of1 | | C' PageSize 30 ~ Displaying 1 - 28 of 28

R S/\ NETWITNESS PLATFORM 11.4.0.0

The Schedule a Chart view includes the following panels:

Charts Groups panel
Charts toolbar

Charts panel

Charts Toolbar

The Charts toolbar allows you to add, modify, delete, duplicate, enable, disable, import and export a
chart. You can also set access permissions for charts in a group.

+ | | # © | [@viewAll Charts ™ Auto Refresh

The Charts toolbar includes the following options:

o o

+ Adds a new chart to the Reporting module.
- Deletes one or more selected charts.
E Edit charts.

Enables the selected charts.
Disables the selected charts.

Creates a duplicate copy of the selected chart.

® @

Provides the following options: Import, Export, Export as Text and Permissions.
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o o

View All Charts Displays all the executed charts.

Auto Refresh Automatically refreshes the charts list.

Charts Panel

The Charts Panel presents all the charts in a tabular or grid format.

| Enabled | Name ~
oo Cleartext Authentications by Servi...
[mie] Cleartext Passwords by Service
[mie] Email Senders
oo Firewall Denied Connections
[mie) Firewall Destination IP Addresses
[mie] Firewall Events
[mie] Firewall Systems
oo Firewall Users
oo DS Signatures
[mie] Log Destination Ports
oo Log Event Categories

| Page 1 | of1 | | C

Group State Duration(H:M:5) Avg(H:M:S) Max{H:M-S} ViewChart  Actions
User Acti..  Inactive o =
User Acti..  Inactive o 38
User Acti..  Inactive f« 2
Situation...  Inactive & -

Situation...  Inactive o 380

Situation...  Inactive f« 25

Situation...  Inactive f« 2

Situation...  Inactive & -

Situation...  Inactive o 380

Situation...  Inactive f« 2

Situation..  Inactive e NG -
Pagesize |30 v Displaying 1 -28 of 28

The following table lists the columns in the Charts panel and their description.

P Joesreton

Enabled

Name
Group

State

Duration (H:M:S)

® - The chart is enabled.
O - The chart is disabled.

The name of the chart.
The Chart Group to which the chart belongs.

The state of the chart:
o Queued

o Completed
o Failed

The time taken to execute the latest chart.

Avg(H:M:S) The average time taken to run the chart.
Max(H:M:S) The maximum time taken to run the chart.
View Chart A hyperlink that redirects to the View a Chart panel.
L XE The actions menu has the following options: Enable, Disable,
View, Delete, Edit, and Export.
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Schedule Report Panel

The Schedule Report panel allows you to schedule a customized report. Prior to scheduling a report, you

can create a dynamic list (with the overwrite option selected) with services added. For more information,
see "Generate a List from the Scheduled Report" section in Create and Schedule a Report. Then use the

list to generate a report with details in the report like services and host names.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

| |

! |
N Configure a Rule | Create and Schedule a View a Report
Engine - >

|
| \
Investigate a Report

Manage Lists, Rules or
Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*You can complete these tasks here.
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Related Topics
o Configure and Generate a Report

o Report View
o Build Report View

o Scheduled Reports View

Quick View

R SA Respond Investigate Monitor  Configure Admin

OVERVIEW REPORTS

Manage View [REPT] New Schedule @

Schedule Report
Enable = H
ReportName  FeedsTest
Schedule Name
NetWitness .
Suite DB
Time Zone UTC (GMT+00:00) | O Set Defaulc
Run Now v
on Past vl 2 $ Hours v Use relative time calculation
bl No variables d
—H
Logo |Q—n
m Reset & Configure

RS /\ NETWITNESS' PLATFORM 11.400

To access this view:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Reports view is displayed.
3. Inthe Reports panel, click ¥ " > Schedule Report.

Features

The Schedule Report view consists of the following panels:
Schedule Report View

Output Actions Panel

Dynamic List Panel

Logo Panel
Schedule Report View

The Schedule Report view allows you to schedule reports.
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Schedule Report

Enatle £

MetWitness DB | SA - Broker

Report Mame  Dynamic Report With List for Service

Schedule Mame Dynamic Report With List for Service

Run Mo -~
On Fast | 24 2 |Hours ~ [ Userelative time calculation
Variablez |terative
~
Report
Iterste On List |S[/Per User Report/List of Services] o
Apply To war ~
Variable ~ Value terative
B Rule: IP-SRC
war £[/Per User Report/List of Services) R

w

The following table lists the fields in the Schedule Report panel.

Fad oeepten

Enable

Report Name
Schedule Name
NetWitness DB

Warehouse
Resource Pool

Run

Enables the report schedules and runs the report.
The name of the report.
The name of the scheduled report configuration.

The database can be NWDB and Warehouse DB depending on the type of database
that you selected in the rule definition. If the report has rules of NWDB and
Warehouse DB types, all the database types or rule types are displayed.

If the report has rules of Warehouse DB, the Warehouse Resource Pool drop-down
is displayed to select the pools or queues available in the cluster. If no pools or
queues are entered for the Reporting engine, this field is disabled. For more
information, see "Step 5: Configure Task Scheduler for a Reporting Engine" topic in
the Host and Services Configuration Guide.

Provides the type of schedule for the run configuration:

o Ad-hoc execution

Hourly execution

Daily execution

o Weekly execution

o Monthly execution

The data range on which the query is run.
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o owan

Use relative Uses the relative time duration to schedule a report.
time calculation

Iterative Report Select the checkbox to schedule a report for the selected list value.

Iterate on List  Click this button to navigate to the List Selection panel and select a list. The
o) following figure displays this panel:

List Selection Window

¥ Refresh
List Mame =~
=25 -
@[ compliance
& [ Filtering Candidate
= Local_Country

[ Logs

& [ network Activity
@[ Per User Report
=M All_FInal

| Lists_Final
< | | »

Close Select

The List Selection panel is a collection of Lists. The Reporting Engine maintains an
active list of the available list names by continuously synchronizing with the
collection to which it is connected.

Apply To Apply list values on the selected variable.

Variables Displays the rule variables along with their associated values and the iterative
properties included in the report.

Note: Depending on the rule chosen while creating a report, you can view
dynamic variables defined for the rule in the Variables field of the Schedule
Report panel. For example, Test-Country is the rule having the dynamic variable

var.
Schedule Schedules the report.
Reset Resets the scheduled report.
Configure Allows you to alter the Reporting Engine configuration details on the "Reporting

Engine General Tab" topic in the Host and Services Configuration Guide.

Note: This button is visible on the Schedule Report panel only when you have the
'Manage Device' access permissions on the Reporting module.
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Output Actions Panel

The Output Actions panel specifies output actions to notify the email recipient when the report execution
completes and also sends reports in PDF and CSV formats as attachments in the email, based on your

selection.

(®) Output Actions

(®) Other Options

() Email
To Use , To Separate The Email IDs
Subject
Body f
f
1
|
Artach: OporF OOV CSY Delimiter |, ¥ Multivalue Delimiter | | |

+

0| 1ype Motification Servers ~ send As PDF send As CSV
[1 MNETWORK_S... ’ Windows Mount v W &4

[] URL ’ Tomcat URL v ™ 4

[] SFTP ’ Cent05 M 4

The following table lists the fields in the Output Actions panel.

e Jowewien

To A comma-separated list of email addresses to receive the output.
Subject The subject entered in the mail.
Body The body of the email. By default, the body field is populated with pre-

defined text that has certain variables that will add meta appropriate to the
generated report.
In the Reporting Engine, these variables are replaced with actual values.

${RanAtStartTime} : The Start time of the report.
${DataRangeStartTime} : The Start time of the data time range.
${DataRangeEndTime} : The End time of the data time range.

${LinkToSA} : The link to the NetWitness PlatformHost from the
email which in turn opens the report in NetWitness Platform interface.

${ReportName} : The name of the report.

${DataSource} : The name of the data source.
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R

Attach: The output format in which the report is attached to the email, such as
PDF or CSV as configured in the Schedule Report dialog.

CSV Delimiter The default CSV delimiter is comma (,). If the CSV content contains a
comma, you must identify a unique separator so the content is stored in its
original form. For example, if msg is a column in the report to be saved as

CSV and the msg content is as follows: ASA-SSM-CSC-20 Module in
slot 1," application reloading ""CSC SSM"""," version
""6.2.1599.0"" CSC SSM scan services are reloading
because of a pattern file or configuration update

The above content will be included in three columns due to the commas
(,). To avoid this, you must specify a different delimiter such as a pipe
line character “|”.

Note: To import the CSV file into Microsoft Excel, use the Data >
From Text option in the Excel application. When you import the CSV
file you must specify the file type of the file being imported as
Delimited and use the same delimiter that you specify to generate the
CSV file.

Multivalue Delimiter The data in multivalued fields are separated by the multivalue delimiter.
The default Multivalue delimiter is two pipe line characters (||).

Other Options You can select an SFTP, URL, or Network Share location configured in
((RE}} and then send the report either in PDF or CSV format based on
the requirement.

+ - Select this option to send the report to the SFTP, URL or Network Share

- location configured in the Reporting Engine Services Config view.

URL
MNetwaork Share

Type The type of output action chosen. For example, SFTP, URL or Network
Share.

Output Actions Select the SFTP, URL or Network Share name configured in the
Reporting Engine Services Config view.

Send as PDF / Send as Select these options to send the report either in PDF or CSV format, or

CSv both to the configured Notification Server (SFTP, URL or Network
Share).

Dynamic List Panel

The Dynamic List panel populates the lists created and you can add, edit or delete the list. The list is
generated based on the scheduled report which can be viewed in the Lists view.
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-:J};u Dynamic List

+ -z
List Mame ~

$[/Per User Report/List of Alias Host]

« | ’

The following table lists the operations in the Generate List panel.

o= Adds a new list to the report.
= Deletes all the lists added to the report.
Z Displays the Generate List dialog.

List Name  The name of the list chosen from the List Selection panel. For more information on the
List Selection panel topic, see Generate List Panel,

Logo Panel

The Logo panel populates the default logo from the Select a Logo panel. For more information on
choosing a logo from this panel, see "Manage and Select a Report Logo" section in the Manage Lists,
Rules or Reports.

You can set the default logo for a Reporting Engine. This is the logo that is used in the generated
reports. For more information on choosing a logo, see Select a Logo Dialog.

Note: If you have not selected any logo then the default RSA logo is used on the report. The option
Save as PDF for the previously executed reports does not support a new customer logo. It displays the
default RSA Logo, if the customer logo must be displayed in the Schedule a Report view.

)
) Logo

Change Logo NETWITNESS
PLATFORM
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Scheduled Reports View
The Scheduled Reports view allows you to create, view and manage scheduled reports.

Workflow

This workflow shows the procedure to create and schedule a report.

You are here

Configure Reporting

|
|
Create and Schedule a View a Report

|

|

Configure a Rule |
s “'I"“ Report

Engine

Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report*  Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports*

*Y ou can complete these tasks here.

Related Topics
o Build Report View

o Report View
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o Schedule Report Panel

« Reports Permissions Dialog

RS/\  Respond  Investigate

OVERVIEW REPORTS

Manage View [REPT] Malware Activity Re... @

Report Schedule !

[+ I | o % | ¥ aumssfresh Fiter Schedule By Narme

O Name ~ Schedule Last Run Duration(H:MS) Avg(H:M:S) State View Report. Actions

O Melware Activity Hourly 201708090215 00:00:03 00:00:02 Completed @ e -

| Page 1 of1 | | G Pagesize 30 v Displaying 1 -1 of 1

[R'S /\ NETWITNESS' PLATFORM 11.4.00

To access this view:

1. Go to Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Reports panel, do one of the following:

« Click . > View Scheduled Reports.
o Click the #Schedules column.

Features
The View Scheduled Reports has the following features:

Report ScheduleToolbar
Report Schedule List panel

Report ScheduleToolbar

The Scheduled Reports has options to add, modify and delete the scheduled report as well as options to
enable or disable the selected run configuration.

‘ - 4 | Q| 7 o | ™ Auto Refresh
The following table lists the operations in the Scheduled Reports toolbar.
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+ Create a new report schedule.

Delete the selected report schedule.

z Edit the selected report schedule.

Note: Double-click on a desired
report schedule to edit it.

® Enables the selected report schedule.

Disables the selected report schedule.

9 View the history of the scheduled
report.
G Filter schedules based on the type of

schedule. (For example, AdHoc)

" Allows you to set permissions for the
selected scheduled report.

M Auto Refresh Automatically refreshes the scheduled
reports list.

Filter Schedule By Name Searches schedules based on the
schedule name.

Report Schedule List Panel
The Scheduled Reports List panel lists the scheduled reports in a tabular format.
The following table lists the columns in the Scheduled Reports List panel:

Name The name of the scheduled report.
Schedule The type of schedule for the run configuration:
o Ad-hoc execution
« Hourly execution
o Daily execution
o Weekly execution

« Monthly execution

Last Run Displays the last time the report was run.

Duration(H:M:S) Displays the time taken for last execution of the report
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Avg(H:M:S) Displays the average time taken to run the report.

State Indicates the state of the scheduled report.

o Scheduled: If a report is scheduled to run on an hourly, daily, weekly,
monthly, or later time, the state of the report is displayed as scheduled, for
the first run.

o Queued: If a report is still waiting to get executed, the state of the report is
displayed as queued.

o Running: If the report schedule is in progress, the state of the report is
displayed as running.

o Partial: If in a report with several rules, a single rule execution failed or an
output action failed or creation of PDF/CSV failed, the state of the report is
displayed as partial. For example, consider a report with five rules and four
rules are executed successfully and one fails, then the state is displayed as
Partial.

o Failed: If in a report with several rules, all the rule schedule executions
failed, the state of the report is displayed as failed.

o Completed: If a report schedule is successfully executed, the state of the
report is displayed as completed.

o Canceled: When cancel request is completed, the state of the report is
displayed as canceled.

Note: Cancel option may not work for Warehouse Analytics jobs. You must
kill the job manually. Following are the steps to kill the job:
For MapR:

1. Get the Jobid from job logs.

2. Login to jobtracker UI and search for Jobid to kill under "Running Jobs".
Sample URL: http://<job-tracker-host>:50030/jobtracker.jsp

3. Kill the Jobid:

* Select Jobid under "Running Jobs" and click Kill Selected Jobs.

(or)

* Click on Jobid link, scroll down and click Kill this job link.

o Inactive: If a report schedule is disabled, the state of the report is displayed
as Inactive.

o Not available: If the report schedule executed information is not available,
the state of the report is displayed as not available.
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o Click to view the rule execution information and output action information.
Rule Execution Info  This pop-up notifies the status of multiple rules in a report and the time taken
AT-09863 TC040 for its execution.

Status: COMPLETED
Executed in 0.329 sec

Note: You can view the rule execution and output action information for a
:;f'“‘_’?;hﬁg-’fﬂm scheduled report having the state Completed, Running, Partial or Failed.
208 e By default, the Output Actions for Completed Report on Reporting Engine

Config page is set to enable, to receive an email when the report status is

Test-Allases . 0 q .
Sratus: COMEBLETED completed. To receive an email for Failed or Partial reports, you must
Executed in 0.251 sec disable this option.

Test-Con-Broker
Status: COMPLETED
Executed in 3.261 sec

Output Action Info

LIST
Status: COMPLETED
Executed in 0.008 sec

View Report Click to view the rule execution information on the View a Report Panel. You
can view the rule execution information for a scheduled report having the state
'running' as well.
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Test a Chart View

In the Test a Chart view, you can view and test the charts.

Workflow
Schedul Chart
»d

| You are here |

> PN
| Test a Chart | Investigate a Chart
\ |
‘ |

Configure Reporting Engine i Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart View a Chart

Analyst

Administrator/ Test a chart™* Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*You can complete these tasks here.

Related Topics
o Configure and Generate a Chart

Quick View

The following figure is an example with the important features labeled.
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[ oo a

- Display [ X Axis ¥ Axis ¥ Legends

Chart Options

Time Range Series Items To Plot Chart Type

Last 3 Hours

The Test a Chart view consists of the following panels:

Chart toolbar
Chart Output panel
Chart Options panel

Chart Toolbar
The Charts toolbar allows you to investigate on a particular chart and change the screen to full screen.

T Investigate & Full Screen

Faurs Jpsscipton

Investigate Investigates further on the selected chart.

Full Displays the chart in full screen.
Screen
Chart Output Panel

The Chart Output panel displays the information in a chart format for the selected time chart options.

The following table lists the features in the Test a Chart View and their descriptions.

e o~

Display  Allows you select the values that needs to be displayed and have the following options:
X Axis, Y Axis and Legends.

X Axis Displays the session count.
Y Axis Displays the actual output.

Legends  Displays the list of variables appearing in the chart.
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Chart Options Panel

The following figure shows the Chart Options panel, which displays the time range, series, and chart
type fields to configure the chart display.

Chart Options
Time Range From To Series Itemns To Plot Chart Type
Custom v | 2017-06-01 08:55:24 2017-06-02 08:55:28 @ Chart Values over Time |5 o Line 4

() Chart with Totals

The following table lists the fields in the Charts Options panel and the descriptions.

o o

Time The default time range is Last 3 Hours. However, you can select a different value from the
Range drop-down list, for example, Last Hour, or Last 6 Hours which are the preset values. Or
you can customize by selecting Last N Days or the Custom option.

From The start date and time. (only for custom options).
To The end date and time. (only for custom options).
Series The series field provides you with two options:

* Chart Values over Time: Renders the chart for the entire time range selected.
 Chart with Totals: Renders the summary of data for the selected date range.

Items to  The maximum number of events the user wants to view on the chart.
Plot

Chart The type of chart to be rendered either area, bar, column, line, step line, step area,
Type spline area or spline.
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View a Chart Panel

In the View a Chart panel, you can view and manage charts. There are options for filtering and sorting
the information in the chart, as well as options for the type of chart, the number of items to chart, and
charting values or totals. When viewing a chart, you can open the charted sessions in the Investigation
module and save the chart as a PDF.

Workflow

You are here

|

| .'

Schedule a Chart T.
- |
| |
I |

-

Investigate a Chart

Configure Reporting Engine Configure a Chart

-
l Test a Chart
Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart* View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View
The following figure is an example with the important features labeled.
Manage View [CHRT] Cleartext Password... @
—47
“?Invsit\gs(e 1= Full Screen H Af- 2 Friday
Behaviors of Compromise Sepuamber 28,2017
Display X Axis MY Axis  Legends . Sassn 20l .
S M T w T F H
1 2
- 3 4 5 6 7 8 9
g N 10 n 12 13 14 15 16
% 17 18 19 20 21 22 23
g 24 25 26 27 28 E
031 0320 0330 03:44 0350 04:00 0410 0420 0430 04:40 04:50 05:00 05:10 Charts
-+ EMPTY ~ -~ !
Behaviors of Compromise
|
Chart Options
Time Range Series Items To Plot Chart Type
Last3Hours v @ ChartValuesoverTime |5 ° Line ~
© Gharsyin Tassls
The View a Chart panel includes the following panels:
Chart toolbar
Chart Output panel
Chart Calendar panel
Chart Options panel
Chart Executed list

Chart Toolbar

The Chart toolbar has options that allow you to investigate, and view the chart on another screen.

“i} Investigate & Full Screen

The following table lists the options in the Chart toolbar.

Investigate Investigates the chart details.
Full Screen Displays the chart on a full screen.
Chart Output Panel

The Chart Output panel displays the chart with sortBy on the Y-axis, time on the X-axis and legends.

Note: You can save the chart as PDF using the icon on the Chart Output panel.

Chart Calendar Panel

The Chart Calendar panel is the default calendar with which you can filter the list of charts depending on
the date you select from the Calendar, as shown in the following figure.
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Friday
September 29, 2017

< September 2017 -~ ’

5 M T W T F 5

10 11 12 13 14 15 16
17 18 19 20 21 22 23

24 25 26 27 28 E

Charts

Chart Options Panel

The Chart Options panel displays the time range, series, and chart type fields to configure the chart
is displayed.

Chart Options

Time Range From To Series Items To Plot Chart Type

Custom ~ | | 2017-06-01 08:55:24 2017-06-02 08:55:28 ® Chart Valuesover Time |5 s Line ~
() Chart with Totals

The following table lists the fields in the Chart Options panel.

Faalowerpten

Time The default time range is Last 3 Hours. However, you can select a different value from the
Range drop-down list, for example, Last Hour, or Last 6 Hours which are the preset values. Or you
can customize by selecting Last N Days or the Custom option.

Note: The time range selected by you for a chart will be saved. When you open the same

chart the next time, the time range that is saved will be displayed. This behavior is not
applicable for the custom option.

From The start date and time. (only for custom options)

To The end date and time. (only for custom options)
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o lowen

Series The series field provides the user with two options:

o Chart Values over Time: Renders the chart for the entire time range selected.

o Chart with Totals: Renders the summary of data for the selected date range.

Items The maximum number of events the user wants to view on the chart.
to Plot

Chart The type of chart to be rendered. Either area, bar, column, line, step line, step area, spline
Type area or spline.

Chart Executed List Panel

The Chart Executed List panel displays all the executions for a particular chart for the selected date.
Double-clicking on any chart execution loads the chart on the Chart Output panel. By default, the
last executed chart is displayed in the Chart Output panel.
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View All Charts View

In the View All Charts view, you can display, print, save and email charts.

Workflow
|
|
Schedule a Chart T.
-
|
I
—
Test a Chart Investigate a Chart

You are here

Configure Reporting Engine A Configure a Chart

Manage Chart Groups
and Charts

What do you want to do?
mm

Administrator/ Configure Reporting Engine For more information, see "Configure Reporting

Analyst Engine" in the Reporting Engine Configuration

Guide.

Administrator/ Configure a chart Configure a Chart

Analyst

Administrator/ Schedule a chart Schedule a Chart

Analyst

Administrator/ View a chart* View a Chart

Analyst

Administrator/ Test a chart Test a Chart

Analyst

Administrator/ Investigate a chart Investigate a Chart

Analyst

Administrator/ Manage a chart group and Manage a Chart Group and Chart

Analyst chart

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Chart
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Quick View

R SA Respond Investigate Monitor C gure Admin

admin

OVERVIEW REPORTS

Manage View

Report Alert Warehouse Analytics ‘/n

Charts / Thursday

p ¢ = / September 28, 2017
iter Chart By Name

Charc ~

< September 2017 - >

< of Compromise

| Page 1 of3 | ) M | C PageSize 30 ~ Displaying 1 - 30 of 72
[RS/\ NETWITNESS® PLATFORM 11.4.0.0

The View All Charts panel includes the following panels.

Charts Toolbar

Charts Output panel
Charts Calendar panel
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Charts Toolbar
The following table lists the options in the View All Charts toolbar:

' Searches schedules
Filter Chart By Name
y based on the chart
name for a selected
calendar day.

Charts Output Panel

The Charts Output panel displays the chart with the chart schedule name.

Chart ~

Behaviors of Cormpromise

Chart Max_Threshold

Chart lookup and add

Cleartext Passwords by Service
Enakblers of Compromise
Firewall Denied Connections
Firewall Destination IP Addresses
Firewall Systems

HTTP Headers Non Standard
HTTP User Agents Non Standard
HTTP Webshells

105 Signatures

Indicators of Compramise

Investigation Context

I mm Diamsimasing Naws

Feature Description

Chart This field displays all the successfully executed charts.

Charts Calendar Panel

The Charts Calendar panel is used to select a date from the Calendar. Based on the date you select, the

list of successfully run charts for the date is displayed.

256
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2 Thursday
September 28, 2017

< September 2017 - >

5 M T w T F 5
12

3 4 5 6 7 8 9

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 E
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View a Report Panel

The View a Report panel is used to review the reports.

Workflow

This workflow shows the procedure view a report or list of all reports.

You are here

| |
Configure Reporting Create and Schedule a | View a Report |
Engine Report Jl-’ - |
|
| \ .
Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports*

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Report

o Build Report View
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o Import Report Dialog

o Scheduled Reports View

o Reports Permissions Dialog

o View All Reports View

o Report View

RSA ke westigate ~ Monitor  Configure  Admin
OVERVIEW s
Manage View * [REPT] Report-RuleToTestS... &
m=s «—H
Report-RuleToTestSpecialChars-1 NETWITHESS Wednesday
Generated on - 2017-08-09 08:03 (+00:00) PLATFORM August 9, 2017
08 . 08 < August 2017 - >
2016 49 08:03:00 (+00:00) Time Range 2017 49 08:02:59 (+00:00) s oM T w T B s
RuleToTestSpecialChars-1/ 1-C trat e
uleloles eclalChars- nw-conc’l - Concentrator
g Y -
User Account
a
n Reports
5
Time
5
06:07
’ 3:0:
8 3:
9
08:03

To access this view:

1. Goto Monitor > Reports.
The Manage tab is displayed.
2. Click Reports.
The Report view is displayed.
3. Inthe Reports panel, do one of the following:

« Click ® >View Scheduled Reports.
o Click the #Schedules column.
The Report Schedule view is displayed.

4. Click View.

Features

The View a Report panel has the following sections.

Reports Toolbar

Reports Output panel
Reports Calendar panel
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Reports Time panel

Reports Toolbar

The Reports toolbar allows you to print, save, email, and view reports on full screen.

Note: The Reporting Engine is responsible for generating PDF and CSV output of the reports based on
the report definition. The size of the PDF files for a report must not exceed 50,000 cells.

=850

The following table lists the options in the Reports toolbar.

@ Prints the generated report.

H Saves the report as a PDF and a CSV file.

Note: The Save As PDF option is not available for a large report. If you are
generating a PDF for a report and it takes a longer time than expected, you get a
warning message stating PDF generation is in progress, please try after some
time.

When you click download as a CSV file, the Select Rule to download dialog is
displayed. You must select a rule from this dialog to download the rule result in a CSV

file.

If the file generation takes a while, you can click on the Notify me option to be notified
once the PDF or CSV is generated. Once the PDF or CSV is generated, you can view
the Notifications for the status.

= Emails the report with the PDF or CSV attachment.
= Opens the generated report on a new window.
Reports Output View

The Reports Output panel view the report with the report schedule name, report generated time and the
actual report with the selected rule variables.
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Report-RuleToTestSpecialChars-1
Generated on - 2017-08-09 08:03 (+00:00) R SA yf,;"l"’ggallsﬂss
2016 o5 08:03:00 (+00:00) Time Range 2017 o5 08:02:59 (+00:00)

RuleToTestSpecialChars-1/ nw-conc1 - Concentrator

User Account

L N I

Feature Description

Name This field displays the name of the scheduled report.
Time This field displays the time when the report is generated.

Report  This field displays the details report with the selected rule variables.

Reports Calendar View

The Reports Calendar view is used to select a date from the Calendar. Based on the date you select, the
list of successfully run reports for the date is displayed.

1 Thursday

August 10, 2017

< August 2017 - >
s M T w T F 5

.]

2 3 4
SEE .

Reports Time View

The Reports Time view displays the time when the report was actually run.
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Reports

Time

0513

When you click View on the scheduled report having Iterative selected, the Sub Reports panel is
displayed. For each value in the configured list a report is generated.

Thiz report has been genersted for each value in the configured list. Select the
report that you Want o view.

Filter *
Values state Wiew Report
poseidonmasterbbirwin.com.br Completed @ Wigw Fe
10.153:3.201 Completed @ view O
* goog e-anaytics.oom Completed @ Wigw
ns1.dnspoint.net Completed M View
adopteursdick com Completed @ Wigw
nsgwuedu Completed @ Wigw

Ledn turner.com Completed @ Wigw
1001530228 Completed @ Wigw L
poell lb-revsoinet Completed @ Wigw
izapiblwibug com Completed @ Wiew
iron3-istserv tops gwoedu Completed @ Wigw
stbomsn.com Completed @ Wigw
misCweather.com Completed @ Wigw
1001535210 Completed @ Wigw

Cp.Us musicyahsocom Completed @ Wigw -
4 | | »

| Page 1 |of324 | » » I C Displaying 1 - 30 of 1000

The following table lists the columns in the Sub Reports panel.

Column | Description

Values The List values chosen for a dynamic variable from the List Selection panel.

State Indicates the state of the scheduled report for each of the list values.

o Partial: If in a report with several rules, a single rule execution failed or an output
action failed or creation of PDF/CSV failed, the state of the report is displayed as
partial. For example, consider a report with five rules and four rules are executed
successfully and one fails, then the state is displayed as Partial.

o Failed: If in a report with several rules, all the rule executions failed, the state of the
report is displayed as failed.

o Completed: If a report is successfully executed, the state of the report is displayed as
completed.
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Column | Description

View Clicking on any of the report schedules or sub reports listed and then View displays the
desired report.

Note: You can view the completed rules on the View a Report page even when the
report is 'Tunning'.
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View All Reports View

In the View All Reports view, you can display, print, save and email reports.

Workflow

This workflow shows the procedure view a report or list of all reports.

You are here

| :

|
Configure Reporting Create and Schedule a vi |

iew a Report
Engine Report Jl-’ - |
|
| \ .
Investigate a Report
Manage Lists, Rules or

Reports

What do you want to do?
Administrator / Configure Reporting Engine For more information, see "Step 3: Configure
Analyst Reporting Engine Data Sources" topic in the
Reporting Engine Configuration Guide
Administrator / Create a List or List Configure a Rule
Analyst Group/Create or Deploy a
Rule/Test a Rule

Administrator / Create and Schedule a Report Create and Schedule a Report
Analyst

Administrator / View a report or list of all View a Report

Analyst reports*

Administrator / Investigate a Report Investigate a Report

Analyst

Administrator / Manage/Access Control for Manage Lists, Rules or Reports
Analyst lists, Rules or Reports

*Y ou can complete these tasks here.

Related Topics
o Configure and Generate a Report

o Build Report View
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o Import Report Dialog

o Scheduled Reports View

o Reports Permissions Dialog

o View a Report Panel

o Report View

Quick View

R SA Respond Investigate Monitor Configure Admin

OVERVIEW REPORTS

Manage View

Chart  Alert  Warehouse Analytics

Reports 0 Wednesday

Fter By Renort Or Schedule Name August9,2017

Reparts Time < August2017 - >
B Al Risk Warning (9 lzems) s M T W T F S
R 2017-08-09 00:10 1 2 3 A
Ri 2017-08-09 01:10 6 7 8 n

R 017 ac

R

R

R

R

R

R

£ Hun

B Ide

2 Mal

Malwa 2017-08-09 00:15 .

To access this view:

1. Go to Monitor > Reports.
The Manage tab is displayed.

2. Click Reports.
The Report view is displayed.

3. Inthe Reports panel, click View All Reports.

The Reports panel is displayed, clicking on any of the reports listed allows you to view the report.

Features
The View All Reports panel has the following features.

Reports Toolbar

Reports Output panel
Reports Calendar panel

Reports Toolbar
The following table lists the options in the View All Reports toolbar:
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Filter By Report Or Schedule Name Searches schedules based on the
report name or schedule name for
a selected calendar day.

Reports Output Panel
The Reports Output panel displays the report with the report schedule name and report generated time.

Reports Time

B All Risk Warning (3 ltems)
2017-08-10 00:10

Risk Warning
Risk Warning 2017-08-1001:10
Risk Warning 2017-08-10 02:10
Risk Warning 2017-08-1003:10
Risk Warning 2017-08-1004:10

B Hunting Summary (5 tems)

Hunting Summary 2017-08-10 00:15

Hunting Summary 2017-08-1001:15

Hunting Summary 2017-08-1002:15

Hunting Summary 2017-08-1003:15

Hunting Summary 2017-08-1004:15
Identity Management (5 ltems)

Malware Activity Report (5 ltems)

B Report-Alerts by severity (1 Item)

Feature Description

Reports  This field displays the detailed report with the selected rule variables.

Time This field displays the time when the report is generated.

Reports Calendar View

The Reports Calendar view is used to select a date from the Calendar. Based on the date you select, the
list of successfully run reports for the date is displayed.
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1 Thursday

August 10, 2017

< August 2017 - >
s M T wW T F s

1

2 3 4
SRR
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The Reporting module user interface provides access to NetWitness alerts. This topic contains
descriptions of the user interface as well as other reference information to help users manage Alerts.

268 Alerting References



Reporting User Guide

Alert List View
The Alert List view allows you to import, export, manage, and add alerts.

Workflow

Schedule an Alert

Configure Reporting Engine Configure an Alert

2

Qou are hey
: : Investigate an Alert
il Manage Alerts and Alert
Templates |
\ |
\ I

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Overview Reports

Manage View

Rules Reports Charts m; Warehouse Analytics Search Report Details &

Alert

4+ = [ | @Enable ODisble | O £ ¢ | MTemplate [ ViewSchedule & View Alerts H /n

Enabled Pushed?  Name Description Actions

No Record
No Record

No Record

® ® o 0

Yes Record

RS /\ NETWITNESS PLATFORM

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.

R The Alert toolbar allows you to add, modify, delete, enable, disable, refresh, import, and export
an alert. Using this toolbar, you can also set access permissions for the selected alert.

The Alert panel lists all the alerts in a tabular format.
The Alerts List view has the following panels:

o Alert Toolbar

o Alert

Alert Toolbar
The Alert toolbar panel has the following features:

o o

-+ Adds a new alert to the Reporting module.

= Deletes one or more selected alerts.

z Edits an alert.
Enable Enables the selected alerts.
Disable Disables the selected alerts.
O Refreshes the view.
& Enables the following options: Import, Export and Permissions.
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Alert

The Alert panel lists all the alerts in a tabular format. The following table lists the columns in the Alert
panel and their descriptions.

Feature |Description

Enabled Displays the state of the alert:
o Enabled - the alert is active and fires based on the rule assigned to it.
o Disabled - the alert is not active.
Pushed? Indicates whether the alert is sent to Decoders or Log Decoders:
e Yes - Alert is pushed to Decoders or Log Decoders.
e No - Alert is not pushed to Decoders or Log Decoders.

Name Identifies the name of the alert. Clicking the alert name displays the rule on which this
alert is based in the Define Rules panel.

Description Indicates the alert description.

Actions Indicates the action the system takes when the alert fires. The different available action
types are as follows:

e Record
o SMTP
o« SNMP
o Syslog
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Alert Permissions Dialog

In the Alert Permissions dialog, the users with 'Read & Write' access permission can set access
permissions for an alert to configure permissions in the Alert Permissions dialog.

Qou are hey
: : Investigate an Alert
il Manage Alerts and Alert
Templates |
|
I

Workflow

Configure Reporting Engine Configure an Alert

2

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template* ~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The Alert permissions dialog allows you to set alert permissions depending on the user role.

The following figure is an example with the important features labeled.
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R S/\ Respond Investigate Monitor Configure Admin
OVERVIEW REPORTS 1
Manage View S
Rules Reports Charts Lists Warehouse Analytics Search Report Det L

Alert
+ = 4 | ®cnable Disable | O % v | EWTemplate & VviewSchedule <@ View Alerts

Enabled  Pushed? Name Import Description Actions
“ No ipsrc | Export | Record

ves . Export as Text 3 Record
e |

Alert Permissions

ST Communication to Blacklisted Hosts

Roles ~ Read & Write Read Only Mo ACcess
Administrators - @) O
Analysts @] O .
Data_Privacy_Officers ] ) -
Malware_Analysts @] O -
Operators O O O]
SOC_Managers O O (O

[1 Apply Read-only permission to Rules in the Alerts

Cancel Save

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

Click % ~ > Permissions. The Alert Permissions dialog box is displayed.
Based on the user role, select the appropriate options.

RIl (Optional) Select the checkbox if you want to automatically provide read access permission to
dependent rules.

I Click Save.

Note: If a User (other than a super user) creates an alert, super users will not be able to access the
alert.

The following table lists the columns in the Alert Permissions dialog.

Column Description
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Roles

Read & Write

Read Only

No Access

D Apply Read-only permission to Rules in the

Displays all the user roles in the NetWitness
user interface.

Allows you to apply 'Read&Write' access to the
alert.

Allows you to apply only 'Read' access to the
alert.

By selecting this permission, you cannot access
or view the alert.

Allows you to automatically apply permissions
to the rules in the alerts.

Alerts

Cancel Cancels all the changes made to the
permissions.

Save Saves the selection and provides access to the
role based on the selection.
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Alert Schedules View

In the Alert Schedules view, you can view all the alerts scheduled. Alternately, you can also disable the
scheduled alerts.

Workflow

The following workflow shows the tasks involved in creating or modifying an alert.

You are here

|
| .
Configure Reporting Engine » Configure an Alert Schedule an Alert View an Alert
|
I

2

Investigate an Alert

Templates

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert*® Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template =~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following example shows you how to access the Alert Schedules view dialog.
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| ®Enable (O Disable | O & | EW Template

[0 enabled  pusheaz | name Deseription Actions

Ooe N Record

oe N Record

oe N Record

oe ¥ Record
Manage VPl [ALRT] Alert Schedules @ 4

‘f' Disable |

Completed 2017/03A15 €:59:20 355610 o 00:00:00 00:00:00 00:00:00

§
o

(] completed 2017/03115 6:59:17 355610 a 00:00:00 00:00:00 00:00:01
[ Completed 2017/03/15 6:59:31 365719 [ 00:00:00 00:00:00 00:00:01
o

Completed 2017/03/15 €:58:49 355608 321202 00:00:02 00:00:00 00:00:05

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

Click View Schedule to open the View Alerts Schedule view.

The Alerts Schedule toolbar allows you to modify the state of the scheduled alert.
The Alerts Schedule List panel lists only the Enabled alerts in a tabular format.

Features
The different panels on the Alert Schedules View dialog are:

o Alerts schedule toolbar panel

o Alerts schedule list panel

Alerts Schedule Toolbar Panel

In the Alerts Schedule Toolbar panel, the Disable icon disables the selected alert. When schedule alerts
are no longer needed or are determined to be ineffective, you can disable them so that they are no longer
executed. You can select one of more alerts to disable. When an alert is disabled, it is removed from the
scheduled alerts list so that you cannot view it here, and it will not execute again unless you manually
execute the alert or set up a new schedule for it.

Alerts Schedule List Panel
The following table lists the columns in the Alerts Schedule List panel and their description.

State The state of the scheduled alert:
o Completed

o Failed
Name The name of the scheduled alert.
Last Run {#time} The last time the scheduled alert was run.
Last Session Id The Session Id of the last scheduled alert.
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Total Alerts The total number of event occurrences.

Duration The time taken to run the scheduled alert.

Avg (s) The average time taken to run the scheduled alert.
Max (s) The maximum time taken to run the scheduled alert.
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Create or Modify Alert Panel

The Create or Modify alert panel is a panel in the Alert List view. This panel allows you to create or
modify an alert as per the requirement.

Workflow

You are here

|
-"ﬁl i I
Configure Reporting Engine Configure an Alert Schedule an Alert plar e
[
|

%

Investigate an Alert

Templates

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert* Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Monitor  Configure Admin

Manage
Rules Reports [CEUERN  Alerts | Warehouse Analytics earch Report Det o
Aert _|H
a
[#]= @ | @Enable ODisale | T ##© | ETemplote & ViewSchedule & View Alerts
Enabled pushed?  Name Description Actions
o . t0 Black Record
No w enie n 5 Record
No rewall Destination IP Addresse Recora
Yes T Tna F € Record
[R'S/\ NETWITNESS® PLATFORM 11.2.00
Manage View [ALRT] New Alert @
Create/Modify Alert
Enable 4
Rule Basis: Browse 4
Data Sources: v [] Push to decoders /H
Description
Severity: Choose v -
Notification: (¥4 Record [CIsmtP []sNMP [1Systog
Record SMTP SNMP Syslog
Execute Once v
Body
Body Template v

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.

Click + to navigate to the Create or Modify Alert panel.
Enable the alert, navigate the rule, and select a data source to alert.
Enter a brief description of an alert.

Define the alert notification methods(RECORD, SMTP, SNMP, Syslog) to alert, when an alert
condition is matched.

The Create or Modify Alert panel has the following sections:
o Alert Definition
o Alert Description

o Alert Notification
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Alert Definition
The following table describes the fields in the Alert Definition:

P fpcrbton

Enable o Enable activates the alert. The alert executes and sends output actions every minute (by
default) when the alert conditions are met.

o Disable deactivates the alert. The alert does not execute and does not send any output

actions.
Rule Click Browse to display the Rules Library panel from which you select the rule that is the
Basis basis of this alert.

You must select a rule that has a unique 'where' clause for an alert.

Data Specifies the data source for the alert.
Sources

Pushto  Pushes the ‘where’ clause of the alert rule to Decoders connected to the selected NWDB
decoders data source.

This is the recommended option used to create RE alerts, as the alert conditions are
checked on the Decoder itself and the alert queries will be comparatively faster in NWDB.

If you deselect this option, the alert rule ‘where’ clause will be queried against the selected
NWDB data source. Based on the complexity and metas in the ‘where’ clause of the rule,
the alert queries might take more time to process in NWDB.

Note: RSA NetWitness does not send rules to the Decoder automatically.

Alert Description
The following table describes the fields in the Alert Description:

o Towmn

Description Describes the alert.

Create Creates the alert. (This option is displayed when you create an alert.)
Save Saves the changes made to the alert. (This option is displayed when you modify an alert.)
Alert Notification

The Alert Notification allows you to define the notification action NetWitness takes when an alert is
generated, for example, recording or sending the alert using one of the defined output actions. The output
actions are Simple Mail Transfer Protocol (SMTP), Simple Network Management Protocol (SNMP), or
Syslog message.

The Notification contains the default Record tab, which you use to create an alert. The icon beside the
Record tab allows you to select the notification type from the drop-down list for the output to specify for
the alert: SMTP, SNMP, or Syslog.
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Depending on the selected notification type, the Notification section is populated with predefined text
that contains variables that add Meta that is appropriate for the alert. In the Reporting Engine, these
variables are replaced with actual values. The following table lists the variables and their descriptions.

${meta.<metakey>}  The meta key value.

Note: If the <metakey> did not fetch any value, an empty string("") is
printed.

By default, Reporting Engine displays all the repeated values for a meta
key. If you do not want the meta values to repeat in the Alert output,
enable the "removeRepeatedMetaValue" option by navigating to
Configuration > Alert Configuration available for the Reporting Engine
in the Services - Configuration > Explore view.

For example, in an HTTP Session the value for the action is displayed as
get, get, put, put, post, get. When this option is enabled, the value is
displayed as get, put, post.

${meta.time} / ${meta.time} - The session time is printed in "yyyy-MMM-dd
${meta.time:<time_  HH:mm:ss" format.
format>}

${meta.time:<time format>} - The session time is printed in the user-
defined custom time format. For example, ${meta.time:dd-MM-yyyy
HH:mm:ss}.

For more information on the supported time formats, see
http://docs.oracle.com/javase/7/docs/api/java/text/SimpleDate Format. html

Note: If the time format provided by the user is invalid, the default time
format will be used. The default time format is "yyyy-MMM-dd

HH:mm:ss".
§{name} The alert name defined in Reporting Engine.
§{count} The number of times an alert is detected in a given time frame. (By default,
it is one minute)
${nw.host} The NetWitness host name as configured in Reporting Engine.
${device.id} The NetWitness device ID of the data source.

The Alert Notification has four tabs:
+ Record Tab
« SMTP Tab
« SNMP Tab

o Syslog Tab
Record Tab

Use the Record tab to define the frequency for recording an alert and the message to generate when an
alert is generated.
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Notification:  [#] Record [15MTP [ SNMP [ Syslog
Record SMTP. SNMP Syslog

Execute

Body

Body Template v

The following table lists the fields in the Record tab and their description.

P Joserpin

Execute  The frequency for recording an alert.

o Once - Record the alert only once based on the alert interval no matter how often the
alert is generated. NetWitness records the number of times the alert has actually
generated during that interval in the log file so that analysts know how many times the
alert registered a match over a given day.

o Each Event - Record the alert each time as it generates. If an alert generates unlimited
number of times during a day, that alert is often treated as noise and can be ignored,
except in case of alerts that require continuous monitoring such as network configuration
changes and DDOS attacks.

Note: Select Each Event setting from the Execute drop-down list for SNMP and Syslog
output actions.

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the alert message.
Template

SMTP Tab
The SMTP tab allows you to define the SMTP (email) output for this alert.

Notification: [ | Record ) sMTP 1 SNMP ] sysleg
Record SMTP SNMP Syslog

Exscute Once
To Use, To Separate The Email IDs

Subject

Body P host}/investigati e i DETAILS/${met: fonid}

Body Template -

The following table lists the fields in the SMTP tab and their description.
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s owmen

Execute The frequency to send an email message for the alert.

o Once - Sends only one email for an interval, if an alert generates in that interval,
irrespective of how many alerts generated.

« Each Event - Send an email with the alert for every event in which the rule criteria

are met.
To The email addresses to which to send this alert.
Subject The subject of the email message.
Body The body of the message.
Body (Optional) If templates have been defined, select a template for the SMTP message that

Template  you can use as is or modify.

SNMP Tab
The SNMP tab allows you to define the SNMP output for the alert.
Notification: [ ] Record [ SMTP [¥ SNMP [ Syslog.
Record SMTP SNMP Syslog
B):E:: ) n:E .host) i e, DETAILS/$ T

Body Template

The following table lists the various fields in the SNMP tab and their description.

e

Execute  The frequency to send an SNMP output for an alert.

¢ Once - Sends an SNMP message along with an email for an interval, if an alert
generates in that interval, irrespective of how many alerts generated.

« Each Event - Sends an SNMP message with the alert for every event in which the rule
criteria are met.

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the SNMP message to use
Template as is or modify.

Syslog Tab
The Syslog tab allows you to define the Syslog message output for this alert.
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Notification: [ Record [ sMTP ] SNMP ¥ syslog.
Record SMTP SNMP Syslog

+

[ sysogName~ | execn te severity Facllity

No syslog config created

Click + to add Syslog configuration to an alert. The New Syslog Configuration dialog box is displayed:

New Syslog Configuration

Syslog Configs | Choose ... ~
Execute Once by
Facility Local7 (23) o
Severity Warning w
Body https://${sa.host}/investigation/

${device.id}/navigatefevent/DETAILSS
${meta.sessionid}

Body Template Choose .. bl

LN

Cancel ave

The following table describes the fields in the New Syslog Configuration dialog:

e

Syslog The Syslog configuration of the Device Config view located at the Syslog Configuration
Configs  panel.

Execute  The number of times that you want to send a Syslog output for the alert.

o Once - Sends a Syslog output along with an email for an interval, an alert generates in
that interval, irrespective of how many alerts generated.

o Each Event - Sends a Syslog output with the alert for every event in which the rule
criteria are met.

Facility =~ The type of program logging the message. Examples for the type of programs are Syslog,
Daemon, Mail, and Kernel.

284 Alerting References



Reporting User Guide

o Jomamn

Severity ~ The severity level of the alert that generated.

« Emergency
o Alert

o Critical

o Error

o Warning

« Notice

o Informational

o Debug

Body The body of the message.

Body (Optional) If templates have been defined, select a template for the Syslog message to use
Template as is or modify.
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Investigate an Alert View

In the Investigate an Alert view, you can view and investigate alert details. When investigating an alert,

you can open the sessions in the Investigation module for further investigation.
Configure Reporting Engine Configure an Alert -> Schedule an Alert
You are herez

k / | |

| Investigate an Alert -'

Manage Alerts and Alert | |
Templates | |
I I

Workflow

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert™ Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Manage View

Report Chart Warehouse Analytics

Alert View

All Day ¥ Max No Of Alerts | 100 >

Investigate Name Number of hits Detected Message
T Top 10 Destination IP Addresses 1 2017/03/13 3:16:49
<? Top 10 Destination IP Addresses 1 2017/03/13 3:15:49
<? Top 10 Destination IP Addresses 1 20717/03/13 3:14:49
<? Top 10 Destination IP Addresses 1 2017/03/13 3:13:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:12:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:11:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:10:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:09:49
<? Top 10 Destination IP Addresses 1 20717/03/13 3:08:49
<? Top 10 Destination P Addresses 1 2077/03/13 3:07:49
h g Top 10 Destination IP Addresses 1 2017/03/13 3:06:49
g Top 10 Destination IP Addresses 1 2017/03/13 3:05:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:04:49
T Top 10 Destination IP Addresses 1 2017/03/13 3:03:49
<? Top 10 Destination IP Addresses 1 2017/03/13 3:02:49
<? Top 10 Destination IP Addresses 1 20717/03/13 3:01:49

The View an Alert view has the following panels:
o View Alerts Toolbar
o View Alerts List

View Alerts List

The following table lists the columns in the View Alerts List panel.

Column | Description

{i} The icon that opens the Investigation module, where the details of the first session that
registered the match for the given alert is displayed for immediate analysis.

Note: You are not redirected to the Investigation module when:

-You reconfigure a data source for an existing alert and run an alert on the new
data source.

-You enter a host name instead of an IP address in the data source field.

Name The name of the alert that registered the match. The hyperlink on the name opens the
Investigation module to view all matches for that particular alert for the hour surrounding
the registered alert.

Number  The number of times the alert is generated.
of hits

Detected The date and time at which the alert generates.

Message  The alert message.
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Import Alert Dialog

The Import Alert dialog allows you to import an alerts archive and specify whether to overwrite existing

rules, lists, and alerts.

Qou are hey
: : Investigate an Alert
il Manage Alerts and Alert
Templates |
|
I

Workflow

Configure Reporting Engine Configure an Alert

2

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Rules Reports Charts Lists Warehouse Analytics

Import Alert

% Erowse... Delete

File Name w  Overwrite ?

" cioe | impons |

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.

In the Alert panel, select a folder to import the file.

In the Alert toolbar, click % ~ > Import to import an alert.

The following table lists the actions in the Import Alert dialog and their description.

Actions |Description

= Browse... Displays a view of the local zip file system so that you can select the alert to be
imported.

- Deletes the selected alert from the Import Alert dialog.

File Name Name of the imported binary file.

Overwrite? Selects the option to overwrite an existing version of the alert you are importing. If you do
not select the Overwrite option, a duplicate file is imported and no error message is

displayed.
Close Closes the Import Alert dialog.
Import Imports the alert with a confirmation message.
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Alert Template References

The Reporting module user interface provides access to NetWitness alerts and alert templates as well.

This topic contains descriptions of the user interface as well as other reference information to help users
manage alert templates.

Topics:
o Create or Modify Template View

o Template View
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Alert Template View

In the Template view, you can add, modify, view, and delete alert templates.

Workflow
Schedule an Alert m

Configure Reporting Engine Configure an Alert

Qnu are hey
|
! Manage Alerts and Alert
Templates
\

Investigate an Alert

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template*  Manage an Alert and Alert Template

Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Manage

Rules Reports Charts. Search Report Details kel

Alert

+ -
Name Message

alert template template message

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.
Click E® Template to open the Template view.

The Template toolbar allows you to add, modify, and delete alert templates.
The Template List panel allows you to view a list of all the templates in a tabular format.

The Alert Template view has the following panels:
o Template Toolbar

o Template List

Template Toolbar

Once the templates are defined, you can select a template to simplify defining and modifying alert
messages.

The following table lists the various actions in the Template view and their description.

G =

== Creates a new alert template.

- Deletes the selected alert template.
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G =

a Edits an existing alert template.

Template List

The following table describes the columns in the Templates List panel.

Name Name of the template.

Message  Alert message defined for the template.
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Create or Modify Template View

In the Create/Modify Template view, you can customize alert templates to use when creating alerts.

Workflow
Schedule an Alert m

Configure Reporting Engine Configure an Alert

Qnu are hey
|
! Manage Alerts and Alert
Templates
|

Investigate an Alert

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template* Manage an Alert and Alert Template

Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview

Quick View

You can create or modify an alert template name and message on this view.

The following figure is an example of the Create or Modify alert template.
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Create/Modify Template

Mame

Message

The following table describes the fields in the Create/Modify template.

e e

Name Indicates the name of the template for Reporting alerts. For example, source IP.
Message Specifies the message that will be sent when an alert is triggered.

Create Creates the template with a confirmation message and becomes available for use in
Reporting immediately.

Save Saves the template with the edited details or when a new template is created. This button
is visible only in the edit mode.

Cancel Closes the dialog without saving the template or any changes made to the template.
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View Alerts Schedule View

In the View Alerts Schedule view, you can view the following information about each of your scheduled
alerts.

o Completion status, name, last run time, last session ID, total alerts triggered.

o Statistics about the time taken to run the scheduled alert: duration, average duration, maximum
duration.

Note: You can also disable the scheduled alerts.

Workflow

You are here

View an Alert

2

Investigate an Alert

Configure Reporting Engine

Templates

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert* Schedule an Alert

Analyst

Administrator/ View an alert View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template Manage an Alert and Alert Template

Analyst

*You can complete these tasks here.

Related Topics

Alerting Overview
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Quick View

The following figure is an example with the important features labeled.

Reports

Manage View

Rules Reports Search Report Details i

Alert
+ = Z | ®Enable

[ enabled | pushed?  name Descripton . aamens

oo olo
IR IR
R

Manage View [ALRT] Alert Schedules @ 4

‘ O Disable ‘

Completed 2017/03/15 6:59:20 355610 ] 00:00:00 00:00:00 00:00:00

Completed 2017/03415 6:59:31 365719 0 00:00:00 00:00:00 00:00:01

a]
o
] Completed 2017/03/15 6:59:17 355610 o 00:00:00 00:00:00 00:00:01
o
o

Completed 2017/03/15 6:58:49 355609 321202 00:00:02 00:00:00 00:00:05

Click Monitor> Reports to view the Manage tab.

Click Alerts to open the Alert view.
Click View Scheduleto view all the alerts scheduled.

The Alerts schedule toolbar allows you to disable the scheduled alert.
The Alerts schedule list allows you to view the scheduled alert details.

The View Alerts Schedule view includes the following panels:
1. Alerts Schedule toolbar
2. Alerts Schedule list

Alert Schedule Toolbar
The Alerts Schedule Toolbar panel allows you to modify the state of the scheduled alert.

e =

Disable Clicking Disable disables the selected alert.
When schedule alerts are no longer needed or are determined to be ineffective, you
can disable them so that they are no longer executed. You can select one of more
alerts to disable. When an alert is disabled, it is removed from the scheduled alerts
list so that you can't view it here, and it will not execute again unless you manually
execute the alert or set up a new schedule for it.

Alert Schedule List Panel

The Alerts Schedule List panel lists only the Enabled alerts in a tabular format. The following table lists
the columns in the Alerts Schedule List panel and their description.
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Feature Description

State The state of the scheduled alert:
o Completed
o Failed
Name The name of the scheduled alert.
Last Run {#time} The last time the scheduled alert was run.

Last Session Id The Session Id of the last scheduled alert.

Total Alerts The total number of event occurrences.

Duration The time taken to run the scheduled alert.

Avg (s) The average time taken to run the scheduled alert.

Max (s) The maximum time taken to run the scheduled alert.

298 Alerting References



Reporting User Guide

View Alerts View

In the View Alerts view, you can view all the alerts. Also, you can also customize the view to show
alerts for a specific period of time, and set the maximum number of alerts displayed in a single page.

Workflow

You are here

Configure Reporting Engine |

Templates

What do you want to do?
mm

Administrator/ Configure Reporting Engine Configure Reporting Engine

Analyst

Administrator/ Configure an alert Configure an Alert

Analyst

Administrator/ Schedule an alert Schedule an Alert

Analyst

Administrator/ View an alert™* View an Alert

Analyst

Administrator/ Investigate an alert Investigate an Alert

Analyst

Administrator/ Manage an alert and alert template ~ Manage an Alert and Alert Template

Analyst

*Y ou can complete these tasks here.

Related Topics

Alerting Overview

Quick View

The following figure is an example with the important features labeled.
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Monitor

Alert 3
4+ = [Z | ® Enable Disable | O %% - | W Template [ View Schedule
Enabled pushed?  Name Description Actions
No nunication to Blacklisted k Record
No rewall Denie Record
No all Des at Addresse: Record
Yes Top tination IP Addresse: Record

Report Chart Warehouse Analytics

Alert View

All Day ~ | Max No Of Alerts 100 z

Investigate Name Number of hits Detected Message
o
I 1 2017/03/13 3:16:49
P
I 1 20717/03/13 3:15:49
o
I 1 2017/03/13 3:14:49
P
I 1 2017/03/13 3:13:49
P
I 1 2017/03/13 3:12:49
oS
I 1 2017/03/13 3:11:49
oS
I 1 2017/03/13 3:10:49
P
I 1 2017/03/13 3:09:49
o
I 1 2017/03/13 3:08:49
o
I 1 2077/03/13 3:07:49
>
I 1 2017/03/13 3:06:49
oS
I 1 2017/03/13 3:05:49
P
I 1 2017/03/13 3:04:49
P
I 1 2017/03/13 3:03:49
o
i Top on IP Addresses 1 2017/03/13 53:02:49
P
L Top 10 Destination IP Addresses 1 20717/03/13 3:01:49

Click Monitor> Reports to view the Manage tab.
Click Alerts to open the Alert view.
Click View Alerts to view the different panels on View Alerts.

The View Alerts toolbar allows you to filter alerts based on a count, or the start and end date of
the alerts.

The View Alerts List lists all the filtered alerts in a tabular format.

The View Alerts view has the following panels:
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o View Alerts Toolbar
e View Alerts List

View Alerts Toolbar
The following table lists the operations in View Alerts toolbar panel.

N

Last Hour(s) The data fetched from the previous execution.
data

Max No Of  The maximum number of alerts that you want to fetch from the Reporting Engine
Alerts service for a specific time-range.

View Alerts List
The following table lists the columns in the View Alerts List panel.

“i) The icon that opens the Investigation module, where the details of the first session that
registered the match for the given alert is displayed for immediate analysis.

Note: You are not redirected to the Investigation module when:
-You reconfigure a data source for an existing alert and run an alert on the new

data source.
-You enter a host name instead of an IP address in the data source field.

Name The name of the alert that registered the match. The hyperlink on the name opens the
Investigation module to view all matches for that particular alert for the hour surrounding
the registered alert.

Number  The number of times the alert is generated.
of hits

Detected The date and time at which the alert generates.

Message  The alert message.
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Appendix

This section provides detailed information about the supported aggregate functions, rule syntax,
advanced rules query syntax in Reporting and task scheduler for Warehouse Reporting.
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Rule Syntax

This section describes the different rule syntax supported in the Reporting Engine.

NWDB Rule Syntax

The NWDB rule is one of the rule syntax supported in the Reporting Engine. To enhance the execution
time of your reporting entities, see "Reporting Guidelines" section in Reporting Overview.

A Rule is a function that manipulates the result set of a rule in order to make the output in a report more
meaningful or add additional functionality to a rule other than querying data and displaying it. Any
combination of these rule actions can be used to create unique and interesting representations of the
information collected by NetWitness Platform.

The Reporting Engine supports the following categories of NWDB data source rule syntax:
« select clause
o Non-Aggregate Rule
o Aggregate Rule
o alias
o where clause
o where clause Operators
o then clause
o Limit field
o Rule Actions

« Rule Operators

Select Clause

The select clause is a comma separated list of values. For example: select sessionid,time,service.
There are two types of select clause for NWDB Rule:

o Non-aggregate rule

o Aggregate rule

Non-Aggregate Rule

When you want to define a rule without any grouping, choose 'None' in the Summarize field. In a non-
aggregate rule, you can select any number of metas in the Select clause. For example, select service,
sessionid, time.
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Build Rule

Rule Type MetWitness Platform DB

Mame Mon-Agzregate Rule

Summarize Mone -

|Select service, sessionid, time

Alias P Source

Where service=443

[Then Enter a then clause...

[Crder By Column Name Sort By
Enter the column name._.. Azcending

Limit 20 .
Save Reset Test Rule

Aggregate Rule

When you want to query for a specific meta and its associated aggregate value then you must use the
Aggregate rule. To get an aggregate, you must choose either of the three metas (Event Count, Packet
Count, Session Size) or choose 'Custom' in the Summarize field to include an aggregate function in
the Select clause. For example, select ip.src, sum (ip.dst). When Custom aggregate rule is enabled, the
following fields are populated in the user interface:

o Group By
e Order By
o Session Threshold

The following figure shows the Build Rule view for Aggregate Rule.
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Build Rule
Rule Type MetWitness Platform DB
Mama Aggregate Rule
Summmarize Custom w
Select ip.=re, countdistinct(ip.dst)
Alias IP Source
Where ip.sTC exists
Croup 2y ipsrc
Then Enter 3 then clzuzs.
4 3
Order By Column Name = SortBy
-
p.src Ascending
-
countdistinct{ip.dst) Ascending
Enter the column name... Ascending
Session - P
i 0
Threshald :
=l o <
Use Sawve Reset Test Rule

There are two types of aggregate values that can be queried:
o Collection aggregation

o Meta aggregation

Collection Aggregation

With collection aggregation, you can get aggregates related to Event, Session or Packets. The following
values can be queried in a collection aggregation:

« Event Count: The total count of events.

o Packet Count: The total count of packets.
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o Session Size: The total session size.

These options are listed in 'Summarize' field and any one of them can be selected in a rule.
For example, choose any of the Collection aggregates (Event Count or Packet Count or Session Size) in
the 'Summarize' field and select ip.src.

Build Rule

Rule Type MetWitnezs Platform DE
Name Collectizn Aggregation
SlEEs Event Lount =
e ip=re

Alias IP Source

Where

ipsrc
Then Enter a then clauss..
3
Order 2y Column Name Sort By
Total Azcending

]
0

.
[u]

= |

3

<y

=
3
E

{5}
=]
©

Save Reset Test Rule

Meta aggregation

With meta aggregation, you can get aggregates of meta values. The following are the supported meta
aggregate functions:
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o sum(meta)

o count(meta)

o countdistinct(meta)
o min(meta)

o max(meta)

o avg(meta)

o first(meta)

o last(meta)

o len(meta)

o distinct(meta)

Supported Meta Aggregate Functions
The NWDB service supports the following meta aggregate functions and syntax in this release.

s e =S

sum The sum of all meta values.

(<meta>) For example, if you provide the field sum(payload) in the select clause, the resultset is
the sum of payload size.

Note: The meta field chosen for the sum aggregate function must be of numeric data

type.
count The total number of meta fields that would be returned.
(<meta>) For example, if you provide the field count(ip.dst) in the select clause, the resultset is

the number of times an ip.dst value is returned.

countdistinct The total number of distinct meta fields that would be returned. For example, if you
(<meta>) provide the field countdistinct(ip.dst) in the select clause, the resultset is the number of
times a distinct ip.dst value is returned.

min The minimum of all meta values.

(<meta>) For example, if you provide the field min(payload) in the select clause, the resultset is
the min of payload size.

max The maximum of all meta values.

(<meta>) For example, if you provide the field max(payload) in the select clause, the resultset is

the max of payload size.
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O

avg The average of all meta values.
(<meta>)

For example, if you provide the field avg(payload) in the select clause, the resultset is
the avg of payload size.

Note: The meta field chosen for the avg aggregate function must be of numeric data

type.

first The first occurrence of the meta value.

(<meta>) For example, if you provide the field first(ip.src) in the select clause, the resultset is the
first occurrence of ip.src for that group.

last The last occurrence of the meta value.

(<meta>)

For example, if you provide the field last(ip.src) in the select clause, the resultset is the
last occurrence of ip.src for that group.

len(<meta>) Converts all field values to a UInt32 length instead of returning the actual value. This
length is the number of bytes to store the actual value, not the length of the structure
stored in the meta database.

For instance, the meta value "NetWitness" returns a length of 10. All IPv4 fields, like
ip.src, returns 4 bytes.

distinct The distinct values of the meta.

(<meta>) For example, if you provide the field distinct(ip.src) in the select clause, the resultset is

all the distinct ip.src for that group.
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Y ou must select 'Custom' in 'Summarize' field and provide the meta and the meta aggregate functions in
the select clause.

Build Rule

Rule Type

Name

Summarize

Seszion

MetWitness Platform DB

Custom
Custom k4
ipsrc, sumipayload)

IP Source

ipsrc

Enter a them clauss...

Column Mame
ip.src

Enter the column name._.

=]
L4

[
o
L

Save Reset Test Rule

sort By
Ascending

Ascending

Note: Meta aggregate functions cannot be used in a WHERE clause and the rule actions like min
threshold/max_threshold can be used to filter aggregate functions. It is advised to use a more refined
WHERE clause to get a better rule performance while using 'group by'.

Aggregate Query for Multiple Meta

To execute aggregate query for multiple Meta, follow these steps:

1. Go to Monitor > Reports.

The Manage tab is highlighted and the Rules view is displayed.
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2. In the Rules toolbar, click + > NetWitness Platform DB.

For example, enter the following meta in the fields highlighted below:
SELECT: ip.src, service, count(alias.host)

ALIAS: Source IP Address, Service Type, count(alias.host)
WHERE: ip.src = 59.96.136.142

Note: In the alias field you can enter a name for columns used in the select clause. If you do not
specify the alias for one of the field in the select clause, then the default description will be used.
For example, if the select clause has Fieldl, Field2, Field3, Field4, and alias has only Fieldl,

Field3, Field4, then for Field2 a default description is used.

3. Click the Test Rule button at the bottom of the screen.

The Test Rule page is displayed.

Test Rule

Data Source

Summarize

Summarize determines the type of summarization or aggregation for the rule.

NWDB -
Format

Tabular ~
Time Range

Past v
5 & |Weeks v
# Use relative time calculation

2014 32 04:49

Source IP Address

Rule With Aggregates

Service Type

count(alias.host)

36

2015

0z
03

04:49
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m Config Value

Summarize To query metas without any custom grouping, select:

o None: The data is grouped by session in this case.

To get collection (sessions/events/packets) related aggregates, select either of the
following:

o EventCount: The total count of events.
o Packet Count: The total count of packets.

o Session size: The total session size.

To get meta based aggregates, select:

o Custom: This indicates that expected meta aggregate function is defined in rule select
clause.

Order By

Order By determines how to sort the result set.

m Configuration Value

Column The Column Name is the name of the columns by which you want to sort the results. By

Name  default, the value is empty. When you click on a column, the value gets populated based on
the Summarize field.

o For 'None' and 'Custom', the value gets populated based on the entries made in
the Select field. You can select from this list or add custom name.

o For Event Count, Packet Count and Session size, accepted values are Total and Value.
o Total - sort by aggregate value
o Value - sort by group by meta

Sort By Sort By determines the order in which you want to sort the results. The following are the
values:

o Ascending Order
o Descending Order

Session Threshold

The session threshold is the optimization setting to stop scanning the matching sessions for each possible
unique value for the selected meta. The threshold is an integer between 0 (default) and 2147483647. The
threshold 0 scans for all matching sessions.

Note: If you provide a non-zero value (a value higher than zero), the aggregate results are
inaccurate. This can be used only when you are interested in unique values and not aggregate values.
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Supported where Clause

where <field1> [<field- The where clause is a comma separated list of language field values and
operator>] ranges that is used by NwValues function. In the where clause, string

< values have to be enclosed within single quotes. For example, where
value 1> <value2>,<value3- username = 'admin' && service = 22.

value4> <logic-operator>

<field2>,and so on

where <field1> [<field- You can use a list in the where clause if you have multiple values to
operator>] <List1> report on. For example, where ip.src exists && alias.host exists
&& alias.host contains $[User Reports/List of Alias Host]. When you
use the list you must specify in the format $[<path>/<List name>].

In the where clause, make sure the syntax is correct based on the meta type.

For example,

For all text meta type use quotes for example, username = ‘userl’.

For all I[P Addresses, Ethernet Addresses, and Numeric meta types do not use quotes for

example, service = 80 && ip.src = 192.168.1.1.

For date and time meta types, if the date and time format is 'YYYY-MM-DD HH:MM:SS*, use quotes.
If the date and time format is 1448034064 (number of seconds since EPOCH (Jan 1, 1970)), do no use
quotes.

Note: If list is used in the rule, make sure that the list values are quoted or unquoted based on the type
of the meta used. Checking the Quotes will be inserted for all the values checkbox in list definition
page (for more information see, "Create Lists or List Groups" section in Configure a Rule) would
quote all the list values.

Supported where Clause Operators

= Returns results where the field is equal to any provided value. For example, tcp.dstport =
21-25,110 returns session with TCP destination ports of 21, 22, 23, 24, 25, or 110.

I= Returns results for fields that do not match the values specified. For example, eth.type
1=0x0800 returns sessions outside of hex value (decimal value of 2048) that is all non-IP
based protocols.

begins Checks for a value at the beginning of a text or binary field.

contains  Searches a text or binary value for a partial match.

ends Checks for a value at the end of a text or binary field.
exists If the field value exists, regardless of value, the operation evaluates to true.

lexists If the field value does not exist, the operation evaluates to true.
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length Evaluates the length of the field. For example, username length 20-u returns any username
that is 20 or more characters long.

regex Performs a regular expression search against text or binary values.

not Not operator is used to negate a clause or condition. For example, (not(user.dst ends "$"))
will not display values for user destination.

Supported then Clause

then The then clause contains a rule action that manipulates the original result set of a rule in
<rule order to make the output in a report more concrete or add additional functionality other than
action>  querying data and displaying it. For example, dedup (filename).

Limit field

This indicates the limit to be put on the query while fetching data from the database. If a result set is
sorted by event

count, packet count, or session size, the limit represents the top (or bottom) N values to be returned. If
the result set is not

sorted, the first N values are returned.

Rule Actions

The NWDB data source rule syntax supports the following rule actions:
o dedup

o filter on

o filter out

e lookup and add

o max_threshold

o min_threshold

o Tegex

e sSum_count

o sum values

o show whats new

dedup (string field)

dedup removes the duplicate entries in an unsorted result set and displays only pertinent data.
The dedup rule action removes duplicate entries of a specific field in the report, so that only the first
occurrence of that value is listed in the report.
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Note: The dedup rule action cannot be used with an aggregate rule.

For example, the meta data generated by an individual session is often repetitive, especially when you
have sessions with a lot of DNS lookups or web sessions that access the same host multiple times for
various resources (such as, javascript, css). To remove the duplicate entries of the host, you can use
the dedup rule action.

Example:

The following example is a lengthy result set that can be trimmed by removing the duplicate values in the
same session.

Test Rule

Data Source

e 5 2015 397 04:05 Rule without Dedup Rule Actions 2015 5 04:05

Format Source |P Address ST Hostname Aliases ~

Type
Tabular hd o ) o )
1 550 Microsoft Secure Server Autharity

Time Range

Past - prd HTTP I['-11:-53.5::5.-E[E[i:.::u""I:’u'r:53.eba',.-s:a: :.::-1"

2 3 Weeks v

[#f Use ralative time calculation

=
I

|

=

Run Test

5 HTTP
& HTTP _google.comfmail google.co 11|
7 HTTP
] HTTP
9 HTTP SPOrs.Com, WWW.SKysporis.com,
10 HTTP
i HTTP
~F1 ima n . d
97 FihS 8g.gwu.edu

The following figure shows the use of dedup rule action to remove the duplicate entries from the result
set.
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Build Rule

MedWitness Placform DB

Mame Rules with Dedup Rule Actions

summarize None =

Select ip=rc, service, alias host

Aliaz Source |2 Address, Service Type, count(alias_host)
Where ip=src exists & service exists A& alias. host exists
Then dedupialias. host);

Enter a then clauzs...

! y
Lo Column Name SortBy

Enter the column name... Azcending
Lirnit 1000 o

Save Reset Test Rule

The duplicate value for each entry in the rule result set is reduced to one value.
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Test Rule
Data Source o o - 02
2015 57 04:12 Rule with Dedup Rule Actions 2015 45 04:12
204.31-Conc hd
Servi .
Format Source IP Address _l:::“ Haostname Aliases Y
Tabular ~
1 55L rosoft Secure Server Autharity
Time Range
Past v | arre
3 HTTP
2 T Weeks ~
4 HTTP
[¥f Use relative time calculation
5 HTTP
7 HTTP
8 HTTP
] HTTP
10 HTTP
11 HTTP
12 DNS
13 HTTP
14 HTTP hd

filter_on (string filter, string field, bool matchExact)

filter on removes values that do not contain the filter criteria from the result set. If the result
set contains multiple fields, you must select a specific field to which the filter is applied. To add
additional results to a single result set, include function such as lookup and add.

The matchExact parameter determines if the match is an exact match or contains a match.
o If matchExactis setto false, any value that contains the filter text is considered a match.

o If matchExact is set to true, only values that match the provided filter text is included in the result
set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action is to match
exactly the text specified in the filter parameter. To specify that results containing the filter text must
be kept in the result set, users must set the matchExact parameter to false.

Example:

The following figure displays the list of countries and their event count.
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Test Rule

Data Source
204.31-Canc

Format

Tabular

Time Range

Range

Fram

0271015 01:00:00
Ta

02/10M15 03:00:00

2015

%2 01:00

Source Country
united states
china

united kingdom

Rule without Filter_On 2015
Total events count
15105
1174
381

362

193
170
162

160

92 03:00

The following figure shows a filter_on rule action to filter out countries except Spain, China, United
States and United Kingdom from the result set.
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Build Rule

Rule Type MetWitness Platform DB

MName Rule with Filver_On_True

Surmnmarize Ewent Count -

Select COUNEry.src

Alias Country Source

Where COUNTRY.Sre exists

Group By COUNEry.Sr

Then filter_on ("spain,china, united kingdom®, country.src’);

Enter a then clauze..

Order By Column Mame sort By

Total Descending

L]

L4

Reset Test Rule

The following figure shows the output with the filter on rule action.
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Sourc ol - = < 03 Ee
Datz Saurce 2018 ,, 06:59:00 Rule with Fileer_On_True 2018 ,; 06:58:59
Admin- Concentrator b

Country Source Total events count

Format

1 china 329101
Tabular L4

2 zpain BAE4D
Time Range

~itad kimEdorm =1

- L3 united kingdo 58335
2 & Months

[# Use relative time calculation

Close

Another way of filtering out the entries from the result set is to create a list of variables which you want
to filter out. For example, you can create a list with United Kingdom, France and Germany as values in
the list. You can use this list in the rule action to get the same result set. For example, if you create a list
called COUNTRY_LIST, you can use the list as follows:

filter on ('SCOUNTRY LIST', 'country.src', 'false');
filter out (string filter, string field)
filter out (string filter, string field, bool matchExact)

filter out removes the values that contain the filter criteria from the result set. If the result set contains
multiple fields, you must select a specific field to which the filter is applied (for example, you can use
a lookup and add to add results to a single result set).

The matchExact parameter determines if the match is an exact match or contains a match.
o If matchExact is set to false, any value that contains the filter text is considered a match.

o If matchExact is set to true, only values that match the provided filter text is excluded from the result
set.

Note: Unless the matchExact parameter is specified, the default behavior of the rule action is to
match exactly the text specified in the filter parameter. To specify that results containing the filter text
must be removed from the result set, users must set the matchExact parameter to false.

Example:

The following figure displays the list of countries and their event count.
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Test Rule
Data S 02 0 : 02
258 2ource 2015 4 01:00 Rule without Filter_Out 2015 4 03:00
204.371-Conc hd
Format Source Country Total ewents count A
Tabular hd 1 united states 15105
Time Range 2 china 1174
Range hd
3 united Kingdom 381
From
02/10/15 01:00:00 4 362
To 5 344
02/10/15 03:00:00 6 poland 318
7 france 8
2 germany 253
] korea, republic 203
10 braz 200
11 ita 198
12 170
13 162
14 160
W
1c P e

The following figure shows the filter out rule action to remove the event count for Spain, China, United

States and United Kingdom from the result set.
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Build Rule

Rule Typ MetWitness Platform DB
Marne Rule with Filter_Out_True
Summarize Event Count -
Select COUMNEry.Src

Alias Country Source

Where COUNTry.Sre exists

Group By COUNTry.sre

filter_on ("spain,china,united kingdom', country.src’);

Enter a then clauss..

! 3
Qrder 2y Column Name Sort By

Total Descending

200 a

Save Reset Test Rule

The following figure shows the output with the filter out rule action.
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Sourc o1 . A . 02 o
stz Source 2018  ,, 00:00:00 Rule with Filter_Qut_True 2018 ,; 235959
#dmin- Concentrator L

Country Source Total events count

Format

1 china 323101
Tabular il

2 spain B4843
Time Range
— 3 united kingdom 58383

ast v

2 & Months =

¥ Use relative time calculation

lookup and add (string select, string field)
lookup and add (string select, string field, int limit)
lookup and add (string select, string field, int limit, boolean inherit)

lookup and add (string select, string field, int limit, boolean inherit,
string extraWhere)

lookup and add(string select, string field, int limit, boolean inherit, string
extraWhere, boolean aggregate)

This rule action iterates through a list of values in a result set and lookup additional meta data to further
describe the relationships between various elements in a result set.

Note: The lookup and add rule action can be used only with an aggregate rule.

The first parameter, select, designates the type of meta data that must be added to elements of the result
set. The second parameter, field, specifies where in the result set the append must apply to. Also, a limit
can be applied to avoid crowding the result set with a large result set.

By default, subsequent queries to the SDK will inherit the where clause of the parent rule. To use a
unique where clause, you can specify a boolean value in the fourth parameter as false and in the
fifth parameter you can specify a different where clause.

Note: If you are using a unique where clause in your query, make sure that you use a single quote (')
for enclosing arguments and double quotes (") for string values.

Now, with the addition of Custom summarization and Group By feature, the result can be achieved
even without having lookup and add rule action. The new rule syntax with groupby displays the result in
a flat structure which is better than the earlier rule syntax without groupby Hence it is recommended to
manually edit/update rules with lookup and add rule action and use groupby clause wherever it is
applicable.
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Note: Lookup And Add rule action is supported only if the SELECT clause has one meta and
aggregate function.

For example, see below scenarios: In Example 2a, lookup and add rule action is used. Instead of using
lookup and add rule action, the same result can be achieved by using Custom summarization and
Group By feature. See Example 2b below.

But, lookup and add rule action is still supported for NWDB rules on the following conditions:
o All versions of NWDB rules with Summarization as Event Count, Packet Count, or Session Size.

o For Custom summarization, the lookup and add rule must have only one group by meta with only one
aggregate function where the aggregate function must be either sum() or count().

Note: It is not supported for “Summarize-None”.

For example, lookup and add rule action can be used for the following rules:
« select ip.src, sum(size) group by ip.src

« select ip.src, count(filename) group by ip.src

It cannot be used for the following rules:
o select ip.src, sum(size),count(filename) group by ip.src
o select ip.src, sum(size),avg(size) group by ip.src

« select ip.src,ip.dst count(filename) group by ip.src,ip.dst

Examples:
1. lookup_and_add('ip.dst','ip.src’, 2);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src.

The following figure shows the rule definition.
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Build Rule
Rule Type
Mamse

Summarize

Group By

Metwitness Platform DS

Lookup and add
Ewent Count
ipsrc

Source |? Address

Tervice exists

ipsrc

Enter a then clauss..

Column Hame

Total

Save Reset

leokup_and_add{'ip.dst’.’ip.src’.2);

Sort By

Ascending

L4

iy

Test Rule

The following figure shows the result set containing the source IP addresses and the top two destination

IP addresses with each ip.src.
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Data Sourc 01 A 03 ol A
- = 2018 10:12:00 Lookup and add 2018 10:11:59
02 02
Adrmin- Concenirator -
Sowrce P Address Total events count =
Farmat
1.ip.src 1
Tabular bl
1.ip.dst 1
Time Range
- . 2.ip.src 1
1.ip.dsz 1
2 -+ Manths
3. ip.sre 1
v Use relative time calculation )
1.ip.dst 1
1.ip.dst 1
E. ip.sre 1
1. ip.dss 1
E. ip.sre 1
1.ip.dst 1
7.ip=rc 1
1.ip.dst 1
. IpERC

2a. lookup and_add('ip.dst','ip.src’, 2); lookup _and_add('service','ip.src', 3);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src and the top three ports used by each ip.src.

The following figure shows the rule definition.
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Suild Rule
Rule Type
Mama

Summarize

NetWitness Platform D8
Lookup and add2

Bwent Count -
D.ErC

Source P Address

senice exists &b ip.src exists

0.5

r
ookup and addlip.dst,ip.snc, 20
r

lookup and add("service',ip.dst’ 2):

CrLer a then clauss...

Column Name

Total

1 e

20 -

Save Rezat Test Rule

Sart By

Descending

The following figure shows the result set containing the source IP addresses and the top two destination

IP addresses with each ip.src and the top three ports used by each ip.src.
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Saure o1 e 03 0
Jata Sourcs 2018 5, 10:21:00 Lookup and add? 2018 . 10:20:59
Admin- Concentrator L4
Source IP Address Total events count
Format
1. ipsrc JE383
Tabular b4
1. ip.dst 27
Time Range
— 1. zervice OTHER 25
ast -
2 ip.dst 26
2 5 Months =
1. service OTHER 25
¥ Use relative time calculation
2 ipsrc 26810
1. zervice OTHER 234
2. =zervice HTTE 191
2 ipdst E1%
1. service HTTF 57
2. service OTHER a9
3. ip.src 25325
1. ip.dst 2250
1. service HTTF s

Close

You can make the query as complex as you want by selecting different fields in the result set and by
appending to different parts. For example, you may want to know what files each source IP had

touched. However, because the parent rule has a WHERE clause of service = 6667 and the default
behavior of this rule action is to append to the original WHERE clause, it becomes necessary to override
the parent WHERE clause. The easiest way to understand this concept is to look at the previous lookup
and_add call lookup and add('ip.dst','ip.src',2). The actual query that is sent to the server is

SELECT ip.dst WHERE service = 6667 &&ip.src = 206.42.199.194. In order to force the WHERE
clause to override the service = 6667 portion of the WHERE clause (inherited from the parent rule), the
user can specify a 4th parameter of false as shown in example 3.

2b. Without Lookup_and_add Rule
This rule uses the Custom summarization and Group By feature to sort the results.

The following figure shows the rule definition.
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Zuild Bule

Rule Type MetWitness Platform DB
Name Wiithout LA

Summarize Custem -

D=L, ip.dst. service, countsessionid)

Aliaz Source P Address

‘Where service exists & ip.src exists

Group By p.=re,ip.dst senvice

:I-F'E"' CrLer a then clausa...

_-C"dEI'E'-}' Column Hame Zarz By

r r

count{sessionid) Descending
CrLer the colurmn name, Asgarudarn s

(]
L

(=]
=]
L8

“ Save Rezer Test Rule

The following figure shows the result set containing the source IP addresses and the top two destination
IP addresses with each ip.src and the top three ports used by each ip.src.
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Test Rule

Data 5 01 - 03
# soures 2018 ,, 10:41:00 Without LUA 2018 ,; 10:40:59
Admin- Concentrator bt
Source [P Address Destination |P Address Service Type countisessionid)
Format
1 SEL 13942
Tabular -
2 HTTP 10619
Time Range
3 HTTP 83817
Past -
4 HTTP 4553
2 % |Months —
5 HTTP 4183
v Stive Ti slculati
Use relat ime calculation c J— 2654
: ¢ : 3452
8 OTHER 3383
9 S5L 2887
10 HTT 2848
1 HTT 2747
12 HTT 2548
13 HTTP 2538
14 OTHER 2385
15 HTTP 2374
-
16 HTTE 2787

3. lookup_and_add('filename’, 'ip.src', 2, false);

This call would issue a query to the server, like SELECT filename WHERE ip.src =

90.0.0.142 rather than SELECT filename WHERE service = 6667' && ip.src =
90.0.0.142 because you have specified the rule action to ignore the initial WHERE clause of the parent
rule.

The following figure shows the rule definition.
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Rule Type

Name

Build Rule

Metwitness Platfarm DB

Lookup and add overriding WHERE clause
Buwent Count b

p.Erc

Souwrce P Address

IEnics

p.src

lookup and add(*filename' ip.src’ 2 false);

CrLer a then clausa...
Column Hame Zoart By
"
Total Descending
~
L -
Save Rezet TesztRule

The following figure shows the result set.
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a e 01 AR~ o 03 AT
Data Sour 2018 ,, 10:48:00 Lookup and add overriding... 2018 ,; 10:47:59
Admin- Concentrator v

Source IP Address Total events count
Forrnat
1.ip.sre 26810
Tabular hd
1. filename adserver 125
Time Range
= 2, filename + adbrite_iab_iframe_url + 105
ast v
2.ip.src 25325
2 $¢ Months w
1. filename online 735
™ Use relative time calculation
2. filename bind 698
4.ip.src 23605
S.ip.src 21485
1. filename bind 43
2. filename <nones 22

The test list is in a group name netwitness, you can access that list with the following syntax.

You can even narrow down these appended results even further to only include filenames that have .gif
as filename extension by using the fifth parameter in the rule action. The fifth parameter allows you to
specify additional WHERE clause criteria. The files with .gif filename extension would be stored in
the test list within a group named DocTeamList. You can access this list with the following

syntax: threat.source = $[DocTeamList/test]

This can be referenced in the extra where clause parameter in the following manner:

4. lookup _and_add('filename’, 'ip.src’', 5, false, 'filename CONTAINS $[DocTeamList/test]');

The following figure shows the rule definition.
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Build Rule
MetWitness Platform DB

MName Infected files in network

Summarize Event Lount =

Zelect ipsrc

Alias Source |? Address

Where zervice exisis

Group By ipsrc

Then [ lookup_and_add{'filename’, “ip.src’. 5. false, "filename CONTAINS 5[DocTeamLlist/te...

Enter a then clauszs.

4
Order By Column Name Sort By
Taotal Ascending
Zeszion ~
Threshold -
Limit 10 &

Save Reset Test Rule

The following figure shows the result set.

332 Appendix



Reporting User Guide

Test Rule

e 2013 33 07:00 Infected Files In Network 2013 2 09:00
Concentrator-1 w
Format Source IP Address Total events count bt
Tabular w 1.ip.src 2115
Time Range 1.filename 207
Past hd 2.filename 13
2 & Hours o~ 3. filename 13 =
4. filename 13
5. filename 12
2.ip.src 826 R
1. filename 12
2. filename 1
3.filename .
3.ip.src 236
1. filename 24
2.filename >
3. filename 5
4. ip.src 236
1.filename 24
2. filename 2 l

5. lookup _and_add('ip.dst','ip.src', 2,true,,false);

This rule action would iterate through each ip.src in the initial result set and lookup the top two
destination IP addresses with each ip.src. The 'aggregate' parameter is set to 'false', this implies that
aggregates would be skipped for lookup values and hence the lookup query executions will complete
faster.

Note:

The default value for 'aggregate' is 'true'. When 'aggregate' is set to 'false', Reporting Engine passes
threshold=1, Sort by='value' and Order=Ascending to NWDB to make lookup queries run faster.

. You must set the 'aggregate' to false, when rule contains aggregate functions or when the rule is run
against a wide time range. This helps the rule to complete the execution faster.

The following figure shows the rule definition.
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Build Rule

tule Type

Mame

Summarize

Seszion

MetWitness Platform DB
Feturn non-aggregate values
Ewent Count -

ipsrc

Source [P address

ip.dst exists

ipsrc

leokup_and_add{'ip.dst”.ip.src’, 2.true, false);

Enter a then clauss...

Column Mame

Total

(=}
L

<>

Feset Test Rule

sort By

Descending

The following figure shows the result set.
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Dara Source 02 ol A 03 ol s
- 2018 5 05:11:00 Return non-aggregate valu... 2018 .5 05:10:59
Admin- Concentrater ¥
Source IP address Total events count =
Format |
1.ip.sre 357293
Tabular w |
Tirme Ranze o
2. ip.src 158871
Pazr w |
p.dst
2 3| Weaks v
2.ip.ds
= lative ti leulat
Use relative time calculation 2 ipare 155180
1.ip.dst
|
4 ip.src ] ed3562
p.dst
2 ip.ds
5. ip.src 60124
2.ip.dst
6. ip.sre 54135
| o cle -
|

max_ threshold (string quantity)
max threshold (string quantity, string field)

max_threshold removes any results with a quantity that is larger than the maximum threshold quantity
from a result set. The quantity can either be in terms of count or size and it is relative to the sorting
options of the parent rule. This means that if you sort a rule by size, the rule action expects you to
specify the parameter in bytes (you can append KB, MB, GB, TB to the parameter to make size
conversion easier).

max_threshold rule can also be used to filter values based on the aggregate function values. Use the
syntax based on the type of summarization used in the rule as below:

o max_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session Size.
o max_threshold(String quantity, String field): Can be used to filter values of Custom aggregates or any

metas.

Examples:
1. max_threshold(200);

The following figure shows the result without the max_threshold argument. The output results have event
counts exceeding 200.

Appendix 335



Reporting User Guide

. L ol

Data Source 2003 :: 05:30 Max_Threshold_ 2013 ,, 05:30
Conc-240 v

SL No Source IP Address Total events count i
Format
Tabular v 1 1884 =
Time Range 2 [
Past v 3 6

4
10 $ Years v B 5

5 [

-]

s

= ~d
=]
- - - R . T

[
-3

B
-]

[- -

The following figure shows a the max_threshold rule action that puts a limit of 200 bytes on the output.
Any output having more than 200 bytes of data are not listed.
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Build Rule
Rule Type
Marmsa

Surnmarize

Group By

Order By

Seszion

Metwitness Platform DB

Max Threshold

Ewvent Count -

ipsrc

Source |? address

ipsrc

Max_Thresholdi200);

Enter a then clauzs.

Column Name

Total
20 o
Save Reset

Test Rule

Sort By

Descending

The following figure shows the result when the max threshold rule action is applied. The result
numbered 1 in the above screen capture is removed from the result.
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Data Source 2003 :} 05:30 Max Threshold 2013 2.1, 05:30
Conc-240 v
5L No Source IP Address Total events count e
Format
Tabular v 1 &
Time Range 2 &
Past ~ 3 6
10 % vYears v h s
5 &
s s
7 &
8 : s
g &
10 &
1 G
12 6
13 &
14 &
15 ]
16 &
17 & il

2. max_threshold(5,count(alias.host));

The following figure shows the result without the max_threshold argument. The output results have count
of alias.host exceeding 5.

Test Rule
Data Source 01 - 02
. 2015 35 15:02 Max Threshold Initial 2015 gz 15:02
204.31-Conc A
L Source
Format Source IP Address Source Country cDestlnatlon Destination IP address User cull.mlh .
Tabular - oumntry Account {alias. host)
Time Range 1 United States United States 615
past - 2 United States 424
2 3 Weesks v 3 United States 342
EUse relative time calculation 4 United States 318
2 United States 250
Run Test
6 United States United States 222
7 United States United States 220
& United States United States 217
9 United Stat United States 21
10 United States United States 21
11 United States United States 183
12 United States United States 184
13 United States 166
W
14 United States 104
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The following figure shows a the max_threshold rule action that puts a limit of 5 on the output. Any
output having value more than 5 is not listed.

Build Rule
Rule Type MNetWitness Platform DB
Narme Max Threshold Count Alias Host
Summarize Custom =
Select ipsrc, country.src, country.dst, ip.dst, user.src, count{alias.hosg)
Alias Source P address
Where ipsTC exists
Group By ipsrc,country_src,country.dst,ip.dst user.src
ThE'I'I Max_Threshold(5.count(alias.host]);
Enter 3 ther clauzs...
4 3
DrderE_,r Column Name -~ Sart By
countialias.host) Descending
Enter the column name... Aszcending
S=Ehn 0 -
Threshold : B
Sl R <
Save Reset Test Rule

The following figure shows the result when the max_threshold rule action is applied. Any output having
value more than 5 is removed from the result.
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Saure 03 - 03
Data Saurce 2016 ,; 05:31:00 Max Threshold Count Alias... 2018 ,; 05:30:59
Admin- Concentrator e
- Source IP address Source Country e Destination [P Address | 0UrCEUSET o dalias host)
Farmat Country Account
Tabular i 1 United States ]
Time Range
Dast w | 2 _'_:_:_E_' Unitad States -1
2 o Years w 3 United States 5
¥ Use relacive time calculation
4 ndia United States 5
5 - e S s
] ____;'_ United States 5
7 United States 5
g - United State: 5
3 ] 5
10 @i 00 United s -

min_threshold (string quantity)

min_threshold removes results with a quantity that is smaller than the minimum threshold quantity from a
result set. The quantity can either be in terms of count or size and it is relative to the sorting options of
the parent rule. This means that if you sort a rule by size, the rule action expects you to specify the
parameter in bytes (you can append KB, MB, GB, TB to the parameter to make size conversion easier).

min_threshold rule can also be used to filter values based on the aggregate function values. Use the
syntax based on the type of summarization used in the rule as below:

o min_threshold(String quantity): Can be used to filter Event Count, Packet Count, and Session Size.
o min_threshold(String quantity, String field): Can be used to filter values of Custom aggregates or any

metas.

Examples:
1. min_threshold(200);
The following figure shows a sample of the min_threshold query.
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Build Rule

Rule Type Metwitness Platform DB

Mams Min Threshold

Summarize Event Lount -

Selec ipsrc

Alias Source |? address

Where

Group By ipare

Then Min_Threshol d(200);
Enter a ther clauzs..
4 ]

I:IrderE_,-' Column Name ~ sort By
Tatal Aszcending
20 &

Save Reset Test Rule

The above figure puts a limit of 200 bytes on the output. Any output having less than 200 bytes of data is
not listed. The output with the min_threshold rule action is applied.
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Test Rule

B:“Sj“;“ 2003 g; 05:30 Min_Threshold 2013 g, 05:30
onc-240 v
SL Ne Source IP Address Total events count
Format
Tabular v 1 1884
Time Range
Past ol
0 3| Years w

As shown, all the values are greater than 200 bytes.
2. min_threshold(100,count(alias.host));

The following figure shows the result without the min_threshold argument. The output results have count
of alias.host below 100.

Test Rule
Data Source 0 . q e 02
- 2015 ., 16:06 Min Threshold Initial 2015 47 16:06
204.31-Conc w
Destination B count
Format Source IP Address Source Country Destination IP address User " A
Tabular b EuuBiEY Account jallaahicat]
Time Range 1 United States United States 1
Fast - 2 United States United States 1
2 % Wesks v 3 United States United States 1
[ Use relative time calculation 4 United States United States 3
5 United States United States 3
Run Test
] United Stat United States 4
7 United States United States 4
8 United States United States 4
9 United States United States 4
10 Un Jnited States 4
11 United States United States 4
12 United States United States 4
13 United States United States 4
W
14 United States United States 4
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The following figure shows a the min_threshold rule action that sets the minimum limit of 100 on the
output. Any output having data less than 100 is not listed.

Build Rule
Rule Type NetWitnazs Platfarm DB
MNarme Min Threshold Count Alias Host
SlaEs Custom =
Select ip.src, country.src, country.dst, ip.dst, user.src, count{alias.host)
Alias Source P address
‘Where ipsrc exists
Group By ipsrc,country_src,country.dst,ip.dsc user.src
Then Min_Threshold(5.count(alias. hostl):
Enter a then clauzs...
4 3
Qrder By Column Name sort By
counti{alias.host) Descending
Enter the column name... Azcending
Session - -
100000 o
Save Reset Test Rule

The following figure shows the result when the min_threshold rule action is applied. Any output having
data less than 100 is removed from the result.
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Sourc 03 2. : A 03 .
Data Source 2016 ,; 05:36:00 Min Threshold Count Alias... 2018 ,; 05:35:59
Admin- Concentrator -

Destination L
Farmat Source |P address Source Country P Destination IP Address  User count{alias_ host)
¥ Account
Tabular -
1 G7EEE
Time Range
2 28872
Past b
3 21ed2
= S| |Years - 4 United States United States 21238
# Use relative time calculation 5 United States United States 20464
g 18045
7 United States United States 11664
2 10827
9 10827
10 8336
" 2386
12 8052
13 JTES
14 7658
-

regex (string regex, string field)

The regex rule action applies regular expression to the result set. The following is the format of the
regex rule action:

regex(regular_expression, meta _name)
Where:

o regular expression - Regular expression to match the value of the meta.

o meta name - Meta or field name on which the regex has to be applied.
For a comprehensive list of supported regex patterns, refer to
http://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html.
Sample regex rule action:

If you want to list filenames of all the PNG and JPEG format files from various sessions, you can write
a rule with the following regex rule action:

regex(".+.(pngljpg)", filename);
The following figure shows the rule.
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Build Rule
Rule Type
Mame

Summarize

Group By

Session

MetWitness Platform DE
Feg Exprezzion
Ewvent Count -
filename

File Name

filename

regex|{”.+.(png|jpg)”. filename);

Enter a then clauss..

Column Mame ~

Total
20 o
Save Reset Test Rule

Sort By

Descending

The output with the regex rule action applied is shown in the following figure.

Appendix

345



Reporting User Guide

Test Rule

fasa Source 2003 g; 05:30 Reg Exp 2013 g, 05:30
onc-Zal v
Format SLNo Filename :::::t S
Tabular b
1 0.jpg 2
Time R
1me fange 2 0000050574_000000000000000546126,jpg 2
Past ~ 1P5
3 01-28-2008_18month3no_widgetjpg 2
10 ¢ |vears ~ 4 2
5 010211010301011610200802122 7.pg 2
[} 01440gk04eljpg 2

lose
Close

sum_count ()

Totals the quantifiers for a given result set. For example, calling a sum_count() for a rule that is sorted
by event count totals the size of all values in the result set and displays the total in place of the result set.

Example:

The following figure shows the sum_count() rule action.
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Build Rule

NetWitness Platform DB

Name Sum fields

Summarize  Event Count v

Select country.src

Alias Sum

Where country.src = 'United States','China’,'Canada’
Group By country.src

Then sum_count():

Enter a then clause...

OrderBy Column Name Sort By
Total Descending
Session 0 2

]
o
<>

Use Save Reset Test Rule
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With sum_count() rule action, the output shows the total size of all the event counts.

Data Source

#dmin- Concentrator i
Format

Tabular w
Time Range

Past L

2 o Years w

"‘_ IUze relative time calculztion

2016

i3 05:50:00 Sum fields 2018 7 05:49:59

Total Session_count of counory.src 2330415

Total events count

sum values ()

Totals the number of values for a given result set. Use this action to display how many matches exists

for a given rule.

Example:

The following figure shows the sum_ values() rule action.
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Build Rule

Rule Type

Mame

Summarize

Session

Use

MetWitness Platform DB

Sum Values

Event Count i

Country.src

Values

Country.src

sum_values{);

Enter a then clause...

Column Mame

Total

L4

Lave Reset Test Rule

Sort By
Descending

The following figure shows the result with sum_values rule action.
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Data Source 2016 i 05:54:00 Sum Values 2018 93 05:53:59
Admin- Concentrator -
Mo of unigue country.src values
Format .
1 178
Tabular -
Time Range

Past v
bl

2 & Years v

[+ Use relative time calculation

show_whats_new()

The show_whats new() rule action takes any result in a result set and filters out any value that is
available in the NetWitness meta database prior to the time frame of the currently running report. When
a report runs, NetWitness Platform determines the ID of the first session in the time range of the report.
If a value in a result set has a first session id that is greater than the first session id of the report time
frame, it did not exist in the NetWitness meta database prior to the report being run and so is new to the
NetWitness system relative to the time frame of the report.

The show_whats new() rule action is also supported for Custom Aggregate Rule. When multiple meta's
are selected in the Custom rule, the first meta is considered for filtering out the old values. See
"Example 2" below to understand how this rule action is used for Custom Aggregate Rule.

Note: The show whats new() rule action can be used only with an aggregate rule.

Examples:
1. show_whats_new() for aggregate rule with Event Count

In the following example, all the Source IP Addresses available for the past two weeks are listed.
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Test Rule

Data Source

204.31-Conc A
Format
Tabular A

Time Range

Past w

2 5 Wesks v

[¥ Use relative time calculation

2015

0
27

12:12:59

Source IP Address

WO_SWN

2015 55

Total events count
58554
12073
5048
2298
2238
1770
1705
1654
1457
1408

1112

12:12:59

The following figure shows the use of the show_whats new rule action to list only the new entries for

the past two weeks.
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Build Rule

Rule Type NetWitness Platform DB
Name ShowwWhatsMew
summarize svent Count ™
Select ip.=re

Alias Values

Where

ipsrc

r

show whats_new():

Enter a then clause...

Column Name Sort By
Total Descending
1 -
200 -

Use Save Reset Test Rule

The following figure lists the new entries for the past two weeks.

352 Appendix



Reporting User Guide

ata Source

Admin- Concentrator b
Format

Tabular ~
Time Range

Pazt -

P -~ A, -
‘ o IWEEKE -

W Uze relative time calculation

2018

13

14

15

18

0z
19

05:56:00

Values

ShowWhatsNew

2018 g. 05:55:59

Total events count

26810

5820
5760
g3z
5606
5329

AR

2. show_whats new() for Custom aggregate rule

In the following example, all the Source IP Addresses available for the past two weeks are listed.

Data Source

204.31-Conc b
Format

Tabular hd
Time Range

Past hd

2 % Weeks v

[ Use relative time calculation

2015

0
27

12:27:35

Source IP Address

WO_SWN_aggregate

2015 {5 12:27:35

sum{size) s

The following figure shows the use of the show_whats new rule action to list only the new entries for

the past two weeks.
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Build Rule

Aule Type MetWitness Platform DB
Mame SWh_aggregate
summarize Custom “
Select ip.src, sum(size)
Alias Source P Address
Where ip.src exists
Group By ip.src

r
Then show whats_new();

Enzer a then clause...

Order By Column Mame Sort By
F F
ip-src Descending
Encer the column name... Azcending
Zeszion o s
Threshold
Limit 2000 -
Use Save Reset Test Rule

The following figure lists the new entries of Source IP Addresses for the past two weeks.
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Data Source 02

0z

2015 o5 10:41 ShowWhatsNew 2015 15 10:41
10.31.126.151 - Concentra ¥
Format Source IP Address sum{size) s
Tabular hd 1 1788
Time Range z 1788
Past hd
3 1632
2 0 Days ¥ 4 1788
[¥f Use relative time calculation 5 261084
T 596
& 66284
] 764
10 57904
11 49436
12 395565
13 4176
14 764
b
1c —ea

The power of this feature is that it doesn't matter when the report is run in identifying values that are
new to NetWitness. The caveat with this feature is that if a data reset occurs, you will lose your data.
However, it is easy to baseline a system and identify changes and new items without a tremendous
amount of strain on the system (depending on the size of your result set).

Supported Rule Operators

The NWDB Reporting Engine data source rule syntax supports a subset of rule operators that are
supported by NetWitness Platform.

* Use an asterisk (*) as the sole operator in a rule to select all traffic.

= Equals operator

1= Does not equal operator

&& Logical AND operator

I Logical OR operator

-u Upper boundary. For example, tcp.port = 40000-u selects all TCP ports above 40000.
= Lower boundary. For example, tep.port =1-40000 selects all TCP ports below 40000.

- The dash (-) operator only applies to numeric values. Separate the lower and upper
boundaries of the range with a dash (-). For example, tep.port = 25-443 selects all TCP
ports between 25 and 443.
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Respond Rule Syntax

The supported rule syntax for the Respond service through descriptions and examples of supported and
unsupported syntax. There is a finite set of syntax that you can use to construct rules for reports using the
Respond service in this release.

The Reporting Engine supports the following categories of Respond data source rule syntax:
o select clause
o Non-Aggregate Rule
o Aggregate Rule
o alias
o where clause
o where clause Operators
o Group By
e Order By
o Limit field

Note: List is not supported in Respond Data source rules.

Select Clause

The select clause is a comma separated list of values. For example: select alert.severity, alert.name,
count(*).

There are two types of select clause for Respond Rule:

o Non-aggregate rule
o Aggregate rule

Non-Aggregate Rule

When you want to define a rule without any grouping, choose 'None' in the Summarize field. In a non-
aggregate rule, you can select any number of metas in the Select clause. For example, select
alert.severity, alert.name.

Aggregate Rule

When you want to query for a specific meta and its associated aggregate value then you must use the
Aggregate rule. To get an aggregate, you must choose 'Custom' in the Summarize field to include an
aggregate function in the Select clause. For example, select alert.severity, alert.name, count(*).

The following figure shows the Build Rule view for Aggregate Rule.
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Build Rule

Rule Type

Respond DB

TestScreenshot

alert.name, alert.zeverity. count{alerc.name)

alert.name="Brute Force Login From

Column Mame

Enter the column name.._

Lave Reset Test Rule

Same Source"

Sort By

Azcending

Supported Aggregate Functions

The rules on Respond service supports the following aggregate functions and syntax.

e count
e Mmax
e min
e Sum

e avg
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Note: The aggregate functions must be added in the end of a select clause for aggregate query. For
example, alert.name, alert.severity, sum(alert.numEvents). By default, a maximum of 10,000 rows
results are fetched and this can be configured using the rsa.response.query.QueryProperties.

Examples of select Clause Syntax

The following table provides examples of the select Clause Syntax.

T

select Select specific metas from an Respond Data Source (Y ou must
columnl separate each column with a comma.).
,column2 column3, ... columnN

Examples of Supported Select Queries
select alert.name, alert.numEvents, count(alert.numEvents)
select alert.severity, avg(alert.severity)

select alert.timestamp, incidentCreated where alert.timestamp >= 1475658011

Summarize

Summarize determines the type of summarization or aggregation for the rule.

m Config Value

Summarize To query metas without any custom grouping, select:

o None:

To get meta based aggregates, select:

o Custom: This indicates that expected meta aggregate function is defined in rule select
clause.

Alias

Some meta names may not be descriptive, in this case description can be added in the the alias field to
make column names more readable. For example, SELECT: alert.severity, alert.name, count(*)
ALIAS: Alert Severity, Alert Name

In the alias field you can enter a name for columns used in the select clause. If you do not specify the
alias for one of the field in the select clause, then the default description will be used. For example, if
the select clause has Fieldl,Field2,Field3,Field4, and alias has only Fieldl, ,Field3,Field4, then for
Field2 a default description is used.

Where Clause

The where clause is a language field values and ranges that is used by Respond function. In the where
clause, string values have to be enclosed within single quotes.
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T

alert.host summary = For TEXT or string type data, enclose the string or text in single or double
(Primary) Link status  quote. If there is any special character such as an apostrophe within the data
"Down" on interface  then you need to add an additional single or double quotes. For example,

INTNAME.' alert.name = ’top alerts from Cote d"Ivoire'.
alert.timestamp >= For Date and Time (date/timestamp data type columns), use the
1475658011 EPOCH syntax.

Supported Where Clause Operators

= (equals) columnl = '"value'

I= (does not equal) columnl \="value'

> columnl > 'value'

>= columnl >= value'

< columnl < 'value'

<= columnl <= "value'

Group By
_
group by : alert.severity, alert.timestamp, Respond picks the metas for Group By field from the
incidentCreated selected Select clause automatically.

Note: Group by field is enabled for
Aggregate queries and are not editable.

Order By

Order By determines how to sort the result set and is not case sensitive.
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Column Name The Column Name is the name of the
columns by which you want to sort the
results. By default, the value is empty.
When you click on a column, the value

gets populated based on the Summarize
field.

o order by alert.name asc
o order by incidentCreated desc
o order by count(numEvents)

o order by status

Sort By Sort By determines the order in which
you want to sort the results such as
ascending or descending.

Note: For all queries, it is mandatory
for you to select the order by field.

Limit field

This indicates the limit to be put on the query while fetching data from the database. If a result set is
sorted by event count, packet count, or session size, the limit represents the top (or bottom) N values to
be returned. If the result set is not sorted, the first N values are returned.
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Warehouse DB Simple Rules Syntax

The section explains the simple rules query syntax and examples.

The following examples illustrate simple rules in the default mode:

All Event Categories Report

Attacks Event Categories Report

Source: China Event Categories Report

IP Source and Destination Event Categories Report
Time Threat Categories Report

Array Query Report

Raw Log Query Report

All Event Categories Report

This rule fetches all event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table, that
is, country_src for the source country, and country_dst for the destination country.

Build Rule
Rule Type Warehouze DB
Expert Mode
MName All Event Categories
Zelect country_src. country_dst
From sessions hd
Alias country_src, country_dst
Where country_src 15 NOT MULL AMD country_dst IS NOT NULL
Group By country_src, country_dst
Having
Order By Column Name Sort By
Enter the column name._. Ascending
Limit 20 2
Use Save Reset Test Rule

The following figure shows the result set of the All Event Categories rule.
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o o850

2014 o

Vo ubuwm e

| Page |1

o | 00:00

event_cat_name

All Event Categories
Generated on - 2014-09-02 09:38

Time Range

All Risk Suspicious By Destination IP / NWAPPLIANCE11244 - Decoder

country_sec

ofda | > M |

2014 2 09:00

country_ast

Displaying 1 - 15 of 50

Tuesday
September 2, 2014
< September2014 ~ o
S M T w T F S

i

Reports
Time

09:38

Attacks Event Categories Report

This rule fetches the event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table and
selecting only those columns whose event category name like 'Attacks.%'.

Build Rule
Rule Type
Expert Mode
MName

Zelect

From

Alias

Where

Group By
Having

Order By

Limnit

L]

‘Warehouse DB

Attacks Event Categories
Event_cat_name. country_src, country_dst

sessions L
event_cat_name. country_src, country_dst

event_cat_name |5 NOT MULL AND country_src |15 NOT MULL AMD country_dst 15
MOT MULL AMD event_cat_name LIKE "Attacks. 3"

event_cat_name. Country_src, oou ntr_\,-'_::l =t

Column Name

Enter the column name_

20 <

Save Reset Test Rule

The following figure shows the result set of the Attacks Event Categories rule.
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=820

2014 3 08:00

| Page |1

Attacks Event Categories

Generated on - 2014-09-02 10:29

Time Range

Attacks Event Categories /

event cat_name

of4 | > M I

RSA

country_dst

Displaying 1 - 15 of 50

0 Tuesday
September 2, 2014

< September 2014 - >

s M T W T F S

|

Reports
Time.

1023

Source: China Event Categories Report

This rule fetches the event categories, source country, and destination country from the sessions table by
defining alias names (temporary column names) for each of the fields to be fetched from the table and
selecting only those columns whose source country is 'China'.

Build Rule
Rule Type

Ezpert Made

Name
Select
From
Alias

Where

Group By
Having

Order By

Warehouse DB
1l

Source: China Event Categories
SVENt_Cat_name. country_src, country_dst
SEssions -

event_cat_name, country_src, country_dst

event_cat_name |5 NOT NULL && country_src IS5 NOT NULL && country_dst IS NOT
MULL && country_src = 'China’

event_cat_name, Country_src, CCUH:I’_‘;’_dS‘E

Column Name SortBy

Enter the column name...

&
i

ending

Sawve Reset Test Rule

The following figure shows the result set of the Source: China Event Categories rule.
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= B2 3
Event Categories - Source China
Generated on - 2014-08-11 07:05

2014 4

00:00 Time Range

Source: China Event Categories /

event_cat_name

of 1

Page 1

NETWITNESS
PLATFORM

RSA

09

2014 41

00:00

country_src

Displaying 1 - 12 of 12

IP Source and Destination Event Categories Report

This rule fetches the IP address of source and destination country from the sessions table by defining

alias names (temporary column names) for each of the fields to be fetched from the table and selecting
only those columns whose destination country is NOT NULL.

Build Rule
Rule Type Warehouse DB
Expert Mode (|
MName Destination Country By |P Source
Select ip_src, country_dst
From Sessions -
Alias ip_src, country_dst
‘Where device_class IS WULL && country_dst 15 NOT NULL
Group By country_dst, ip_src
Having
Order By Column Name Sort By
Enter the calumn name... Ascending
Lirnit =] fo-
Use Save Reset Test Rule

The following figure shows the result set of the IP Source

and Destination Event Categories rule.
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LI =]
Destination Country By IP Source .
Gener.ats:cl0n-2014-0‘3-11Oir.gr y NETWITNESS
PLATFORM
2014 53  00:00 Time Range 2014 % 00:00
Destination Countr‘y B}i IP Source /
ip_src Country_dst
a8
- | Page 1 ofa | > B | Displaying 1 - 15 of 50

Time Threat Categories Report

This rule fetches the threat category events, the time the log or event was ingested into Log
Decoder/Decoder, and the source IP addresses from the sessionstable by defining alias names
(temporary column names) for each of these fields to be fetched from the table.

Build Rule

Rule Type Warehouse DB

Ezpert Made

Mame by Time Threat Categories

Select time, threat_category, ip_src

From zessions -

Alias time, threat_category. ip_src

Where device_class |5 MULL

Group By time, threat_category. ip_src

Having

Order By Column Mame Sort By
Enter the column name... Ascending

Lirnit 20 fo-

E Sawve Reset Test Rule

The following figure shows the result set of the by Time Threat Categories rule. The time displayed in
the time field is the UNIX time (For example, 1388743446).
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Note: In the “Select” clause the syntax would be “UNIX time” to convert to UTC time in report. For
example, you can use the Epoch time converter tool to convert UNIX time (1388743446) to UTC
(Coordinated Universal Time) (1/3/2014 3:34:06 PM).

=8 =R B

Threat Categories - By Time

Generated on - 2014-00-11 07:44

2014 5} | 00:00

by Time Threat Categories /

time
16 1388743446
17 1388743446
13 1388743446
19 1388743446
20 1388743446
21 1388743446
22 1388743446
23 1388743446
24 1388743446
25 1388743446
26 1388743446
27 1386743446
28 1388743446
29 1388743446
30 1388743446

« € | Page 2 of 4 > |

Time Range

threat_category

NETWITNESS
PLATFORM

2014 o7 | 00:00

Displaying 16 - 30 of 50

Array Query Report

This rule fetches an array of alias host names from the sessions table which contains the

value 'www.google.com'.

Build Rule
Rule Type ‘Warehouse DE

Expert Mode (m

Limit 100

L%

Use Save Reset

MName arrsy_contains query
Select alias_host

From sessions -
Alias

Where array_containzalias_host,
Group By

Hawing

Order By Column Name

Enter the column name...

sort By

Ascending

Test Rule

The following figure shows the result set for querying an array from sessions.
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N -
ARRAY_CONTAINS
Genera(ed_un - 2014-09-11 07:55 N ETWITN ESS
PLATFORM
2014 5% 00:00 Time Range 2014 | 53 | 0000

array_contains query /

alias_host

| Page 1 (of7 1 > B | Displaying 1 - 15 of 100

Raw Log Query Report
Raw logs can be queried either from the logs or sessions table.

This rule uses raw_log as a meta for querying raw log from logs whose packet ID is NOT NULL.

Build Rule
Rule Type Warehouse DB
Ezpert Made
Marme raw_log - Rule
Select raw_log
From logs -
Alias
Where packetid IS NOT NULL
Group By
Having
Order By Column Mame Sort By
Enter the column name... Ascending
Limit =] fo-
Use Save Reset Test Rule

The following figure shows the result set for querying raw logs from logs.
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=8-=50

RAW_LOG FROM LOGS NETWITNESS’
Generated on - 2014-09-11 08:08 PLATFORM

2014 5 00:00

Time Range 2014 §7 | 00:00

raw_log - Rule /

This rule uses ${raw_log} as a meta for querying raw log from sessions whose source IP address is
NOT NULL.

Build Rule
Rule Type Warehouse DB
Expert Mode (|
Mame 4{raw_log}-Rule
Select ${raw_log))
From sessions -
Alias
Where ip src 15 NOT NULL
Group By
Hawing
Order By Column Name Sort By
Enter the column name... Ascending
Lirnit =] fo-
Use Sawve Reset Test Rule

The following figure shows the result set for querying raw logs from sessions.
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o B =B

$(RAW_LOG) NETWITNESS
Generated on - 2014.08-11 08:23 PLATFORM

2014 | % | o000 e T 2014 o7 | 00:00

${raw_log)-Rule /

raw_log
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Warehouse DB Advanced Rules Syntax
The section explains the advanced rules query syntax and examples.

General Syntax of an Advanced Rule

The following figure shows how to define an advanced query.

Meta
Build Rule
MNFS_LD111
Rule Type Warehouse DB
Expert Made 54 -
MName Expert-Threat Categories: By Time (Time variablz)
access_poin
Query [OROP Table IF EXISTS sessions21022012 3 N [
JCREATE External TAE — i
ROW FORMAT SERDE ‘org. 2 astian
ale
alert_id
alias_ho
alias_ip
‘|
Lists
. "default™"null"},
ing”. "null"], "default™"null7},
4= Inzert -
[ Compliance
@[] Filtering Candidate
oM ume_varianie —
ima} AND time = T = Local_Country
o] Logs
Alias Time, Threat Category, IP Source B[] Metwork Activity
@[] Per LUiser Report
E Save Reset Test Rule o
<

The following syntax is an example of an advanced query:

DROP Table IF EXISTS sessions21022014;

CREATE External TABLE sessions21022014

ROW FORMAT SERDE ‘org.apache.hadoop.hive.serde2.avro.AvroSerDe’
STORED AS INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'

OUTPUTFORMAT 'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat'

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12/2"
TBLPROPERTIES ('avro.schema.literal'="
{
"type":"record";
"name":"nextgen";
"fields":
[

{"name":"time", "type":["long", "null"], "default":"null"},

{"name":"threat category", "type":["string", "null"], "default":"null"},
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{"name":"ip src", "type":["string", "null"], "default":"null"},

{"name":"device class", "type":["string", "null"], "default":"null"}
]
"}i

set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;

select from unixtime (time), threat category, ip.src from time variable where
threat category isnotNULL and time >= ${report starttime} and time <= ${report
endtime};

Note: Reporting Engine treats a line beginning with <hyphen> <hyphen> as a comment in Expert
Warehouse Rule.
For example,
set mapred.input.dir.recursive=true;
-- This is an Expert comment
set hive.mapred.supports.subdirectories=true;

The general syntax of an advanced query is as explained below:

1. Drop and create an external table, and then format the row:
Firstly, we drop the table, if the table already exists and create an external table sessions21022014
DROP TABLE IF EXISTS sessions21022014
CREATE EXTERNAL TABLE sessions21022014

Note: You must create an external table only if you are using an other table. For example, if you
are using an other table apart from sessions21022014 then you must drop the table and create an
external table.

Then, specify the row format as Avro.SerDe interface to instruct HIVE as to how a record is to be
processed. Avro.SerDe allows you to read or write Avro data as HIVE tables and store them as input

format and output format.
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.Avro.SerDe'

STORED AS INPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'

OUTPUTFORMAT 'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat'

2. Specify the HDFS location:

Secondly, you must specify the HDFS location '/RSA/rsasoc/v1/sessions/data/2013/12/2' from where
the data is queried before executing the HIVE statements. The location parameter specifies the data
to be fetched depending on the date input provided. This is a variable parameter hence you can fetch
values depending on the date entered.

3. Define the table schema:
Thirdly, you define the table schema by defining columns with a specific data type and default value
as 'null'.
TBLPROPERTIES ('avro.schema.literal'="
{"type":"record";

"name" :"nextgen";

"fields":

[

{"name":"ip src", "type":["string", "null"], "default":"null"}
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]
"}
4. Import data from directory which contains sub directories:
Then, you must enable HIVE to recursively scan all sub-directories and fetch all the data from all

sub-directories.
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;

5. Fetch data from the HIVE table:
Once you execute all the above statements, you can query the database with the HIVE
query select clause to fetch the data from the HIVE table.

The following examples illustrate advanced rules in the expert mode:
o Hourly, daily, weekly, and monthly report

o Table partition based on location report

« Join logs and sessions based on unique_id report

« List report

o Parameterized report

o Partition based table with multiple locations

o Automated partition using custom function (10.5.1 onwards)

Hourly, Daily, Weekly, and Monthly Report

In these example rules, you can create various reports for December 02, 2013 (as in the below figure).
The date variable in the LOCATION statement can be altered, depending on which you can
create an hourly, daily, weekly, and monthly report.

Hourly Report

In this example rule, you can create an houly report for December 02, 2013. The LOCATION statement
can be altered to generate an hourly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12/2' - the date input (2013/12/2) indicates
year/month/day. The entire data for 02 December, 2013 is retrieved using this location statement.
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Schedule Report

Enable [+

Report Mame All Event Categories
Schedule Mame |Hourly Repart

Warehouse DB | MFS_LD111

Run Hourly

On Past

Variables Mo wariables defined
) Oulpul Actiods

) Loge

Previous Schedule Reset

| A Minute a

w2 % |Hours

% Configure

w |

] Use relative tima calculation

The result set of this query would be an hourly report.

Daily Report

In this example rule, you can create a daily report for December 2013. The LOCATION statement can
be altered to generate a daily report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12' - the date input (2013/12) indicates year/month.

The entire data for December, 2013 is retrieved using this location statement.

Schedule Report
Eniable W

Repart Wame All Event Categories

Schedule Mame | Daily Report

Warehouse DB | MF5_LD111

Run Daily

On Past

Variables Mo wariables defined
) Oulpul Actiods

s LOgd

Previous Schedule Reset

4+ Configure

W

[[] Use relative time calculation

The resultset of this query would be a daily report.

Weekly Report

In this example rule, you can create a weekly report for December 2013. The LOCATION statement
can be altered to generate a weekly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013/12' - the date input (2013/12) indicates year/month.

The entire data for December, 2013 is retrieved using this location statement.
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Schedule Report

Enable =4
Repart Wame AllEventCategoriss

Schedule Mame | Weekly Report

Warehouse DB |MFS_LD111 -
Run Weekly w AT -
[ Sunday [ Monday [ Tuesday [ Wednesday
[] Thursday [ Friday [] Saturday
On Past ~| |2 2 Hours | w| [ Use relative time calculation
Variables Mo wariables defined
) Output Adtions

T

Previous m Reset | |&F Configure

The result set of this query would be a weekly report.

) Lo

Monthly Report

In this example rule, you can create a monthly report for the year 2013. The LOCATION statement can
be altered to generate a monthly report.

LOCATION '/RSA/rsasoc/vl/sessions/data/2013' - the date input (2013) indicates year. The entire
data for the year 2013 is retrieved using this location statement.

Schedule Report

Enable =4
Repart Wame AllEventCategories

Schedule Mame | Monthly Report

Warehouse DB | MF5_LD111 -
Run Monthly «| Day |1 & At (12:30 b4
On Past v |2 & |Hours |w| ™ Use relative tima calculation
Variables Mo warizbles defined
) Dutput Actions
'\-r Logao

T

Previous Schedule Reset | & Configure

The result set of this query would be a monthly report.

For more information on LOCATION definition, see Specify the HDFS location in the "General
Syntax of an Advanced Rule" section.

You must perform the following steps in sequence to view the resultset of an advanced rule:

1. Define an Advanced Rule

2. Add an advanced rule to a Report
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3. Schedule a Report
4. View a scheduled Report

The following figure shows how to define an advanced rule.

Meta
Build Rule
< 1 w
Warehouse DB NESLD1
Expert Mode W Filte x
Mame Expert-Threat Categories: By Time (Time variable) a5 -
Query N access_point |:|
B accesses
action
alert
alert_id
alias_host
. -
alias_ip
4 3
1. "default™:"rull"}, Lists
ring”, "null"]. "default™"null"}, X
null"], "default""null"},
["string™. "null"]. "default":"null"} 45 Insert & oome
] Compliance a
rom time_variable where 0[] Filtering Candidate
tarttime} AND time <= o
e £ Local_Country
Alias Time, Threat Category, IP Source ag Logs
8] Network Adctivity
Use Save Reset Test Rule &[] Per User Report
[} -
< ’
The following figure shows how to add an advanced rule to a report (For
example, AllEventCategories).
AllEventCategories RSA NETWITHESS Text m
Header 1 H1
=} Expert-Threat Categories: By Time (Time variable) Tabular ~ €] T H2
Header 3 H3
Heater 4

Table of Contents

Body Text E

Comment ==

Schedule Save

The following figure shows how to schedule a daily report.
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Schedule Report

Enable [+
Report Mame All Event Categories

Schedule Mame |Daily Repart

Warehouse DB | MFS_LD111 -
Fun Daily «| Ar (1230 b4
On Past | |2 &|Hours |w| [ Use relative time calculation
Wariables Mo wariables defined
) Output Actions

w) Loge

Frevious Schedule Reset | 4% Configure

If you want to generate a report for a specific time range, you need to manually define the time range in
the query using the following two variables:

S{report starttime} - The starting time of the range in seconds.
S{report endtime} - The ending time of the range in seconds.

For example, SELECT from unixtime (time), threat category, ip.src FROM time
variable WHERE threat category is not NULL AND time >= ${report starttime}
AND time <= ${report endtime};

The following figure shows the result set of scheduling a daily report.

=80 5B

Expert-Threat Categories (By Time) NETWITNESS

Generated on - 2014-09-11 11:10 PLATFORM
2014 {3 00:00 Time Range 2014 % 00:00

Expert-Threat Categories: By Time (Time variable) /

Time

malware

8 malware
El malware
o malware

malware

12 malware
13 malware
malware

= malware

Table Partition Based on Location Report

In this example rule, you can create a table partition based on location. Each table can have one or more
partition keys which determines how the data is stored. For example, a country dst of type STRING and
an ip_src of type STRING. Each unique value of the partition keys defines a partition of the table.

In the example provided, we execute a HIVE query to fetch destination country and IP address of source
from the sessions05032014 table and group the result set by these fields.
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This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see "General Syntax of an Advanced
Rule" section.

. WMeta
Build Rule
MF5_LD111 -
Rule Type Warehouse DB
F b 4
Expert Mode [
05 .
Mame Expert - Group By Destination Country .
access_point |:|
Query DROP Table IF EXISTS zessi SCCESSES
CREATE External TABLE :
ROW FORMAT 5 actian
alert
alert_id
alias_host
alias_ip v
4 3
"fields": .
[ Lists
{"name™"ip_src", "type":["string”. "null"]. "default":"null"}, N
{"name™:"country_dst", "type":["string", "null"], "default™:"null"} — x
1 =
T 42 Insart = o8 - 3=
select country_dst, ip_src from sessi ~ i
country_dst is not null group by country @[] Compliance -
algF Itering Candidate
i Local_Country

@ Jlogs

8 [ Network Activity

&[] Par User Report
ﬂ Save Reset Test Rule
O -

4 | »

Alias

The following figure shows the result set of creating a table partition based on location report.

o B =B

Destination Country By IP Sourcel NETWITNESS'
Generated on - 2014.08-11 11:27 PLATFORM

2014 %% 09:00 Time Range 2014 % 11:00

Expert - Group By Destination Country /

ip_sre

s 0 BN YA W N -

| Page 1 ofd | >» P | Displaying 1 - 15 of 50
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Join Logs and Sessions Based on unique_id Report

In this example rule, you can create a rule to join logs and sessions table to fetch unique_id, IP address

of source and destination, and packet ID based on unique id.

In the example provided, we execute a HIVE query to fetch certain fields from both the sessions_table

and logs_table by performing a join based on the 'unique id' field.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query

returned a result set. For more information on these statements, see the ""General Syntax of an

Advanced Rule" section.

. Meta
Build Rule
MFS_LDT11 -
Rule Type Warehouse DB
F X
Expert Mode I
as -
Mame ExpertRule-Join .
access_point |:
Query DROP Table IF EXISTS acCesses
CREATE External TAELE 5 .
ROW FORMAT wroSerDe’ asten
STORED AS | alert
alert_id
alias_host
- -
alias_ip
4 3
Lists
Fi te X
42 Insert & fo g - 3=
8 [] Compliance s
select s.unique_id. 5.ip_sr ist, s.packetid from sessions_table s join logs_table | 8 [ Filtering Candidate
M (s.unique_id = lL.unique_id) LIMIT 50; —
= Local_Country
L] 3
B Logs
Alias B[] Matwark Activity
&[] Per tser Report
m Save Reset Test Rule o -
4 | | »

The following figure shows the result set of joining logs and sessions table based on unique id.
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=80-=0

E rtRule-Joi
e v NETWITNESS'
PLATFORM

2014 9% 22:00 Time Range 2014 % 11:00

ExpertRule-Join /

unique_id ip_sre ip_dst packetid
1 000000B285041EE20000511A0000536E 78970880
2 000001B2DC0421E2000051 1AQ00053BE B1526784
3 0000028280041BE2000051 1A0000538E 76343440
a 00000982C2041FE20000511A000053BE 79822848
s 00000AB2670418E20000511A0000538E 73859072
-] 00000CB2F70423E20000511A000053BE B3296256
7 00000EB25A0417E20000511A0000538E 73007104
a8 0000128286041 EE20000511AD00053BE 79036416
a 000018B28E041BE20000511A0000538E 76414976
10 00001AB298041CE2000051 1A000053BE 77266042
1" 00001AB2DD0421E20000511A0000538E 81592320
12 00001CB2C3041FE20000511AD0005IBE 7eaassaa
2 00001CB2FE0423E20000511A0000S2BE 83361792
14 000022825B0417E20000511A0000538E 73072640
15 000024B2010420E20000511A000053BE 80805888

| Page |1 ofa 1 > | Displaying 1 - 150f £

List Report

In this example rule, you can create a List report to fetch IP address of source and destination, and
device type from the lists_test table where device type is not null and IP address of source is fetched
from the appropriate event list.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see the "General Syntax of an Advanced
Rule" section.

. Meta
Build Rule
MFS_LD111 -
Rulz Type Warehouss DE
Fi te X
Expert Mode =
05 -
Mame Expert Rule - Lists )
access_point |:|
Query DROP Table IF EXISTS lists_test; accesses
CREATE External TAELE lists_test )
ROW FORMAT SERDE ‘org.apa acten
alert
alert_id
alias_host
. -
alias_ip
4 3
"fields": i
[ Lists
{"name""j ", "rype"["string”, "null"], "default":"null"}, [ [
{"name "ty tring”, "null"], "default":"null"}, -
' "Mdevice_type". "type™["string”. "null"], "default":"null” =
i{ name""device_type", "type":["string”. "null"], "default":"null"} 3= Insert = oo
E . h . o] Compliance e
@[] Filtering Candidate
= test where device_type |5 MOT NULL AMD -
LIMIT 5; #= Local_Country
B Logs
Alias |II-'f Source, IP Dastinatiorl B Metwork Activity
&[] Per User Report
Use Save Reset Test Rule )
-
4 | v
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The following figure shows the result set of executing a list report.

o8- =2

ExpertRule-Lists

2014 {3  00:00

ExpertRule-Lists /

nmp wnN =

Generated on - 2014-00-11 12201

of 1

Time Range

IP Destination

NETWITNESS
PLATFORM

2014 | §] 00:00

Country Source
netscreean
netscrean
netscreen
netscreen

netscreen

Displaying 1 -5 of 5

Parameterized Report

In this example rule, you can create a rule to fetch IP addresses of source and destination, and device

type from the runtime_variable table based on the specified run time

variable $ {EnterIPDestination}. At run time, you are prompted to enter a value for the IP address
of destination ip_dst. Based on the value entered, the result set is displayed.

This rule provides information about the table created, row formatted, location (directory path) for avro
data files in Warehouse, and returns a result set as per the HIVE query to indicate that the query
returned a result set. For more information on these statements, see the "General Syntax of an Advanced

Rule" section.

Build Rule

Expert Mode I

Rule Type Warehouse DB

MName Expert - Run Time Variable

Query DROFP Table IF EXISTS runtime variable;

Alias

{"name":"devic
{"name""ip src",

IP Source, IP Destination, Device Type

Save Reset

. "oype":[Mong”, "null®], "default™ " null"}
ype", "ype":["string”. "null"], "default":"null"},
‘type":["string”, "null"], "default":"null}

Iveta
MFS_LDT1 -

Q5 a
access_paint |_|
ACCesses

action

alert

alert_id

alias_host

alias_ip
1

Lists

4= Insert '~
o] Compliance
alF Itering Candidate
IE Local_Country
o Legs
B[ Newwork Activity
B[ per User Report

[

Q
e

« |

The following figure shows the result set of executing a parameterized report.
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=8-50
Expert - Run Time Variable

Generated on - 2014-09-11 1214

2014 % o000 Time Range 2014 9| 00:00

Expert - Run Time Variable /

IP Source IP Destination Device Type
1 netscreen
2 Nnetscrean

s netscrea n

I Page 1 of 1 | | Displaying 1 -3 of 3

Partition Based Table with Multiple Locations
The following is an example of partition based table with multiple locations:

set mapred.input.dir.recursive=true;

set hive.mapred.supports.subdirectories=true;

DROP TABLE TIF EXISTS AVRO COUNT;

CREATE EXTERNAL TABLE AVRO COUNT

PARTITIONED BY (partition_id int)

ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2Z.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="{

"name": "my record", "type": "record",

"fields": [

{"name":"sessionid", "type":["null", "long"], "default" : null},
{"name":"time", "type":["null", "long"], "default"™ : null}

I

)

STORED AS

INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';
ALTER TABLE AVRO COUNT ADD PARTITION(partltlon id=0) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/8";

ALTER TABLE AVRO COUNT ADD PARTITION(partltlon id=1) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/9';

ALTER TABLE AVRO COUNT ADD PARTITION(partltlon id=2) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/10/";

ALTER TABLE AVRO COUNT ADD PARTITION(partltlon id=3) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/11/";

ALTER TABLE AVRO COUNT ADD PARTITION(partltlon id=4) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/12/";

SELECT COUNT (*) as TOTAL FROM AVRO_COUNT WHERE time >= ${report_
starttime} AND time

<= S{report endtime};

The partition based table with multiple location is as explained below:

1. Enable HIVE to recursively scan all sub-directories and read all the data from the sub-directories.
set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;
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2. Drop and create an external table, and then format the rows:
DROP TABLE IF EXISTS AVRO COUNT;
CREATE EXTERNAL TABLE AVRO_ COUNT
PARTITIONED BY (partition id int)
ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="{

"name": "my record", "type": "record",

"fields": [

{"name":"sessionid", "type":["null", "long"], "default" : null},
{"name":"time", "type":["null", "long"], "default" : null}
I

)

STORED AS

INPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';

Note: You must create an external table only if you are using any other table. For example, if
you are using any other table apart from AVRO _COUNT then you must drop the table and
create an external table.

Note: Points to remember when you create a table:

- Dropping a 'non-external' table deletes the data.

- The table is partitioned on a single column called partition id and this is the standard column
for Reporting Engine.

- The default value of any column is null as the AVRO file may not contain the specified
column.

- The column names should be in the lowercase as HIVE is case insensitive but AVRO is
case sensitive.

- You must specify avro.schema.literal in the SERDEPROPERTIES .

For more information on the "rule syntax", refer to Apache HIVE.

3. Add partitions:

Once you define a table, you must specify the HDFS locations from where the data needs to
be queried before you execute the HIVE statements.The location parameter specifies the data to be
fetched depending on the specified date. The data is spread across multiple locations or directories in
HDFEFS. For each location you need to add a partition with unique values assigned to the partition
column. The locations can be any directory in the HDFS

ALTER TABLE AVRO COUNT ADD PARTITION(partition_id=0) LOCATION
'/rsasoc/vl1l/sessions/data/2015/07/22/8"';

ALTER TABLE AVRO COUNT ADD PARTITION(partition_id=l) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/9";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=2) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/10/";

ALTER TABLE AVRO COUNT ADD PARTITION (partition id=3) LOCATION
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'/rsasoc/vl/sessions/data/2015/07/22/11/"';
ALTER TABLE AVRO_COUNT ADD PARTITION(partition_id=4) LOCATION
'/rsasoc/vl/sessions/data/2015/07/22/12/"';

Note: HIVE reads each file in these locations as AVRO. Incase if there is a non-AVRO file
available in one of these locations then the query may fail.

4. Run the query
SELECT COUNT (*) as TOTAL FROM AVRO COUNT WHERE time >= ${report_
starttime} AND time
<= $S{report endtime};
When a table is created, you can execute specific queries to filter the data. For example, after you
create the table you can filter the data as shown in the below examples:
Sessions with a specific Source IP Address:
SELECT * FROM AVRO COUNT WHERE time >= ${report starttime} AND
time <= ${report endtime} AND ip src = '127.0.0.1";
Group by based on user destination:
SELECT * FROM AVRO COUNT WHERE time >= ${report starttime} AND
time <= S{report endtime} GROUP BY usr dst;

Automated Partition using Custom function

In 10.5.1, you can use the custom function to automate the addition of partitions to a user defined table in
the expert mode.

General syntax

RE WH CUSTOM ADDPARTITIONS (table, namespace, rollup, [starttime,
endtime])
The following table describes the custom function syntax:

o e o

1 table The table name for which the partition has to be added.
2 namespace The namespace can be sessions or logs.
3 rollup This value determines the level of directory path to be included in partitions. The

value can be HOUR, DAY, or MINUTE. If Warehouse Connector is configured
for Day rollup, setting this value as HOUR produces ZERO results. The number
and location of each partition is based on time range used to run the rule and the
rollup value.

4 (Optional) To generate partitions for a specific time range other than the time range
starttime,  mentioned in the rule, you must specify the starttime and endtime in Epoch
endtime Seconds.

Note: Expressions are not supported for the starttime and endtime.
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The custom function is invoked when Reporting Engine executes the rule either during test rule or
scheduled report. While running a expert rule, whenever Reporting Engine identifies the function

declaration, it extracts the required

arguments and insert #» number of ADD PARTITION HiveQL statements and executes them on

the Hive Server.

The location and directory structure is determined by the argument passed in the rule and the Hive data
source configuration in Reporting Engine. The number of partitions depends on the rollup specified and
the time range used while executing the rule. For example, with the rollup as HOUR and the time range
as PAST 2 Days results in 48 partitions for 48 Hours while with the rollup as DAY, Reporting

Engine creates 2 partitions, one for each day.

The partition query is generated by the Syntax Template as set in Reporting Engine's Hive Configuration
attribute AlterTableTemplate.

Note: By default, this function starts adding partitions to a table with partition id from 0 to N-1. Hence
this requires that the table must be partitioned by single integer column named partition id.

The following is an example of automated partition using custom function:

set mapred.input.dir.recursive=true;
set hive.mapred.supports.subdirectories=true;
DROP TABLE IF EXISTS AVRO COUNT;

CREATE EXTERNAL TABLE AVRO_COUNT

PARTITIONED BY (partition id int)

ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avro.AvroSerDe'
WITH SERDEPROPERTIES (

'avro.schema.literal'="{
"name": "my record", "type": "record",
"fields": |
{"name" :"sessionid", "type":["null", "long"], "default" : null}
, {"name":"time", "type":[ "null" , "long"], "default" : null}
, {"name" :"unique id", "type":["null", "string"], "default" : null}
1!
)
STORED AS
INPUTFORMAT

'org.apache.hadoop.hive.gl.io.avro.AvroContainerInputFormat'
OUTPUTFORMAT
'org.apache.hadoop.hive.gl.io.avro.AvroContainerOutputFormat';

RE_WH_CUSTOM_ADDPARTITIONS(AVRO_COUNT, 'sessions', 'DAY');
SELECT COUNT (*) as TotalSessions FROM AVRO_ COUNT
WHERE time >= ${report starttime} AND time <= S${report endtime};

Creating Custom Tables Report

In 10.6.1, you can use and create Custom Tables on the Hive Server. Reporting Engine supports running
queries on user defined tables and the ability to create a new table from a Single Rule output. When this
feature is enabled in the Warehouse Rule Builder UI, user can see a list of custom tables available in
Hive Server.
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Build Rule

Expert Mode [

Name

Select

Rule Type Warehouse DB

Meta

Hive-104 ~
X
0s -
_cl

access_point

W accesses

Alias

logs

Having

sessions

T

Where aatc_temp_d1

aatc_temp_d2

aatc_temp_fl1

aatc_temp_fl2

Group By aatc_temp_ms
adf_log_filter_results
adf_orc_collected_log_ids

Order By adf orc_collected_log_ids_with_pid
adf_orc_collected_session_ids

adf_orc_collected_session_ids_with_pid

action
ad_computer_dst
ad_computer_src
ad_domain_src

ad_username_src

1 3 .
Lists
X
+= Insert = Fo AN - X
- B AEMO

20

| | Save

<>

Reset Test Rule

i Localhost

B[] TesMe

To enable this feature set customTablesEnabled to TRUE by navigating to Reporting Engine ->
Explore ->Hive Config.

- Change Service

|= [BE RE (REPORTING_ENGINE)
B[] com.rsa.soc.re.security

B[ Jcom.rsasocre

Explore

= RE (Reporting Eng...<!

fcom.rsa.socre/Configuration/HiveConfigihiveConfig ~

AlterTableQueryTemplate
AuroSchemalldTemplate
ColumnsToBeDropped
CreateDataTableTemplate
CreateMetaTableTemplate

CustomTablesEnabled

DeleteTableTemplate

DropTempSchemalocationTemplate

ExcludedCustomTables
InitQueries
Jass_config_template
JdbcDriver

Jgss_debug
JoinFromTemplate
KerberosCanfigile
KerberosKeyTabFile
PartitionTemplate
SchemaFileBuilderQuery
‘WarehouseCTASTemplate

WarehonseResnurcePnolNames

1

RE (Reporting Engine)
ALTER TABLE %TABLENAME% ADD %PARTITIONS%
hdfs:///${hiveconf:hive.exec.seratchdir}3SCHEMA_TEMP_DIRECTORY%/0000

partition_id

create external table WTABLENAME® partitioned by (partition_id int) ROW FORMAT SERDE 'org.apache.hadoop.hive.serde2.avr

create external table if not exists BTABLEMAMES ROW FORMAT SERDE 'org.apache.hadoap.hive.serde.avro.AvroSerDe’ WITH SE|
true

default

drop table if exists %TABLENAMES

dfs -rmr ${hiveconf:hive.exec.s

ratchdir}/%SCHEMA_TEMP_DIRECTORY%

reporting.* rsasoc.* temp.*

set mapred.input.dir.recursive=true set hive.mapred.supports subdirectories=true set mapred.task. timeout=1200000 set mapred
com.sun.security.jgss.initiate { com.sun.security.auth. module Krb5LoginModule required useKeyTab=true useTicketCache=true d.
org.apache.hive.jdbc HiveDriver

false

U6SESSIONS_TABLEY left cuter join %HLOGS_TABLE% on (%LOGS_TABLEM.unique_id = BSESSIONS_TABLEY.unique_id and %LOGS_|

Jetc/krbS.conf

PARTITION (partition_id=%PARTITIONID%) LOCATION 'WLOCATION®'
insert overwrite directory '${hivecanfhive.exec.scratchdir/%SCHEMA_TEMP_DIRECTORYH' select concat{"WSCHEMAY',") from %M

CREATE TABLE %TABLENAMES% STORED AS ORC AS %RESULT%
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Creating Custom Table from Regular Rules

To schedule a report which contains a single SAW rule, a new text input with a Warehouse CTAS
Name is added. The user can now specify a Custom Table name that will be created out of the output of
the rule in Report.

Note: This feature is available only if the Report contains a single SAW rule on the Schedule page.
Otherwise, this option is hidden.

The process to use the feature is explained below:

1. Create a rule to filter with data in SAW.

Build Rule
Warehouse DB
Expert Mode [
Name HTTP_SESSIONS_DAILY
Select *
From sessions v
Alias
Where service |S NOT NULL AND service = 80
Group By

Lists
Having

X
Order By Column Name Sort By
= % oo
Enter the column name... Ascending ¥= Insert o o
BE[JAEMO
= Localhost

B[] TesMe

Limit 20000000 c
Use Save Reset Test Rule

2. Create a Report with the above rule.
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Report-HTTP_SESSIONS_DAILY R S A e Rules
Header 1 H1
M| HTTP_SESSIONS_DAILY Tabular v O || s o
Header 3 H3
Header 4 H4

Table of Contents

Body Text z
Comment p
Previous Save
3. Create a Schedule and enter the CTAS Table Name.
EETE View [REPT] Warehouse CTAS 001 [REPT] DailyHTTPSessionsC... @
Schedule Report
Enable i
Report Mame Warehouse CTAS 001
Schedule Mame | DailyHTTPSessionsCreatedByCTAS
Warehouse DE | Hive-104 w
WarehoUse | DailyHTTPSessionsCreatedByCTAS
CTAS Table
Time Zone UTC {GMT+00:00) w| [] Set Default
Run Mo w
on Fast w1 o ||Days | [ Use relative time calculation
Variables Mo variables defined
*) Dutput Actions
*) Logo
Reset | £# Configure

4. Run the Report and Reporting Engine will create the Result Summary as below for the Schedule.
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se CTAS 001

Manage View

[REPT] Warehc [REPT] Warehouse CTAS 001 &

Warehouse CTAS 001

0 Monday
Generated on - 2016-04-04 09:35 (+00:00) April 4, 2016

NETWITNESS
PLATFORM

< April 2016 ~ *

2016 93 00:00:00 (+00:00) Time Range 016 4 23:59:59 (+00:00) s w1 oW 1 s
1 2
HTTP_SESSIOMS_DAILY /
total_records minimum _time maximum_time : n
1 10451 2016-04-03 00:22:57 20160403 23:59:59
| Page 1 of1 | | | PageSize |30 - Displaying 1 -1 of 1
Reports
Time
035
5. On the next schema refresh or restart of Reporting Engine, the CTAS Table is listed.
Manage View [RULE] Mew Rule &
- m Meta
Build Rule
Hive-104 v
Rule Type Warehouse DB
X
Expert Mode [
os .
MName ;
£
Select | | ° arcess_paint
From | : SE L. w SLCESSES
- AW_CETTTE_ITTT [~ N oo
Alias avro_purge_result 1
ad_computer_dst w
Where dailyhttpsessionscreatedbyctas k |[. I I |)]
dummy ) .
Lists
dummy1
elat_avro_export_location_based_logs_table X
elat_base_orc_sessions_logs_join_table EI = Insert - oon
Group By elat_filtered_orc_logs_table —
= Localhost
Having elat_filtered_orc_sessions_table
o O[] TesMe
Order By elat_orc_collected_uniqueids_per_|log_table —
elat_orc_log_filtering_results_table
elat text filtered logs L
B A
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Task Scheduler for Warehouse Reporting

A task scheduler in a Hadoop cluster schedules the jobs consisting of tasks, and allocates specific
resources to each job running in a cluster. By default, the task scheduler allocates equal number of
resources to all the jobs. For example, if 10 jobs are running they will share resources of the cluster
equally. However, you can configure the task scheduler to control the execution of the jobs such that one
job runs faster than others by allocating more resources (pools or queues) to the job. This helps you
prioritize to run a few reports over others.

Features
NetWitness Platform supports two task schedulers:
o Fair Scheduler (org.apache.hadoop.mapred.FairScheduler)

o Capacity Scheduler (org.apache.hadoop.mapred.CapacityTaskScheduler)

Fair Scheduler

This scheduler divides the total capacity of the cluster into logical pools. You can submit a job to any one
of these pools. All the jobs submitted to a pool share the resources allocated to the pool only. Once a
pool has free resources, the freed resources are given to other pools with jobs running. For example, a
fair scheduler has 100% resources with two pools namely Pool A and Pool B which share the total
resources at 40% and 60% respectively. If Pool A has four jobs running, it allocates 10% resources to
each job. When the four jobs are completed, the freed resources are allocated to Pool B.

Note: You can configure a pool to run more than one job in parallel.

Capacity Scheduler

This scheduler divides the total capacity of the cluster into queues. Each queue is allocated a pre-
configured share of the total capacity. A job may be submitted to any of these queues. If more than one
job is submitted to the same queue, the jobs will be executed sequentially. For example, if a capacity
scheduler has 100% resources with three queues namely the Default, Low and High and they share the
total resources at 20%, 30% and 50% respectively. If Default has two jobs D1 and D2, Low has three
jobs L1, L2 and L3, and High has four jobs H1, H2, H3 and H4, these jobs are executed in their
respective queues sequentially. If the jobs in a queue are completed, the freed resources will not be
distributed to other queues.
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Query Aggregates
This section explains the supported aggregate functions.

Supported Aggregate Functions
The following table lists the supported Aggregate Functions.

Aggregate

Description

Function

count Returns the count of meta values, which includes duplicate Numeric Numeric
values as well.

countdistinct Returns the total number of distinct or unique values. Numeric Numeric
distinct Returns all the unique values. Any Any
first Returns the first occurrence of the meta value. Any Same as
input
last Returns the last occurrence of the meta value. Any Same as
input
sum Returns a sum of all non-NULL values of metaKey in a group. Numeric Numeric
avg Returns the average value of all non-NULL values of the Numeric Numeric

(Average) metaKey within a group.

min Returns the minimum for all values of metaKey in each group. Any Any
(Minimum)  This value is based on order by field.

max Returns the maximum for all values of metaKey in each group. Any Any
(Maximum)  The maximum value is the value that is returned by order by

field.
length Returns the length of the values of metakey. This is called a Any Numeric

"scalar function" in SQL.

Examples of Queries and Results per Function

Count

This function returns the number of values for a specified meta key, that exclude null values but include
duplicate ones. .

Example

The following figure shows a sample query for count function used for the destination IP and the
respective source IP.
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Build Rule

Rule Type MetWitness Platform DB
Marme Count funiction
Summarize Custom -
Select ipsre, count{ip.dst)
Alias Sowurce |P Address
Where ipsrc exists

Group By ipsrc

Then Enter a then clause..

3
Column Name =~ Sort By
Enter the column name... Ascending
r r

countlip.dst) Descending
Seszion - P
vt 0
Threshold :
Limit 10 -

Save Reset Test Rule

The following figure shows the result for the above query.
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Sourc 01 AT q 03 e
Ptz Source 2018 ! 08:02:00 COunt function 2018 2 08:01:59
Concentrator - Concentral »

Source |P Address countlip.dst)

Format

1 55073
Tabular L4

2 2733
Time Range

neq1

Past mlE 251

4 2178
2 & Months =

5 2053
¥ |Uze relative time calculation _

5 1531

2 1042

£l 970

10 947

Close

Here, for each unique ip.src (source IP), the page returns the total number or count of ip.dst (destination
IP) values, which include the duplicate values as well.

Note: If your RSA NetWitness Platform is currently on 10.5 or newer version and any of the
NetWitness Platform Core devices are on 10.3 or 10.4 versions, then some of the aggregate functions
may display unexpected errors. However, aggregate functions such as sum() and count() are supported
in 10.4 version.

Countdistinct

The countdistinct function returns the count of unique or distinct values for the metakey. In other words,
countdistinct function can be used to retrieve a number of distinct values for the specified metakey.

The following figure shows a sample query where the countdistinct function is used along with IP source
(ip.src) and data size(size).

Example
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MetWitness Platform DB

Count disting: funddon

Cusboam -

p.=7e, size, countdistinadfilename)
Source P Address

o= exists &4 filename exists

Criter a then clausa...
Column Mame = Sart By
Crter the column narme, Ascerding

r r
countdistinct[filenamea) Descending

]
L

=
€3

Save Rezest Test Rule
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The following figure shows the result for the above query.

Data Sourc o1 ne- A - 03 .
t = 2018 ;5 08:06:00 Count distinct function 2018 5 08:05:59
Concentrator - Concentrat »
_ Source P Address Data Size countdistince{filename)
Format
— 1 138674 122
abular b
2 552008 &7
Time Range
o 2 2375324 B4
EEi -
4 148562 64
2 5| Months w
5 95476 56
*"_ Iz relative time caloulation _
B 94520 55
2 127548 53
£l o0ia4 45
10 108036 48

Here, the page displays the data size along with the total number or count of distinct filenames from the
respective IP source. Unlike the count function, the countdistinct excludes the duplicate values from the
result.

Distinct

This function returns all the unique or distinct values of the metakey.

Example

The following figure shows a sample query for distinct function used to retrieve e-mails, between
various source and destination IP (ip.dst).
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Build Rule
Rule Type NetWitness Platform DB
Mame Distirect furction

Cusboem -

p.=re, ip.dst. distinademail)
Allas Source P Address

Whers p.arc exists &4 email exizsts

p.5rCLipodst

Then Crler 4 Lhe .
Crder By Column Nams =~
CriLer the codurnn rarme,
"

distinctjemail)

10 v
Save Rezat Test Rule

Zart By

Aacarndin
v
Descending

The following figure shows the result for the above

query.
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D=tz Zource 2018 ;1  08:09:00 Distinct function 2018 2 08:08:59

o5
Concentrator - Concentrar «
Source IF Address Destination IP address distinct@mall]

Format i
- 1 z=tern@gwuLedu, ntonous] $E2EErookadu

sbular -

2 ssofaBew " b3 (Fzi - e

Tims Rangs Z zsofiaB@ewu.edu. wallet=cb 9 @singaporemyway.com
Pazt w |3 zorthographyBharrycareys.com

7 »| [Monthe zmilesEgwu.adu, ZiZ@gwu.edu, rowland@gwu.edu,
— - 2 methi@gwu.edu. jengw@gwuedu,
o Use relative tirme caloulation B dwskywatchmi@skywatch. pt.

dwredmaplegrovem@redmaplegrove.o
=

5 zli@gwu.edu. [ysn@emmes.com

B zli@gwu.edu. zhenggi@nhlbi.nihugow, lyan@emmes.com

zibet@alanperiman.com

g zhanania@law.gwu.edu, jarrentBnokis.com
9 zeepirim@Bresmes.nl, jlusius@law govu.edu
10 zdaviEgwu.edu, _erkt | yer@Palazkapublichealth.org

Cloze

Here, the page displays the list of unique e-mails that were exchanged between the respective IP source
and destination.

First

This function is used to retrieve the first value from an ordered sequence of values for a specified
metakey.

Example

The following figure shows a sample query for first function used to retrieve the first destination city
name.
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Euild Rule

Rule Type

Mame

MNetwitness Platform DB

First fumction

Cusbom -
p.=re, ip.dst, Firstoity.dst)
Source P Address

p.=re exists B& cigy.dst exists

p.sre.ip.dst

Crler a then dause...

Column Name =

LrnLer e Codurmn name.
r
ip.dst
10 -
Zave Reszet Test Rule

Zort By

AL erydng
r
Deescending

The following figure shows the result for the above

query.
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Dizta Source

Concentrator - Concentra «

Format

Tabular -
Time Range

Past w
2 % |Months =

v

1 'USE reialve time casiulalsn

2018

9 08:12:00

Source IF Address

First function

Destination IP address

2018 )7 D08:11:59

Firsticity.dst]
Daong Ha
Harwoi
Hanoi
Xiangxi
Changzha
Seoul

Seoul
Har=ukaichi
Hirashima

Takyo

Here, the page displays the the first destination city for the corresponding source and destination IP. You

can use the first function to isolate a particular value from a search result.

Last

This function is used to retrieve the last value from an ordered sequence of values for a specified

metakey.

Example

The following figure shows a sample query for last function used to retrieve the most recent user name.
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Build Rule

Rule Type

Mame

Group By

Netwitness Platform DB
Last function
Custom -
p.=re, ip.dst. lastifullname)
Source P Address

p.ere exists &4 fullname exists

p.5rCLipodst

CrLer a then clause...

Column Kame = zart By

Crler the codurnin name, AELEr T
" "

ip.dst Descending

Yy Y

10 A

Save Rezst TestRule

The following figure shows the result for the above query.
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213 Source

w

Format

Tabular

Time Rangs

Pazt

2 % Months

"". USE resalive time casiul

Concentrator - Concentrar «

2018 9! 08:14:00

Source IF Address

Destinaton IF address

Last function

laseifullmame}

sipcckpark2007 @naver. com:5060>
sipeckpark2 007 @naver. com:5060-
=sipeD5535ETES5Evoip.euteliain

sipestarkscatd Iverizon.ned@6s. 142.233.155:443>
sip: 17735693093 Eoruphone.com>
sipestarksabhd verizon.ned@] 28.164.99.184:1471

siprwhimaycaldwel@68.142.233.153:443>

2018 27 08:13:59

Here, the page displays the list of most recent or last usernames in full, that were exchanged between
the source and destination IP.

Sum

This function returns the total of the non-NULL values of the metaKey within a group.

Example

The following figure shows the query for the Sum function used for packets.
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Build Rule
Rule Type Metwitness Platform D&
Mame Sum function

Custom -

country.dst, size. sumipackets)

Destination Country

Whers counkry.dst exists

Graup By ountry.dst size

:I-F'E'F' Criter a Lthen clauss...

Drrder By Column Name Sart By
country.dst Descending
Crler the calurmin narme, AL & LI

]
L

Save Reze: Test Rule

The following figure shows the result of the above query.
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st Source 2018 2! 08:18:00 Sum function 2018} 08:17:59
Concentrator - Concenora «
Destination Country Data Size sumipackets]
Format
— 1 TIimbabwe 293 2
zbular -
Time Range 2 gin Islands, British £977532 3952
Past w| | 3 rgim Islands, British 15400 28
4 air |slands, B - 2 A
2 3| |Months = = T =6
5 etnam 408 4
"". USE resalive time Caiulabon
6 etnam 156 2
8 etnam 206 2
9 etnam 18 2
10 etnam 98 10

Close

Here the page displays the total or sum of the packets along with the size of the data for the respective
destination country.

Avg

The average function returns the average of non-NULL values of the meta within a group.

Example

The following figure shows a sample query for average data size transmitted between a source and
destination IP.
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Build Rule

Rule Type NetWitness Platfarm DB
Nama Awvarage function
Summarize Custom -

p.57C, ip.dst. avelsze)

Allaz Source P Address
Where D.5TC exists
Group By p.=TCip.dst
:I-F'E'F' Cnter a then clausa..
Drder By Column Name Sart By
r
avgsire] Descending
Crler e cohurmn name. Aacarding

]
£

Save Reze: Test Rule

The following figure shows the result for the above query.
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s13 Source

Format

Tabular

Time Range
Past

2 % |Months

o

1 USE resatve eme Cakiu

Concentrator - Concentra «

2018

91 08:25:00

Source IF Address

Average function

Destination IF address

2018 2
awgisize
16780425
12175750
11987350
10168064
9215054
8771154
B092E58
7184440
B598030

BSETEEZ

08:24:59

Close

Here, the page displays the average size of data exchanged between source and destination IP:

Max and Min

Max and Min functions provide the maximum and minimum for given values of a meta respectively.

The following figure shows a sample query for max and min functions for various data sizes, for source

IP and destination country.

Example
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Build Rule
Rule Type Metwitness Platform D8
MName kax and Min function

Custom -

p.=rC, country.dst, mawx{size), minlsize)

Source P Address

‘Where p.=re exists & country.dst exists
Graup By P.EMC,0OUNEry 05T
:r"'E'"' Cnter a then clausa..
Crrder By Column Hame Sart By
r r
ip.src Mscending
Crler the calurmin narme, AL & t‘

L

€

Reze: Test Rule

The following figure shows the result for the above query.
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Dtz Sourcs 2018 9 08:28:00 Max and Min function 2018 §; 08:27:59

05
Concencrator - Concentra

i
<

Sowrce IP Address Destination Cowntry max|size) minfsize)
Format
— 1 Unized States 256 256
sbular w
2 u 2868 B56
Time Range
Pazr w| | 3 Unized Stanes 162 162
4 Unized States 264 132
2 % Months 5 3
5 u 136 136
"f. USE resalive time Casiulalson
B Uniged 169928 169928
2 Unized Stanes 256 256
9 Unized Stanes 3974 3602
10 United States 286 286

Close

Here, the page displays the max(size) and min(size) columns, along with the list of source IP and
destination country. The max(size) column lists the maximum data sizes exchanged while the min(size)
column lists the minimum data sizes that were exchanged.

Filter aggregate meta results with Max_threshold

You can further filter the results of any function by using the threshold rule action.

Example
Following is a sample query for max_threshold used along with the Max function in the Then field is:
max_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Build Rule

Rule Type MetWitness Platfarm DB

MName Max Threshold

Summarize Custam =

Select ip.src, directory, mazx(size)

Alias Source IP Address

Where ip.src exists && directory exists
Group By ip.src.directory

Then max_threshold{5000, max{size))

Enter a then clause...

Crder By Column Name -~ Sort By
Enter the column name... Descending
ip.sre Azcending

Session o -

Use Save Feset Test Rule

Here the max_threshold is applied for data size with an upper limit of 5000. The following figure
shows the result.

Appendix 407



Reporting User Guide

lest Rule

Diata = o3 A 03 2
2= Souree 2016 2 09:04:00 Max Threshold 2018 g2 09:03:59
Admin- Concentrator b
Source [P Address Directory ma(size)

Format

1 running: fusrilocal/libexec 196
Tabular ~

2 4480
Time Range

3 AbouttheCouncilBoardofDirectors 3384
Past ~

4 AbouttheCoun rectors/BoardofDirectors., 4032
9 2 Years e
= = 5 Abi nitiatives 3538
- stive i = i

Use relative time calculation & Aboutthe 2455

7 Aboutthe s 4008
F B

2 Aboutthe! m 372

E 3384

10 age phao 3224

Here, the result page displays the max(size) column, that lists the data sizes lesser than 5000 as this is
the maximum threshold in the query, along with the corresponding IP source and the respective directory.
Filter aggregate meta results withMin_threshold

Similarly, min_threshold is used to filter the results for any function. A similar scenario as max_
threshold is considered to explain this.

Example
Query for min_threshold used along with the Max function in the Then field is:
min_threshold(5000,max(size))

The following figure shows the Build Rule screen for the above query.
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Build Rule

Rule Type

Mame

Summarize

Session

Use

MetWitness Platform DB

Min Thresheold

Custom w
ip.src, directory. max(size)
Source [P Address

ip.src exists L& directory exists

ip_srcdirectory

min_threshold({5000, maxsize])

Enzer a then clause...

Column Mame ~ Sort By
Enter the column name... Descending
ip.=rc Azcending
o v
10 -
Save Reset Test Rule

Here the min_threshold is applied for data size with a lower limit of 5000. The following figure
shows the result.
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Test Rule

Data = 0z O i 0z -
SES mmuree 2016 09:06:00 Min Threshold 2018 09:05:59
03 05
Admin- Concentrator -
Source |P Address Directory max(size)
Format
1 Mages 92640
Tabular A
2 -nzarchiv/IMG 1959336
Time Range
3 -nzarchiviMNsAEBE/MSAEBES 199936
Past A
4 -mfpankin 7432
2 2| |Years hd o f M
5 AbouttheCouncilBoardofDirectorsiMembership 6032
W Lse relative time calculation erlin
B cgi/p/downloadFile/d/6504/n/offfother/1/name/SummaryoftheFeb27Forumdoc 7680
7 -ais/images 18340822
2 - 18340822
3 —judal 22576
10 —judai mage 22576

Here, the result page displays the max(size) column, that lists the data sizes greater than 5000 as this is
the minimum threshold in the query, along with the corresponding IP source and the respective directory.

Note: Max_threshold and Min_threshold rule actions are common across all the functions, and can be
used along with the other queries in the Then field to retrieve the respective output.

Length

This function returns the length of a meta value. In other words, Length function returns the number of
bytes used to store the actual value.

For instance, for the value "Analytics" it returns the length as 9. Similarly, for an IPv4 ip.src, it returns 4
(representing 4 bytes).

Example

The following figure shows a sample query for the length function used for usernames.
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Build Rule

Rule Type

Mame

Summarize

Session

Use

MetWitness Platform DB

Length of User Mame

Custom w

ip.src, username, len{username)
Zource IP Address

ip.src exists &8 username exists

ip.src,username

tnter a then clause..

Column Mame -~

Enter the column name....

LSEmame
] +*
10 +*
Save Reset Test Rule

Sort By
Dezcending

F
Descending

The following figure shows the result for the above query.
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Test Rule

Data o . 03 (15~
== Seures 2018 ! 09:10:00 Length of User Name 2018 2 09:09:59
Admin- Concentrator b
Source |P Address User Account len{username) =
Format

-

Tabular - - ——

=

Time Range

Pazt - 7.

2 - Months 7.

b e B e B B |

™ Use relative time calculation

Here, the page displays the length of the usernames associated with the user account and their respective
source IP.
Additional Information

When you query for aggregates (E.g. sum(size)) with Group By on a meta which has multiple values in
a session, then the session with multiple values is accounted for aggregate calculation for each value of
that meta.

Example

When you query for the Count aggregate function with Group By on Alias.host and if the column has
multiple values in a session, then the session is counted for each occurrence, including the duplicate
values.

Consider the following table.

host-a, host-b, host-a

2 host-b, host-c, host-a, host-c ¢ 20
3 host-b, host-c, host-d b 30
4 host-c, host-a a 40

In the above table, alias.host for host-a and hest-c¢ has duplicate values listed for a single session. Let us
consider the following query:

Select : alias.host, count(ip.src), sum(size)
Group By : alias.host
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Here, host-a and host-c are present in 3 sessions and they are duplicated for two different sessions.
However, the output is as shown below.

s oat]| counipro) | sum sz
4 80

host-a

host-b 3 60
host-c 4 110
host-d 1 30

Output table shows that the count for host-a and host-c is 4. This is because for each alias.host value,
the entire session is considered. Similarly to calculate sum (size), the same sessions are considered for
each alias.host value.

In the report output if the number of rows has reached NWDB maximum aggregate rows defined in RE
configuration, then a message Max Aggregate Row Limit Reached is displayed to indicate that there is
more information to be displayed. The default limit is 1000, and you can change this value as per your
requirement, in the Reporting Engine Configuration page .

Report-AggregateRows R SA NETWITNESS:
Generated on - 2016-05-12 12:05 (+00:00) PLATEORM
2016 22 10:00:00 (+00:00) Time Range 2016 22 11:59:59 (+00:00)
AggregateRows / 2FA-CONC {Max Aggragate Row Limit Reached)
ip.src Total events count
1.ip.src 10.100.50.57 1
2.ip.src 93.189.156.232 1
3.ip.src 128.222.180.240 1
4.ip.src 172.20.20.92 1
5.ip.src 10.8.21.100 2
1. service HTTP 2
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Troubleshoot Reporting

This section provides troubleshooting instructions for issues faced when using the Reporting module
in NetWitness Platform.

Configuring SFTP Server Issue

Procedure
Try the following steps if you face any issues while configuring the Linux SFTP server:

1. If the Report Output Action for the configured SFTP fails, you must SSH to the SFTP server and try
to connect locally to check if SFTP is working fine.

Connect to SFTP server:

2. If the Local connection fails, open the file sshd_config> vi /etc/ssh/sshd_config.
3. Check for the entry in the file:

# override default of no subsystems
Subsystem sftp /usr/libexec/openssh/sftp-server

If this entry does not exist, add the two lines mentioned in Step 3 at the bottom of the file and Save it.
Restart service from SSH > service sshd restart.

Retry the SFTP connection now.

N ok

Make sure SFTP port is not blocked by SA server appliance firewall. Update iptables rules to allow
sftp port.

Meta Values in Investigation Link Issue

When the device information on the datasource is changed, the Investigation link for the

I . .
SR meta values of the executed reports is not displayed on the NWDB results page.

: Remove and re-add the datasource to Reporting Engine.
Resolution _ ‘ _ ,
Note: This workaround is not applicable for reports that are already generated.

Internet Explorer 10 Browser Issue

Issue When you click the Test Rule multiple times in quick succession, results with large input
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data may not displayed in Internet Explorer 10.

If this issue occurs, try one of the following steps:
o Close the Test Rule window on Internet Explorer 10 and run the test again.

o Use other browsers like Chrome or Mozilla Firefox to test the rule execution.

Dynamic List Editing Issue

A dynamic list cannot be added from the Edit option on the 'View All Schedules' page to
an existing schedule.

1. Reports > Select the report >

2. Click the #Schedules for the specific report

3. Select the schedule to be modified from the Report Schedule page
4. Edit the schedule

Deployment Failure Issue

Deployment of reports fail, if the dependencies of certain compliance reports in Live are
not deployed prior to the reports.

Retry the deployment. If the problem persists, try to deploy the rule or list dependencies
first and then deploy the reports.

Respond Server Issue

When the Forward Alerts to Respond option is enabled and RabbitMQ connections to the
Respond Server are blocked, some of the Reporting Engine threads may be blocked.

Disable the Forward Alerts to Respond option until the RabbitMQ broker in the
NetWitness Platform server at the Respond has begun and accepts the connections.

Post-Upgrade Issue

Post-upgrade from 10.6.x to 11.2, Categories meta for incident collection is not supported.

When using the Categories meta for incident collection, the results rendered are in an
incorrect format. Hence this meta is not supported and you cannot use the categories
meta in either select clause or where clause. Also, it is not available in the list of metas
for selection in the Rule Builder page.
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